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CHAPTER

ONE

INSTALLATION

1.1 Windows
jamovi is available for Windows Vista (64-bit) and above. Installation on windows is quite straightforward, and should be familiar to anyone who has installed software on Windows before. Download
the latest version from the download page (https://www.jamovi.org/download.html), and double-click
the icon.
At some institutions (particularly universities), the normal approach to installing software is blocked
by IT security policies. In this case, you can download our .zip-version. To use this, simply
download, unzip to a location on the computer, and naviagate to the bin folder. Double-clicking
jamovi.exe will begin jamovi. Its possible that additional security restrictions prevent jamovi
from working in this way, in which case it would be worth raising the issue with your IT staff.

1.2 macOS
jamovi is available for macOS 10.9+ (Mavericks and newer). To install it, download the .dmg-file
from our download page (https://www.jamovi.org/download.html), and double-click the downloaded
file. This will present you with a file view, and you can install jamovi by dragging-and-dropping the
jamovi application to the Applications folder (in the usual way). After this, jamovi will appear in
your applications, and can be started like any other installed application.
jamovi for macOS has an auto-update mechanism, and can alert you to when new versions are available. You can update your version of jamovi from the app menu (; at the top right of the window).

1.3 Linux and Chromebooks
jamovi is currently available for Linux, (for all flatpak participating linux distributions – which is
most of them), and Chromebooks, from flathub.
Note: Some Chromebooks experience a blank screen issue when starting up jamovi. If you encounter
this, there are instructions on how to fix this a little further down ( 4).
If youre new to flatpak/flathub, youll need to follow the setup guide on our flathub page
(https://flathub.org/apps/details/org.jamovi.jamovi).
If youre an old hand at flatpak, you can install jamovi with the command:
flatpak install flathub org.jamovi.jamovi
and later, you can update your version of jamovi with:
flatpak update

3
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1.3.1 Text not appearing in plots under linux
On some linux machines, the flatpak font cache is not up-to-date, resulting in plots in jamovi not
displaying text correctly. To remedy this, you can run the following command at the terminal:
flatpak run --command=fc-cache org.jamovi.jamovi -f -v
This appears to be an issue with flatpaks, and were working with the flatpak community to get to the
bottom of it.

1.3.2 Blank screen at startup on Chromebooks
Some Chromebooks experience a blank screen when starting up jamovi. The cause of this issue is not
completely clear at this time, however it can be fixed by disabling Crostini GPU support.
Enter chrome://flags/ into the ChromeOS address bar. This will bring up Experiments. Search
for Crostini GPU Support and set it to disabled. After restarting your Chromebook the issue
will be fixed (special thanks to @mulderc (https://github.com/mulderc)).
Jonathon Love
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Chapter 1. Installation

CHAPTER

TWO

FIRST STEPS IN JAMOVI

When first starting jamovi, you will be presented with a user interface which looks something like
this.

To the left is the spreadsheet view, and to the right is where the results of statistical tests appear.
Down the middle is a bar separating these two regions, and this can be dragged to the left or the right
to change their sizes.
It is possible to simply begin typing values into the jamovi spreadsheet as you would any other spreadsheet software.
Alternatively, existing data sets in a range of formats (CSV, Excel, LibreOffice, R, SPSS, Stata, SAS,
etc.) can be opened in jamovi. Additionally, there are a number of example data sets available in
jamovi. To open a file, select the file menu (, at the top left hand corner of jamovi), select Open and
then Data library or This PC, depending on whether you want to open an example, or a file
stored on your computer.

A very common format for exchanging data is using files with comma- separated values (.csv or
.txt). Given that these data are stored as simple text file using commas (or ;, |, etc.) to separate
values nearly any software package can read and write them (and you to can take a look using any
5
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text editor). An example is shown in the figure. The first line contains the variable names and any
other line afterwards a measurement point (typically a person where data were acquired from). If you
have your data in a spreadsheet program (e.g., Excel), you can create a CSV-file from your data by
selecting File → Save as... and choose Comma delimited in the drop-down menu close to
the Save as-button. Thereafter, you may open the CSV-file in jamovi.
In the unlikely event that jamovi does not open a file correctly, file an issue (bug report) in the GitHub
issue tracker (https://github.com/jamovi/jamovi/issues).
Jonathon Love
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CHAPTER

THREE

ANALYSES

Analyses can be selected from the analyses ribbon or menu along the top. Selecting an analysis
will present an options panel for that particular analysis, allowing you to assign different variables
to different parts of the analysis, and select different options. At the same time, the results for the
analysis will appear in the right results panel, and will update as you make changes to the options.
When you have the analysis set up correctly, you can dismiss the analysis options by clicking the
arrow to the top right of the options panel. If you wish to return to these options, you can click on the
results that were produced. In this way, you can return to any analysis that you (or say, a colleague)
created earlier.
If you decide you no longer need a particular analysis, you can remove it with the results context
menu. Right-clicking on the analysis results will bring up a menu, and by selecting Analysis, and
then Remove, the analysis can be removed.
jamovi produces nice APA formatted tables, and attractive plots. It is often useful to be able to copy
and paste these, perhaps into a Word document, or into an email to a colleague. To copy results, right
click on the object of interest, and from the menu select exactly what you want to copy. The menu
allows you to choose to copy, say only the image, or the entire analysis. Selecting copy, copies the
content to the clipboard, and can be pasted into the other program in the usual way.
Jonathon Love
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Chapter 3. Analyses

CHAPTER

FOUR

THE SPREADSHEET

In jamovi, data is represented in a spreadsheet, with each column representing a variable.

4.1 Data Variables
The most commonly used variables in jamovi are Data Variables, these variables simply contain data
either loaded from a data file, or typed in by the user. Data variables can be one three data types:
• Integer
• Decimal
• Text
and one of four measure types:
•

Nominal

•

Ordinal

•

Continuous

•

ID

The measure types are designated by the symbol in the header of the variables column. Note that
some combinations of data-type and measure-type dont make sense, and jamovi wont let you choose
these.
Nominal and Ordinal are, predictably, for nominal and ordinal variables. Continuous is for
variables with numeric values which are considered to be Interval or Ratio scales (Equivalent to
Scale in SPSS). The ID measure type is, unlike the others, unique to jamovi. Its intended for
variables that contain identifiers that you would almost never want to analyse. For example, a persons
name, or a participant ID. The advantage of IDs, is that jamovi does not need to maintain a list of
levels internally, which can improve performance when interacting with very large data sets.
When starting with a blank spreadsheet and typing values in, the data and measure types will change
automatically depending on the data you enter. This is a good way to get a feel for which variable
types go with which sorts of data. Similarly, when opening a data file, jamovi will infer the variable
type from the data in each column. In both cases, this automatic approach may not be correct, and it
may be necessary to manually specify the data and measure type with the variable editor.
The variable editor can be invoked by selecting Setup from the Data tab, double-clicking on the
column header, or by pressing F3. The variable editor allows you to change the name of the variable,
and (for data variables) the data type, the measure type, the order of the levels, and the label displayed
for each level. The variable editor can be dismissed by clicking the close arrow, or by pressing F3
again.
New variables can be inserted or appended to the data set using the Add button from the data ribbon.
The Add button also allows the addition of Computed variables.

9
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4.2 Computed Variables
Computed Variables are those which take their value by performing a computation on other Variables.
Computed Variables can be used for a range of purposes, including log transforms, z-scores, sumscores, negative scoring and means.
Computed variables can be added to the data set, with the Add button available on the data tab. This
will produce a formula box where you can specify the formula. The usual arithmetic operators are
available. Some examples of formulas are:
A + B
LOG10(len)
MEAN(A, B)
(dose - VMEAN(dose)) / VSTDEV(dose)
Z(dose)
In order, these are the sum of A and B, a log (base 10) transform of len, the mean of A and B, and
the z-score of dose (twice).
There are many more functions available.

4.2.1 V-functions
A number of functions appear in pairs, one prefixed with a V and the other not. V functions perform
their calculation on a variable as a whole, where as non-V functions perform their calculation row
by row. For example, MEAN(A, B) will produce the mean of A and B for each row. Whereas
VMEAN(A) gives the mean of all the values in A.
Additionally V functions support a group_by argument. When a group_by variable is specified,
a separate value is calculated for each level of the group_by variable. In the following example:
VMEAN(len, group_by=dose)
A separate mean is calculated for each level of dose, and each value in the computed variable will
be the mean corresponding to its rows value of dose.

4.3 Recoded Variables
Transformed and recoded variables are also available.
See
(https://blog.jamovi.org/2018/10/23/transforming-variables.html) for details.

this

blog

post

4.4 Filters
Filters in jamovi allow you to filter out rows that you dont want included in your analysis. For
example, you might want to only include peoples survey responses if they explicitly consented to
having their data used, or you might want to exclude all left-handed people, or perhaps people who
score below chance in an experimental task. In some cases you just want to exclude extreme scores,
for example those that score more than 3 standard deviations from the mean.
The filters in jamovi are build on top of jamovis computed variable formula system, which allows the
building of arbitrarily complex formulas.
More details about filters are covered in this blog post (https://blog.jamovi.org/2018/04/25/jamovifilters.html)
Jonathon Love
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CHAPTER

FIVE

UPDATING DATA

Once a data set is set up with filters, computed variables, transforms and analyses, sometimes you
may want to update the data. This may be for a number of reasons – It might be that you have a new
data set, that you want to apply the analyses you performed earlier to it, or you may be conducting an
experiment where youre tesing a number of participants, and you now have an additional participants
data to analyse. By importing into an existing data set you can re-run your analyses without having
to re-perform all of your data cleaning and analysis steps (making your jamovi files behave a bit like
scripts).
For a video introduction to import and templates in jamovi,
(https://blog.jamovi.org/2019/03/27/import.html).

see this blog post

5.1 Single-file Import
Import is available from the file menu () at the top left of jamovi. When you import a file into an
existing data set, the following operations are performed:
1. All the rows of the existing data set are deleted.
2. All the (original) names of the existing columns are matched to the names of the columns from
the new data set.
3. The new values are imported to the existing columns, keeping the data and measure types from
the existing data set.
4. The new columns which did not match names in the original data set are appended to the right
of the data set.
If no new column matches the column names in the existing data set, then those columns are left
blank.
Following a file import, all the filters, computed variables, transforms and analyses update.

5.2 Multi-file Import
It is also possible to import multiple files at once. This can be useful when you are combining multiple
data sets, for example, where each file represents a participant. The process is the same as the singlefile import detailed above, except that you select multiple files when performing the import. You can
do this by holding down control or shift when selecting data files, or with the multi-select button at
the top of the import dialog.
When importing multiple files like this, they are combined vertically with the rows of the second
file appearing below the first, the rows of the third file appearing below the second, and so on. An
additional column called source is created detailing which file each row has come from. This can
be useful when you need to split-by or group-by each participant. This column can be particularly
useful to use with the group_by argument to V-functions described above.

11
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At present, there is no way to combine files horizontally in jamovi.

5.3 Templates
Templates in jamovi are special data sets that are analagous to script files in more traditional statistical
environments. They are a way to specify data types, computations, filters, transforms, and analyses
in advance. Once the data becomes available, it can be imported into the template, and the template
will update accordingly. The nice thing about jamovi templates is that they are entirely specified with
the familiar user interface, and do not require working with a syntax or code.
To save a data set as a template, select Export from the file menu, and select jamovi template
(.omt) from the file type box. When opening a template, youll see it contains columns but no
rows, and that all the analysis results are blank. To use the template, import a new data set (or data
sets) using the file import described above. The data will update, followed by the filters, computed
variables, and finally the analysis results.
jamovi templates are also a great way to provide analyses to less capable students or colleagues.
Jonathon Love
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CHAPTER

SIX

SYNTAX MODE

jamovi also provides an R Syntax Mode, in this mode, jamovi produces equivalent R code for each
analysis. To change to syntax mode, select the application menu () at the top right of jamovi, and
check the Syntax mode checkbox there. It is possible to leave syntax mode by clicking this a
second time.
In syntax mode, analyses continue to operate as before, but now they produce R syntax, and ASCII
output like an R session. Like all results objects in jamovi, you can right click on these items (including the R syntax) and copy and paste them, for example, into an R session.
At present, the provided R syntax does not include the data import step, and this must be performed
manually. There are many resources explaining how to import data into R, and we recommend you
take a look at these (most analyses in jamovi require data as a data frame).
Another R feature that may be of interest is the Rj Editor (https://blog.jamovi.org/2018/07/30/rj.html),
which allows you to use R code to analyse data directly in jamovi.
Jonas
Rafi
(https://www.su.se/english/profiles/jora9288-1.283149)
(https://www.uib.no/en/persons/Sebastian.Jentschke)

and

Sebastian

Jentschke
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Chapter 6. Syntax Mode

CHAPTER

SEVEN

ANALYSES: INTRODUCTION

The aim of the following section is to provide short, non-technical tutorials on how to conduct common statistical
procedures in jamovi, and was originally created by Jonas Rafi under the name jamovi guide. However, this is
only intended as a brief overview. For a more in-depth treatment of these analyses, wed recommend you take a
look at the many community resources (https://www.jamovi.org/community.html) available.

7.1 A Note On Measurement Types
The following documentation describes each of the analyses, and describes the variable measure types required.
For example, it might explain that a particular analysis requires a continuous

dependent variable, and a nominal

grouping variable. However its possible that the columns in your data set, for a number of different reasons,
arent set up with the correct measure types (as indicated in the column header). You can adjust the measure type
of columns using the variable editor, however (for the most part) these measure types are really just a guide and
dont need to be set correctly. If you assign a
continuous variable to an analysis expecting a
the analysis will simply treat the variable as nominal.

nominal one,

All this to say, if the documentation says that a particular measure type is required, the data simply needs to be the
correct shape, and you can save yourself the labour of setting the measure types correctly if you dont want to.

7.2 Descriptives
• Descriptive analyses ( 17)

7.3 t-tests
The t-test is used to test whether the mean value in a normally distributed data set deviates significantly from a
null hypothesis (which assumes that there is no difference).
There are three types of t-tests:
• t-test: Independent samples ( 23)
• t-test: Paired samples ( 25)
• t-test: One sample ( 27)
Community resources

A more comprehensive introduction into the concept is presented in this video
(https://www.youtube.com/embed/mb7KCLYEis8?list=PLkk92zzyru5OAtc_ItUubaSSq6S_TGfRn) by Barton
Poulson (https://datalab.cc/jamovi).

15
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7.4 Analyses of Variance (ANOVA)
The Analysis of variance (ANOVA) is a statistical method that examines how the impact of one or more factors
affects an outcome (dependent) variable. These factors are the predictor variables and are categorical. Typically,
such factors reflect an experimental manipulation (e.g. with or without treatment), but a factor can also represent
groups for whose influence one would like to control (e.g. gender: men or women). The analysis of variance is
based on a concept similar to that of the t-test, but it goes beyond that, in that factors can have several levels (t-tests
only allow two) and in that several factors can be examined simultaneously.
There are different types of analysis of variance, which differ in the number of factors examined - one or more
factors - or whether they compare between people or within a person - repeated measurements:
• ANOVA: One-Way ( 31)
• ANOVA ( 35)
• ANOVA: Repeated Measures ( 37)
• ANOVA: Mixed ( 41)
Community resources

An introduction into the concept of an ANOVA is presented in this video
(https://www.youtube.com/embed/GcbMG6sizXs?list=PLkk92zzyru5OAtc_ItUubaSSq6S_TGfRn) by Barton
Poulson (https://datalab.cc/jamovi).

7.5 Correlation and regression
Correlation and regression analyses are statistical methods for assessing the relationships between a dependent /
outcome variable and one or more independent / predictor variables. While the correlation analysis examines the
relationship between one predictor and one outcome variable, regression analysis mainly focuses on prediction
(how well can one or more variables predict another (outcome) variable). Often, a distinction is made between
linear and non-linear (e.g., logistic regression).
• Linear Regression ( 45)
• Logistic Regression ( 49)
Community resources

An introduction into the concept of regression analyses is presented in this video
(https://www.youtube.com/embed/gRhVjKNWiUs?list=PLkk92zzyru5OAtc_ItUubaSSq6S_TGfRn) by Barton
Poulson (https://datalab.cc/jamovi).

Jonas Rafi (https://www.su.se/english/profiles/jora9288-1.283149)
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Chapter 7. Analyses: Introduction

CHAPTER

EIGHT

DESCRIPTIVE ANALYSES

How to perform descriptive analyses and create graphs in jamovi:
1. Select Analyses → Exploration → Descriptives.

2. Drag and drop the variables you want descriptive analyses for to Variables.

3. The result is shown in the right panel. Right-click on the output to save or copy it.

17
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4. To split your descriptive analyses on a categorical variable (e.g. to separate by gender), move that variable
to Split by.

This changes how the output looks like:

18
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5. Click the Statistics tab to see more alternatives.

19
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6. To create a plot based on the above choices, click the Plots tab and tick the box of your desired plot. If
you would like to identify outliers and to check whehter your variables conform with a normal distribution,
then you should tick Box plot, Violin, and Q-Q.

Further help from the community resources

If you would like to have these concepts explained in a different way, please have a look at this introductory
video (https://www.youtube.com/embed/srqNCux0ijY?list=PLkk92zzyru5OAtc_ItUubaSSq6S_TGfRn) by
Barton Poulson (https://datalab.cc/jamovi).

For those, aiming to stretch even further to an in-depth introduction, you can read the respective chapter in the
Learning statistics with jamovi web documentation
(https://lsj.readthedocs.io/en/latest/lsj/Ch04_Descriptives.html) or chapter 4 of the e-book
(https://www.learnstatswithjamovi.com/) by Danielle J. Navarro (https://djnavarro.net/) and David R. Foxcroft
(https://www.davidfoxcroft.com/).

20
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Jonas Rafi (https://www.su.se/english/profiles/jora9288-1.283149)
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Chapter 8. Descriptive analyses

CHAPTER

NINE

T-TEST: INDEPENDENT SAMPLES

How to perform an independent samples t-test in jamovi:
1. You need at least one
continuous dependent variable, and a
(e.g. treatment / control).

grouping variable with two levels

A correct setup should look similar to this:

2. Select Analyses → T-Tests → Independent Samples T-Test.

3. Drag and drop your outcome variable to Dependent Variables and your grouping variable to
Grouping Variable.

23
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4. The result is shown in the right panel.

:
Those who have previous experience with SPSS may want to have a look at the side-by-side-comparison ( 137)
of how a t-test for independent samples is conducted in SPSS and jamovi.

Community resources

This video (https://www.youtube.com/embed/SM-DN9dpPd4?list=PLkk92zzyru5OAtc_ItUubaSSq6S_TGfRn)
by Barton Poulson (https://datalab.cc/jamovi) provides a more comprehensive introduction into this test.

For those, aiming to stretch even further to an in-depth introduction, you can read the respective section in the
Learning statistics with jamovi web documentation (https://lsj.readthedocs.io/en/latest/lsj/Ch11_tTest_03.html)
or chapter 11.3 / 11.4 of the e-book (https://www.learnstatswithjamovi.com/) by Danielle J. Navarro
(https://djnavarro.net/) and David R. Foxcroft (https://www.davidfoxcroft.com/).

Jonas Rafi (https://www.su.se/english/profiles/jora9288-1.283149)
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CHAPTER

TEN

T-TEST: PAIRED SAMPLES

How to perform a paired samples t-test in jamovi:
1. You need two
continuous variables, with each row representing a subject. i.e. the pair of values taken
from each row represent paired measurements.

A correct setup should look similar to this:

2. Select Analyses → T-Tests → Paired Samples T-Test.

3. Drag and drop your two variables to Paired Variables (you can drag these one at a time, or select
both variables in a pair by holding down the Ctrl-key while clicking on each, before dragging them across).
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4. The result is shown in the right panel.

:
Those who have previous experience with SPSS may want to have a look at the side-by-side-comparison ( 141)
of how a t-test for paired samples is conducted in SPSS and jamovi.

Further help from the community resources

This video (https://www.youtube.com/embed/lSjfYYiJG6E?list=PLkk92zzyru5OAtc_ItUubaSSq6S_TGfRn) by
Barton Poulson (https://datalab.cc/jamovi) provides a more comprehensive introduction into this test.

For those, aiming to stretch even further to an in-depth introduction, you can read the respective section in the
Learning statistics with jamovi web documentation (https://lsj.readthedocs.io/en/latest/lsj/Ch11_tTest_05.html)
or chapter 11.5 of the e-book (https://www.learnstatswithjamovi.com/) by Danielle J. Navarro
(https://djnavarro.net/) and David R. Foxcroft (https://www.davidfoxcroft.com/).

Jonas Rafi (https://www.su.se/english/profiles/jora9288-1.283149)
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CHAPTER

ELEVEN

T-TEST: ONE SAMPLE

How to perform a one-sample t-test in jamovi:
1. You need one

continuous variable and a mean to test against (typically the mean being tested is zero).

A correct setup should look similar to this:

2. Select Analyses → T-Tests → One Sample T-Test.

3. Drag and drop your dependent variable to Dependent Variables.
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4. Locate the section Hypothesis further down, this is where you enter the mean you want to test against.

5. The result is shown in the right panel.
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Further help from the community resources

This video (https://www.youtube.com/embed/DrBT4ezYIL8?list=PLkk92zzyru5OAtc_ItUubaSSq6S_TGfRn)
by Barton Poulson (https://datalab.cc/jamovi) provides a more comprehensive introduction into this test.

For those, aiming to stretch even further to an in-depth introduction, you can read the respective section in the
Learning statistics with jamovi web documentation (https://lsj.readthedocs.io/en/latest/lsj/Ch11_tTest_02.html)
or chapter 11.2 of the e-book (https://www.learnstatswithjamovi.com/) by Danielle J. Navarro
(https://djnavarro.net/) and David R. Foxcroft (https://www.davidfoxcroft.com/).

Jonas Rafi (https://www.su.se/english/profiles/jora9288-1.283149)
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CHAPTER

TWELVE

ANOVA: ONE-WAY

How to perform a One-way ANOVA in jamovi:
1. You need one

continuous dependent variable, and one

grouping variable with two or more levels.

A correct setup should look similar to this:

2. Select Analyses → ANOVA → One-way ANOVA.
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3. Drag and drop your outcome variable to Dependent Variable and your grouping variable to Fixed
Factors.

4. Select whether your variances are equal or unequal. To test for equality of variancess using Levenes test,
tick the box Equality of variances.

5. The results are shown in the right panel:

Further help from the community resources
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Those looking for an in-depth introduction: You may read the respective chapter in the Learning statistics with
jamovi web documentation (https://lsj.readthedocs.io/en/latest/lsj/Ch13_ANOVA_01.html) or chapter 13.1 - 6 of
the e-book (https://www.learnstatswithjamovi.com/) by Danielle J. Navarro (https://djnavarro.net/) and David R.
Foxcroft (https://www.davidfoxcroft.com/).

Jonas Rafi (https://www.su.se/english/profiles/jora9288-1.283149)
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CHAPTER

THIRTEEN

ANOVA

How to perform a factorial ANOVA in jamovi:
1. You need one

continuous dependent variable, and one or more

grouping variables.

A correct setup should look similar to this:

2. Select Analyses → ANOVA → ANOVA.
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3. Drag and drop your outcome variable to Dependent Variable and your grouping variables to Fixed
Factors.

4. The results are shown in the right panel:

Further help from the community resources

A more comprehensive introduction into this statistical method is provided by this video
(https://www.youtube.com/embed/TJoJTVgDyqY?list=PLkk92zzyru5OAtc_ItUubaSSq6S_TGfRn) by Barton
Poulson (https://datalab.cc/jamovi).

For those, aiming to stretch even further to an in-depth introduction, you can read the respective section in the
Learning statistics with jamovi web documentation
(https://lsj.readthedocs.io/en/latest/lsj/Ch14_ANOVA2_01.html) or chapter 14.1 - 4 of the e-book
(https://www.learnstatswithjamovi.com/) by Danielle J. Navarro (https://djnavarro.net/) and David R. Foxcroft
(https://www.davidfoxcroft.com/).

Jonas Rafi (https://www.su.se/english/profiles/jora9288-1.283149)
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CHAPTER

FOURTEEN

ANOVA: REPEATED MEASURES

How to perform a repeated measures ANOVA in jamovi:
1. You need one

continuous dependent variable for each measurement occasion.

A correct setup should look similar to this:

2. Select Analyses → ANOVA → Repeated Measures ANOVA.

3. In the box Repeated Measures Factors: write the name of your outcome variable
(e.g., My_scale) and name the levels for each measurement occasion (e.g., Pre, Post and 12 month
follow-up). The images below shows the box with default values (left) and when the values has been
set (right).
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→

4. Drag and drop your outcome variables to their respective cells in Repeated Measures Cells.

5. To test the equality of the variance with the Levene test, open the Assumption Checks drop-down
menu and set the Homogeneity test tick box. It is also a good idea to check that the variances at the
different steps of the repetition factor are the same (Sphericity). To do so, open the Assumption
Checks drop-down menu and set the Sphericity tests tick box.

6. The results are shown in the right panel:
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Further help from the community resources

A more comprehensive introduction into this statistical method is provided by this video
(https://www.youtube.com/embed/m5JNwPgiMso?list=PLkk92zzyru5OAtc_ItUubaSSq6S_TGfRn) by Barton
Poulson (https://datalab.cc/jamovi).

For those, aiming to stretch even further to an in-depth introduction, you can read the respective section in the
Learning statistics with jamovi web documentation
(https://lsj.readthedocs.io/en/latest/lsj/Ch13_ANOVA_07.html) or chapter 13.7 of the e-book
(https://www.learnstatswithjamovi.com/) by Danielle J. Navarro and David R. Foxcroft.

Jonas Rafi (https://www.su.se/english/profiles/jora9288-1.283149)
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CHAPTER

FIFTEEN

ANOVA: MIXED

How to perform a mixed ANOVA in jamovi:
1. You need one

continuous variable for each within-subject measurement (e.g. pre / post) and at least one

grouping variable (between-subjects-factor) with at least two levels (e.g., treatment / control, gender).

A correct setup should look similar to this:

2. Select Analyses → ANOVA → Repeated Measures ANOVA.

3. In the box Repeated Measures Factors: write the name of your outcome variable
(e.g., My_scale) and name the levels for each measurement occasion (e.g., Pre, Post and 12 month
follow-up). The images below illustrates this.
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4. Drag and drop your outcome variables to their respective cells in Repeated Measures Cells.

5. Move your grouping variable(s) to Between Subject Factors.

6. The result is shown in the right panel:
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Further help from the community resources

A little more comprehensive introduction into this statistical method is provided by this video
(https://www.youtube.com/embed/m5JNwPgiMso?list=PLkk92zzyru5OAtc_ItUubaSSq6S_TGfRn).

Jonas Rafi (https://www.su.se/english/profiles/jora9288-1.283149)
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Chapter 15. ANOVA: Mixed

CHAPTER

SIXTEEN

LINEAR REGRESSION

How to perform a linear regression in jamovi:
1. You need one

dependent variable, and at least one

predictor variable (aka a covariate).

A correct setup should look similar to this:

2. Select Analyses → Regression → Linear Regression.

3. Drag and drop your dependent variable to Dependent Variable and your explanatory variable to
Covariates if it is continuous or to Factors if it is categorical.
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4. The result is shown in the right panel:

:
Those who have previous experience with SPSS may want to have a look at the side-by-side-comparison ( 169)
of how a linear regression is conducted in SPSS and jamovi.

Further help from the community resources

A more comprehensive introduction into this statistical method is provided by this video
(https://www.youtube.com/embed/_5AVGuEzCXc?list=PLkk92zzyru5OAtc_ItUubaSSq6S_TGfRn) by Barton
Poulson (https://datalab.cc/jamovi).

For those, aiming to stretch even further to an in-depth introduction, you can read the respective section in the
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Learning statistics with jamovi web documentation
(https://lsj.readthedocs.io/en/latest/lsj/Ch12_Regression_03.html) or chapter 12.3 - 11 of the e-book
(https://www.learnstatswithjamovi.com/) by Danielle J. Navarro (https://djnavarro.net/) and David R. Foxcroft
(https://www.davidfoxcroft.com/).

Jonas Rafi (https://www.su.se/english/profiles/jora9288-1.283149)
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CHAPTER

SEVENTEEN

LOGISTIC REGRESSION

How to perform a logistic regression in jamovi:
1. You need one
categorical dependent variable (nominal or ordinal), and at least one continuous
explanatory variable.

A correct setup should look similar to this:

2. Logistic regression can be found by selecting Analyses → Regression. If the outcome variable is
nominal (as in the above image), select 2 Outcomes if it has 2 steps / different values, or N outcomes
if it has more than 2 steps. If the outcome variable is ordinal (e.g., low, medium, high), select Ordinal
Outcomes.

3. Drag and drop your dependent variable to Dependent Variable and your predictor to Covariates.
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4. Scroll down to the Model Coefficients drop-down-menu and check the options Odds ratio and
Confidence interval.

5. The result is shown in the right panel:

:
Those who have previous experience with SPSS may want to have a look at the side-by-side-comparison ( 173)
of how a logistic regression is conducted in SPSS and jamovi.
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Further help from the community resources

A little more comprehensive introduction into this statistical method is provided by this two videos, explaining
logistic regression with two levels
(https://www.youtube.com/embed/s7GL0z-3ymA?list=PLkk92zzyru5OAtc_ItUubaSSq6S_TGfRn) (to predict,
e.g., gender or clinical vs. control group) and with more than two levels
(https://www.youtube.com/embed/nuyEUEBf-GQ?list=PLkk92zzyru5OAtc_ItUubaSSq6S_TGfRn) (to predict,
e.g., food preferences: fast food, healthy food, high protein food, vegan food, etc.).

Sebastian Jentschke (https://www.uib.no/en/persons/Sebastian.Jentschke)
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CHAPTER

EIGHTEEN

HOW TO

The aim of the following section is to clear and simple instructions on how to deal with common tasks within
jamovi.

18.1 jamovis user interface
Sebastian Jentschke (https://www.uib.no/en/persons/Sebastian.Jentschke)

18.1.1 Install modules in jamovi
Click on the ń+ż-icon in the top-right corner to install modules from the jamovi library.

Choose the jamovi library from the menu that opens.

In the window that opens now, first click on ńAvailableż (top-middle). Then go through the list with modules and
click ńINSTALLż at any module that you would like to use. Finally, close this window by clicking on the arrow
pointing up (top-right corner).
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18.2 Analyses
Sebastian Jentschke (https://www.uib.no/en/persons/Sebastian.Jentschke)

18.2.1 Use the R-version of the PROCESS-macro from within jamovi
In preparation: You need to install Rj and to download the most recent version of the PROCESS-macro. Open the
ZIP-file that you downloaded, go into the folder PROCESS v... for R and extract the process.R-file into
your Documents-directory.
Open a data file that you want to use for your analyses. Afterwards, open Rj using the R-symbol in the
Analyses-icon-bar (Rj is a jamovi module; if you have not installed it yet, you may check Install modules
in jamovi ( 53)).
Now you are ready to write R-code inside jamovi. Run the following code in the Rj text box for commands. You
may just copy-and-paste the following code.
• on Windows
source(file.path(Sys.getenv('HOMEDRIVE'), Sys.getenv('HOMEPATH'),
,→'Documents', 'process.R'))
• on Mac and Linux
source(file.path(Sys.getenv('HOME'), 'Documents', 'process.R'))
Run this code (source) by pressing the green triangle. Please be patient, it might take a moment (up to a minute,
depending on how fast your computer is). You should see an output like this
******************** PROCESS for R Version 4.2 beta ****************
Written by Andrew F. Hayes, Ph.D. www.afhayes.com
Documentation available in Hayes (2022). www.guilford.com/p/hayes3
***********************************************************************
PROCESS is now ready for use.
Copyright 2022 by Andrew F. Hayes ALL RIGHTS RESERVED
Workshop schedule at http://haskayne.ucalgary.ca/CCRAM
Afterwards, the PROCESS-macro is initialized and you can comment the line out (by putting a # at the start of
the line) → # source(
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Now you are set to run analyses. Please note that the PROCESS-macro for R uses a different random number
generator than SPSS and SAS1 and that therefore the bootstrapping confidence intervals for the Indirect effect(s)
of X on Y are different from what the output shown in the book. Furthermore, does the current version of the
PROCESS-macro for R accept data only in numeric format.2 Thus, factors must be converted to numeric form
(e.g., 0 and 1) prior to their use in a PROCESS command. This can be done using the following command in Rj
(just copy-and-paste it).
for (C in names(data)[sapply(data, is.factor)]) {
data[[C]] = as.numeric(data[[C]]) - min(as.numeric(data[[C]]))
}
Once this is done, you may just write (or copy-and-paste if you own the e-book) the commands that are shown in
the book. Please note that you have to change the name of the data set: in this example, taken from p. 188 of Hayes
(2022), the dataset pmi is required (to download the data sets (https://afhayes.com/public/hayes2022data.zip)).
Thecommand in the book has to be adjusted by changing data = pmi into data = data (data refers to the
currently opened dataset in jamovi).
process(data = data, y = "reaction", x = "cond", m = c("import",
,→"pmi"), total = 1, contrast = 1, model = 6,seed = 31216)
Please remember that you have to run the source command again whenever you open a new dataset / a new
jamovi session. If you want to run several analyses with the same dataset / within the same jamovi session, this is
not required.
Jonathon Love

1 The default random number generator in R is dierent than the default random number generator in SPSS and SAS. Thus, bootstrap
confidence intervals generated by R will be dierent than those produced by SPSS and SAS even when the same seed is used when estimating
the same model using the same data. (Hayes, 2022, p. 613)
2 PROCESS for R accepts data only in numeric format. Thus, for example, if a variable named sex were coded M and F in the data, these
alphabetic codes must be converted to numeric form (e.g., 0 and 1) prior to their use in a PROCESS command. (Hayes, 2022, p. 612)

18.2. Analyses
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CHAPTER

NINETEEN

DEVELOPER HUB

Welcome to the developer hub (https://dev.jamovi.org) for jamovi (https://www.jamovi.org).
Here you will find resources that cover the development of analyses for jamovi (and R). Its still a
work in progress, and well be adding to it over time, but the current tutorial series has everything you
need to get up and running.
Jonathon Love

19.1 Gentle steps into developing a jamovi module
Jonathon Love

19.1.1 Getting Started
Before we begin, analyses in jamovi are written in the R programming language
(https://www.r-project.org/). This tutorial assumes you have some knowledge of R, and
ideally some experience in writing R packages.
That out of the way, lets begin!
Development of modules for jamovi requires the jmvtools package. In this tutorial we
will:
1. install jmvtools
2. ensure that jmvtools can find jamovi
3. build and install a jamovi module from GitHub
Install jmvtools
jmvtools is available from the jamovi repo, and can be installed in R with:
install.packages('jmvtools', repos=c('https://repo.jamovi.
,→org', 'https://cran.r-project.org'))

Check jmvtools can find jamovi
Now you have jmvtools installed, we can check whether it can locate your jamovi
installation:
jmvtools::check()
jmvtools searches for jamovi in what might be considered usual places‘, such as:
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/Applications
/usr/lib/jamovi
C:\Program Files
If jmvtools cant find it, you can specify the path in the call to check():
jmvtools::check(home=
,→'C:\\Users\\jonathon\\Documents\\jamovi')
(you should substitute in your own path, unless your username is jonathon, and youve got
jamovi in your documents folder).
If you have to specify this path, you can set this for the remainder of the session with
options():
options(jamovi_home='C:\\Users\\jonathon\\Documents\\jamovi
,→')

Install a Module
Now we have jmvtools installed and working, we can use it to build and install a module.
If you havent already, start up jamovi.
Next well download a module from GitHub, build and install it.
well use the Base R
(https://github.com/jamovi/jmvbaseR) module – you can download it using the direct link
here (https://github.com/jamovi/jmvbaseR/archive/master.zip).
Unzip the source directory and open the project file jmvbaseR.Rproj in RStudio (or
just set your working directory to the sources directory). Now we can call the install()
function:
jmvtools::install()
# not to be mistaken for
,→devtools::install()
This will build the module, and install it into jamovi.
If you turn now to your open jamovi window, youll see a new Base R menu has appeared
on the ribbon, with a set of new analyses. The ability to install and update jamovi analyses
from R turns out to be pretty nifty, because as well see in the next section, we can make
changes to an analysis, run jmvtools::install() again, and immediately see those
changes reflected in jamovi. This makes developing and testing jamovi analyses a breeze!

Jonathon Love
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19.1.2 Creating a Module
In this section we will create a jamovi module from scratch, and install it into jamovi. This
section builds on knowledge from the previous: Getting Started ( 57).
The easiest way to create a module for jamovi is with the create() function from the
jmvtools package:
jmvtools::create('SuperAwesome')
This will create a module called SuperAwesome in the current working directory. If we
now look at the contents of the freshly minted SuperAwesome, we will find:
SuperAwesome/
DESCRIPTION
NAMESPACE
jamovi/
|
0000.yaml
R/
This should seem suspiciously familiar to anyone whos worked on R packages before.
Thats because jamovi modules are R packages, but with that additional jamovi/0000.
yaml-file. With that file, this package becomes a dual citizen: it can be built into an R
package, and it can be built into a jamovi module.
If you take a look in the 0000.yaml-file, youll notice it contains a very similar set of
values to the DESCRIPTION-file. However, as we add analyses to the module, they will
come to be listed in this file as well. In the early stages of development, theres not much
need to interact with this file, so well return to it later.
Jonathon Love

19.1.3 Creating an analysis
T-Test
In this section, we are going to add a t-test analysis to the module we created in the previous
section.
An independent samples t-test is typically used to determine whether two groups differ on
some variable. For example, you may be interested in whether children from one neighbourhood are a different height than children from another neighbourhood. In this case, a
data set would have one row for each child - one column would contain their heights, the
other column would contain which neighbourhood they are from.
For those familiar with the t.test function built into R, if the columns were height
and neighbourhood, the test could be run:
t.test(height ~ neighbourhood, data=data)
In this next section, we are going to create a t-test jamovi analysis which makes use of this
function.
Creating an Analysis
The easiest way to begin an analysis for a jamovi module is to use the addAnalysis()
function from the jmvtools package. First well set the working directory to the
SuperAwesome directory (created by jmvtools::create() in the previous section), and then call addAnalysis()

19.1. Gentle steps into developing a jamovi module
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setwd('SuperAwesome')
jmvtools::addAnalysis(name='ttest', title='Independent
,→Samples T-Test')

Anatomy of an Analysis
If we now look at the SuperAwesome modules source tree, we have:
SuperAwesome/
DESCRIPTION
NAMESPACE
jamovi/
|
ttest.a.yaml
|
ttest.r.yaml
|
ttest.u.yaml
|
0000.yaml
R/
ttest.h.R
ttest.b.R
At this point Im a little embarrassed to say that there are 5 files per analysis. This structure
does make things a lot more manageable, so although it may seem excessive at first, theres
a good rationale behind it. Just bear with me, its not as overwhelming as it seems.
file
ttest.a.
yaml
ttest.r.
yaml
ttest.u.
yaml
ttest.h.R

ttest.b.R

contains
The analysis definition contains all the meta information about the
analysis, describes the arguments and ui options it receives, etc. Well
cover this in the tutorial next.
The results definition contains all the information about the way the
results for the analysis are displayed.
The ui definition is automatically generated from the .a.yaml-file.
For many analyses this will produce a good result, and wont need
further editing.
The header file is automatically generated from the .a.yaml and
.r.yaml-files above, and makes writing your analysis a lot easier.
You dont ever need to look at this file, and you certainly shouldnt edit
it.
The analysis implementation is where youll write your analysis, and
where youll spend most of your time when developing jamovi analyses. As well see, this is an empty template waiting for an implementation.

The Analysis Definition
First up, well look at the analysis definition in the ttest.a.yaml-file. YAML is a
simple, easy to read text format for structured data. If youre new to YAML, you can
read more about the format here (https://yaml.org/spec/1.2), but that probably wont be
necessary. Its intuitive and readable, and youll probably have no trouble picking it up.
jmvtools::addAnalysis() creates a default .a.yaml-file with a handful of basic
options. Happily for this tutorial, these happen to correspond to the options that a t-test
requires. Our generated ttest.a.yaml-file is as follows:
- name: ttest
title: Independent Samples T-Test
()
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()

jas: "1.1"
version: 1.0.0
options:
- name: data
type: Data
- name: dep
title: Dependent Variable
type: Variable
- name: group
title: Grouping Variable
type: Variable
- name: alt
title: Alternative hypothesis
type: List
options:
- name: notEqual
title: Not equal
- name: oneGreater
title: One greater
- name: twoGreater
title: Two greater
default: notEqual
- name: varEq
title: Assume equal variances
type: Bool
default: true
At the top of the .a.yaml-file is information about the analysis:
name: ttest
title: Independent Samples T-Test
jas:
"1.1"
version: "1.0.0"
The name is a unique identifier for the analysis, but it also corresponds to the name of the
R function which will be made available from the package. As such, the usual constraints
on function names apply: it must begin with a letter, and can only be made up of letters
and numbers (jamovi disallows analysis names with dots in them).
The title of the analysis is how the analysis appears in menus, help text, and in the results.
Next is the jas or jamovi analysis spec; you should just leave this at 1.1. Next, we have
the analysis version. Each analysis is versioned in jamovi, and you should make use of
semantic versioning (http://semver.org/) (but lets not worry about that for now).
The options come next; data, dep, group, alt and varEq. When used as an R
package, these options correspond to the arguments passed to the analysis R function. In
this case they will be:
ttestIS(data, dep, group, alt='not equal', varEq=FALSE)
(If you peek inside ttest.h.R, youll find this exact function has been generated.)
When used in jamovi, these options correspond to the UI options for the analysis. Lets
look at that now. Install the module weve just created and open up jamovi (or open up
jamovi first, then install the module the order doesnt matter):
19.1. Gentle steps into developing a jamovi module
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jmvtools::install()
(Note that if your module has additional dependencies, these will be installed by
jmvtools::install() at this stage as well. You can read more about additional
dependencies in Additional Notes ( 77) at the end of this tutorial.)
The SuperAwesome menu will now be available, and will contain Independent
Samples T-Test.

Selecting this analysis will bring up the UI:

We can see how the UI elements created, correspond to the analyses options. Revisiting
the dep and group options from ttestis.a.yaml:
- name: dep
title: Dependent Variable
type: Variable
- name: group
title: Grouping Variable
type: Variable
We see they are of type Variable. This means they require the user to provide a column
from the data set. As can be seen in the UI, they are represented as drop targets, where
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columns from the data set can be assigned through drag and drop.
Turning to the option alt
- name: alt
title: Alternative hypothesis
type: List
options:
- name: notEqual
title: Not equal
- name: oneGreater
title: One greater
- name: twoGreater
title: Two greater
default: notEqual
The UI element alt is of type list, which has been turned into a drop down list, allowing
the user to choose between the options.
Finally, looking at varEq
- name: varEq
title: Assume equal variances
type: Bool
default: true
We see that options of type Bool are represented as checkboxes.
There are a number of different option types. A more comprehensive description of each
of them, and their properties is available by clicking on the occurrences of .a.yaml in
this document.
Of course, our analysis doesnt actually do anything yet – we havent written any R code.
Jonathon Love

19.1.4 Implementing an analysis
In this section we will add the implementation, that is the R code, to perform our t-test
analysis.
In jamovi analyses, the implementation lives in the .b.R-file, so if we look in our ttest.
b.R-file we see
# This file is a generated template, your changes will not
,→be overwritten
#' @rdname jamovi
#' @export
ttestClass <- R6::R6Class("ttestClass",
inherit = ttestBase,
private = list(
.run = function() {
# `self$data` contains the data
# `self$options` contains the options
# `self$results` contains the results object
,→(to populate)
()
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()

})
)
This is another file that our call to jmvtools::create() created. Now this may
appear unfamiliar, and might not look like most of the R code youve written, but thats
OK, you dont really need to know whats going on here. What is going on here is that
the analysis is represented by an R6 class. For the curious, you can read more about R6
classes here (https://cran.r-project.org/web/packages/R6/vignettes/Introduction.html), but
all you really need to know is that you write your analysis in the .run function, and you
can safely ignore the rest.
Youll also notice that the .run() function receives no arguments. We access the values that the user specified (either in the jamovi ui, or as arguments to the generated
ttestIS()-function) through self. Again, this may seem a little unfamiliar, but it
is very straight forward.
As covered in the previous section ( 59), our t-test has four options (as defined in ttest.
a.yaml), dep, group, alt and varEq, we can access the values for each of these in
our analysis with:
• self$options$dep
• self$options$group
• self$options$alt
• self$options$varEq
Additionally, ttest.a.yaml defined the special data option, which means we can
access the data provided by the user as a data frame (either the data loaded in jamovi, or
the data passed as an argument to ttestIS() function in R), with:
self$data
Now we have access to the options, and access to the data, we can begin writing our
analysis as follows
ttestClass <- R6::R6Class("ttestClass",
inherit=ttestBase,
private=list(
.run=function() {

,→

formula <- paste(self$options$dep, '~', self
$options$group)
formula <- as.formula(formula)
results <- t.test(formula, self$data)
print(results)
})

)
First, we take the values of self$options$dep and self$options$group, which
are both strings and assemble them into a formula. Then we can call the t.test()
function passing in this formula, and the self$data data frame. Finally, we print the
result.
Now this analysis will and does work; however when running in jamovi, the result of
the print statement will appear at the terminal, rather than in the applications results area
(where the user would like it). To remedy this, rather than simply printing the results, we
assign the results to the analysis results-object. When run in an R session, the results
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will still be printed, but when run in jamovi, the results will appear in the results panel.
We assign to the analysis results-object using (you guessed it), self$results. Our
new function will now read:
ttestClass <- R6::R6Class("ttestClass",
inherit=ttestBase,
private=list(
.run=function() {

,→

,→

formula <- paste(self$options$dep, '~', self
$options$group)
formula <- as.formula(formula)
results <- t.test(formula, self$data, var.
equal=self$options$varEq)
self$results$text$setContent(results)
})

)
In this new function, we get the results element called text from self$results,
and call setContent() with the results from the t-test. Well cover results elements in
greater depth in the next section, but for now this is all you need to know.
So now our analysis is implemented, its time to install it and try it out. Install the module
with the usual:
jmvtools::install()
Now open the Tooth Growth data set from the jamovi examples (File → Examples →
Tooth Growth). Assign the len column to the Dependent Variable, and the supp
column to the Grouping Variable. You should have something like the following:
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Similarly, we can install this module as an R package using the devtools package (not
to be confused with jmvtools), and run the same analysis in an interactive R session:
devtools::install()
library(SuperAwesome)
data(ToothGrowth)
ttest(data=ToothGrowth, dep='len', group='supp')
Independent Samples T-Test
Two Sample t-test
data: len by supp
t = 1.9153, df = 58, p-value = 0.06039
alternative hypothesis: true difference in means is not
,→equal to 0
95 percent confidence interval:
()
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()

-0.1670064 7.5670064
sample estimates:
mean in group OJ mean in group VC
20.66333
16.96333
Before we continue, astute readers will have realised that assembling our formula with
paste is problematic. If either column name has spaces or special characters, paste will
produce a bad formula. For example, if the user specified a dependent variable called
the fish the resultant formula would be the fish~group, and the call to as.
formula() would fail:
as.formula('the fish~group')
## Error in parse(text = x, keep.source = FALSE) :
##
<text>:1:5: unexpected symbol
## 1: the fish
##
^
The names of the columns making up the formula need to be escaped, or quoted. Fortunately, jmvcore provides the function constructFormula(), which assembles
simple formulas appropriately escaping column names:
constructFormula('the fish', c('group'))
## [1] "'the fish'~group"
We can modify our analysis to use this instead:
ttestISClass <- R6Class("ttestISClass",
inherit=ttestISBase,
private=list(
.run=function() {

,→

formula <- constructFormula(self$options$dep,
self$options$group)
formula <- as.formula(formula)
results <- t.test(formula, self$data)
self$results$text$setContent(results)
})

)
The jmvcore package contains many such useful functions. It would be worth checking
them out.
Jonathon Love

19.1.5 Debugging an Analysis
Hopefully you got throw the last section without encountering any errors in your analysis.
In this section, well explore how to debug an analysis which is going wrong. For example,
if we change our .run() function to produce an error:
ttestISClass <- R6Class("ttestISClass",
inherit=ttestISBase,
private=list(
.run=function() {
()
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()

t.test(c(Inf, 3))

# <-- produces an error!

})
)
We receive the following error message.

In this example, our code is only one line of code, so we can be reasonably confident
where the problem lies. However, in practice software can be two or three or even more
lines of code. In more complex situations, it can be handy to have a stack trace which tells
us where the problem occurred. jamovi can be placed in dev mode, which displays stack
traces when errors occur. dev mode can be toggled from the app menu to the top right of
the jamovi window:

With dev mode turned on, we can see the stack trace and see that the call to t.
test(c(Inf, 3)) is responsible for the error.
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When developing jamovi modules, its best to just leave dev mode on.
Jonathon Love

19.1.6 Creating Rich Results
In this section, we will add rich results to our analysis; a nice APA formatted table like
this:

Rich results are visually appealing, and make it easier for users of your module to parse and
understand the results your module produces. A lot of people find statistics challenging,
so we might as well make them as accessible and easy to read as possible.
The Results Definition
In order to provide rich results, we need to add some entries into the results definition.
This is the ttest.r.yaml-file which was created earlier in this tutorial series:
- name: ttest
title: Independent Samples T-Test
jrs: "1.1"
items:
- name: text
title: Independent Samples T-Test
type: Preformatted
This is pretty similar to the ttest.a.yaml-file; theres a name, a title, and a jamovi
results spec (jrs) (note, this is different to the jas in the .a.yaml-file). items comes
next, and it describes all the items that make up the results. For example, the results could
be made up of two tables and a plot. Each item in the results is listed here.
At present, the results contains a single Preformatted results item called text with
the title Independent Samples T-Test. If you think back to the previous section
( 63), we accessed a results object with the following:
self$results$text
Now you can see where this seemingly arbitrary name text came from. This is how
different results-items are accessed.
Adding a Table
Lets add a table for our t-test results. For the time being, well leave the existing
Preformatted results item and add the table underneath. This will let us check that
the results we populate the table with are correct.
Modify ttest.r.yaml so it reads:
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- name: ttest
title: Independent Samples T-Test
jrs: "1.1"
items:
- name: text
title: Independent Samples T-Test
type: Preformatted
- name: ttest
title: Independent Samples T-Test
type: Table
rows: 1
columns:
- name: var
title: ''
type: text
- name: t
type: number
- name: df
type: integer
- name: p
type: number
format: zto,pvalue
With these modifications, weve added a new table called ttest with the title
Independent Samples T-Test. Weve also specified that it is to have 1 row, and
that it has four columns; var, t, df and p. Notice that weve specified an empty string for
the title of column var. If a title isnt specified the column name is used instead.
The type for each column is specified as either text, number or integer. The type
affects the way the column is formatted. text columns have their content left aligned,
number and integer columns have their content right aligned. integer columns are
formatted as whole numbers (no decimal places).
The format field is a string of comma separated values. It provides additional information on how a column should be formatted. In the case of the p column, it has two formats
applied, zto and pvalue. zto indicates that a value ranges between zero and one; this
causes it to be rendered to a fixed number of decimal places. In contrast, values without
this format are formatted to a fixed number of significant figures. This makes the biggest
difference with values close to zero; without zto the value 0.006 would be rendered 0.
00600 (3 significant figures), where as with zto it would be rendered 0.006 (3 decimal
places). With values like correlation coefficients and other values which range between
zero and one, the latter is generally preferred.
The other format is pvalue, which indicates that values in this column are p-values
(https://en.wikipedia.org/wiki/P-value). If any of these values drop below a threshold (.001
by default), they will be replaced with < .001.
Now that weve set up our table, we can see what it looks like by reinstalling the module:
jmvtools::install()
If you return to jamovi now, youll see that the installed module has been updated and our
earlier analysis has been rerun. The table we added is now visible in the results. This is
pretty handy: whenever you reinstall a module, it is updated immediately. Your results
should now look as follows:
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Populating a Table
Now weve created a table, lets fill it in with the values from the t-test. For this, we need
to extract the actual values from the t-test object returned by Rs t.test function. Rather
awkwardly, analyses in R dont return consistent results objects; theres generally no predictable way to know how to access the underlying values. Some R functions return lists,
others return S3 objects, others S4. Some require reading the values with indices ([[x]]),
others require the use of slots (@). It generally requires a bit of trial and error to figure out
how to access the underlying values of a results object. One useful function for this is the
mode() function. For example, we can call mode on a t.test results object like so:
results <- t.test(1:5)
mode(results)
This tells us that the results object from the t.test-function is a list (although somewhat
in disguise). We can then use the functions we normally use on lists, for example:
results <- t.test(1:5)
names(results)
With a little more tinkering we can figure out that results$statistic contains the
t statistic, results$parameter contains the degrees of freedom, and results$p.
value contains the p value (that last one probably didnt require that much tinkering).
We can assign each of these values to the row in our table with the setRow() function:
table <- self$results$ttest
table$setRow(rowNo=1, values=list(
var=self$options$dep,
t=results$statistic,
df=results$parameter,
p=results$p.value ))
Now if we reinstall our module:
jmvtools::install()
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Our results in jamovi should look something like this:

Now we have everything working, lets remove the text results:
ttestISClass <- R6Class('ttestISClass',
inherit=ttestISBase, private=list( .run=function() {
formula <- constructFormula(self$options$dep, self
,→$options$group)
formula <- as.formula(formula)
results <- t.test(formula, self$data)
table <- self$results$ttest
table$setRow(rowNo=1, values=list(
var=self$options$dep,
t=results$statistic,
df=results$parameter,
p=results$p.value
))
})
)
then perform a reinstall with jmvtools::install(). Now we have a nice, attractive,
minimalist t-test.

Lets also take a look at running this analysis in an R session. We can install the package
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into R with:
devtools::install()
,→jmvtools

# note here we're using devtools, not

and run the analysis with:
library(SuperAwesome)
data('ToothGrowth')
ttest(ToothGrowth, dep='len', group='supp')
Independent Samples T-Test
Independent Samples T-Test

len

t

df

p

1.92

55

0.061

As can be seen, a nicely formatted table has been generated in R as well. Everything is
maintained, right down to the number of decimal places. In this way jamovi can make R
packages even if you have no intention of publishing as jamovi modules more attractive,
easier to read, and more consistent too.
Jonathon Love

19.1.7 Adding Plots
In this section, well add a plot to the t-test analysis weve been developing in this series. A
plot is another item to appear in the results, so well add another entry into our ttest.r.
yaml-file:
- name: ttest
title: Independent Samples T-Test
jrs: "1.1"
items:
- name: ttest
title: Independent Samples T-Test
type: Table
rows: 1
columns:
- name: var
title: ""
type: text
- name: t
type: number
- name: df
type: integer
- name: p
type: number
format: zto,pvalue
- name: plot
title: Descriptives Plot
type: Image
width: 400
()
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()

height: 300
renderFun: .plot
Same as before, we define an item with a name, title and a type; in this case the
type is Image. Additionally, we define renderFun which is the name of the function
responsible for rendering the image. Whatever we specify as the render function, we must
add as a private member function to ttestClass in ttest.b.R:
#' @export
ttestClass <- R6::R6Class(
"ttestClass",
inherit = ttestBase,
private = list(
.run = function() {
formula <- paste(self$options$dep, '~', self
,→$options$group)
formula <- as.formula(formula)
results <- t.test(formula, self$data)
table <- self$results$ttest
table$setRow(rowNo=1, values=list(
var=self$options$dep,
t=results$statistic,
df=results$parameter,
p=results$p.value
))
},
.plot=function(image, ...) {
,→function

# <-- the plot

})
)

Adding ggplot2
Were going to use ggplot2 for plotting, so make sure you have that installed. To use
ggplot2 in this package / module, we need to add some entries into the DESCRIPTIONand NAMESPACE-files. We add ggplot2 to the imports line in the DESCRIPTION-file,
so it reads:
Imports: jmvcore, R6, ggplot2
and well add the following line into NAMESPACE:
import(ggplot2)
These entries are standard for using R code from other packages in a package. More
information is available in Writing R Extensions (https://cran.r-project.org/doc/manuals/rrelease/R-exts.html).
Now we have ggplot2 ready, we can proceed with using it in our analysis.
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Implementing Plots
In jamovi modules, plotting occurs in two stages; first the data for the plot is prepared, then
the plot is rendered. The two stages mean that if the image is resized, or the user requests a
different file format, only the rendering needs to be performed again the data preparation
needs only to occur once.
For the t-test, were going to plot a mean for each of the groups, and the standard errors. In
ggplot2, were required to assemble these plot points into a data frame, which we will
do as follows:
means <- aggregate(formula, self$data, mean)[,2]
ses
<- aggregate(formula, self$data, function(x) sd(x)/
,→sqrt(length(x)))[,2]
sel
<- means - ses # standard error lower bound
seu
<- means + ses # standard error upper bound
levels <- base::levels(self$data[[self$options$group]])
plotData <- data.frame(level=levels, mean=means, sel=sel,
,→seu=seu)
##
level
mean
sel
seu
## 1
OJ 20.66333 19.45733 21.86934
## 2
VC 16.96333 15.45417 18.47250
This plot data we assign to the image using the setState() function:
image <- self$results$plot
image$setState(plotData)``
Next, well add the plotting code into the .plot() function we created:
.plot=function(image, ...) {
plotData <- image$state
plot <- ggplot(plotData, aes(x=level, y=mean)) +
geom_errorbar(aes(ymin=sel, ymax=seu, width=.
,→1)) +
geom_point(aes(x=level, y=mean)) +
labs(title=self$options$dep)
print(plot)
TRUE
}
The plot function accepts an argument image, which corresponds to the image object
we called setState() on. We can retrieve the state object from this image with
image$state, which we can see is being assigned to plotData.
Following this are a number of calls to ggplot2 functions. A full discussion of how to
use ggplot2 is well and truly beyond the scope of this document, but there are many
excellent resources available online.
Next we explicitly print the ggplot-object. When using ggplot interactively in an R session, calling ggplot() leads to the creation of the plot, however, when calling ggplot
from inside a function, it is necessary to explicitly call print().
The final statement is TRUE which is the return value. Dont forget this! Returning true
notifies the rendering system that you have plotted something. If you dont return true, your
plot will not appear. There are situations where the user may not have specified enough
information for plotting, in which case the function should return FALSE.
So this is our final ttest.b.R-file:
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#' @export ttestClass <- R6::R6Class("ttestClass", inherit
,→= ttestBase, private = list(
.run = function() {
formula <- paste(self$options$dep, '~', self
,→$options$group)
formula <- as.formula(formula)
results <- t.test(formula, self$data)
table <- self$results$ttest
table$setRow(rowNo=1, values=list(
var=self$options$dep,
t=results$statistic,
df=results$parameter,
p=results$p.value
))
means <- aggregate(formula, self$data, mean)[,2]
ses
<- aggregate(formula, self$data,
,→function(x) sd(x)/sqrt(length(x)))[,2]
sel
<- means - ses # standard error lower
,→bound
seu
<- means + ses # standard error upper
,→bound
levels <- base::levels(self$data[[self$options
,→$group]])
plotData <- data.frame(level=levels, mean=means,
,→sel=sel, seu=seu)
image <- self$results$plot
image$setState(plotData)
},
.plot=function(image, ...) {
plotData <- image$state
plot <- ggplot(plotData, aes(x=level, y=mean)) +
geom_errorbar(aes(ymin=sel, ymax=seu,
,→width=.1)) +
geom_point(aes(x=level, y=mean)) +
labs(title=self$options$dep)
print(plot)
TRUE
})
)
And these are our final results, including the plot:
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Jonathon Love

19.1.8 Distributing Modules
Calls to jmvtools::install() produce a file with the extension .jmo in the current
working directory. This file is your module, and can be distributed to other people, to sideload. This is a good way to distribute your module during testing, where you might want
to send it to a handful of people. People can side-load modules from within the jamovi
store (accessible from a menu at the top right of jamovi).
Once you are satisfied that your module is ready for broader distribution, we encourage
you to submit it to the jamovi library (https://www.jamovi.org/library.html). This makes
your module browseable and discoverable by anyone using jamovi.
If you have a module you would like to submit to the jamovi store, do get in touch with us
(contact@jamovi.org).
Jonathon Love

19.1.9 Additional Notes
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Dependencies
jmvtools::install() also downloads all your packages dependencies (listed in
DESCRIPTION), and bundles them into your module. This ensures that the module has
everything it needs, and also that a module will always use predictable dependency versions. This results in larger module file sizes, but arguably is a small price to pay for
reproducibility given how inexpensive disk space is.
Namespaces
We recommend you minimise import statements in your NAMESPACE-file. These can
lead to substantial delays when your package is loading, as all listed imports in the
NAMESPACE-file are loaded whether they are required or not.
Instead, access functions with their full namespace, i.e.:
stats::t.test(...)
With this approach, dependencies are only loaded when they are required. This improves
start-up time (the delay between a user selecting one of your analyses, and results appearing for the first time), and can lead to a significant reduction in the amount of RAM your
module uses.
Jonathon Love

19.2 Advanced topics in jamovi module development
Jonathon Love

19.2.1 Dynamic tables
In the previous tutorial series, we looked at constructing and populating tables
( 69). The .r.yaml-file contained:
- name: ttest
title: Independent Samples T-Test
type: Table
rows: 1
columns:
- name: var
title: ''
type: text
- name: t
type: number
- name: df
type: integer
- name: p
type: number
format: zto,pvalue
That is, the results contained a table called ttest with the title Independent
Samples T-Test, with 4 columns and 1 row.
In practice however, the number of rows in the table often isnt fixed. They may
vary based on the options the user has selected, or based on the results of the
analysis itself. In this tutorial, we will concentrate on the former.
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In the previous tutorial series, we created a t-test analysis. It allowed the user to
specify a single dependent variable, and a single grouping variable. However, we
could make this analysis more convenient by allowing people to specify multiple
dependent variables. For example, a data set might contain the columns gender,
height and weight. By allowing multiple dependent variables, the user could
specify height and weight as the dependent variables, and gender as the
grouping variable. Our analysis could then perform multiple t-tests (one for each
dependent variable). The resulting analysis might look something like this:

The first thing we need to do is change the dependent variable in the .a.yamlfile, from Variable to Variables.
- name: ttest
title: Independent Samples T-Test
menuGroup: SuperAwesome
version: '1.0.0'
jas: '1.1'
options:
- name: data
type: Data
- name: deps
# <-- let's add
,→an s
title: Dependent Variables # <-- and
,→another s
type: Variables
# <-- Variables
,→with an s!
As we have changed the name and type of the dep variable, our t-test will no
longer work. For now, you should comment out or delete the content of the
.run() function of the t-test analysis, otherwise it will produce a number of
errors. We will return to it later in this tutorial.
Having performed these modifications, your t-test UI should look something like:

19.2. Advanced topics in jamovi module development

79

Documentation for jamovi

As can be seen, multiple dependent variables can now be specified.
Now lets return to our .r.yaml-file, to the rows value in particular:
- name: ttest
title: Independent Samples T-Test
type: Table
rows: 1
What we now want, is not 1 row, but rather 1 row per dependent variable. If one
variable is assigned to the option deps, then we want the table to have 1 row.
If two variables are assigned to the option deps, then the table should have two
rows, etc.
The way we do this, is with whats called data-binding. Data-binding is where we
bind a particular property of a results object, to an option. In this case, we want
to bind the number of rows to the deps option. We do this be specifying the
option inside of parentheses (or brackets).
- name: ttest
title: Independent Samples T-Test
type: Table
rows: (deps)
When bound in this way, the number of rows in the table always matches the
number of variables specified by the user. Lets reinstall our module and see this
in action:

As can be seen, our table grows and shrinks accordingly. But we can do one
better. The first column should contain the variable name, and although we can
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add this using the Tables setRow() function, there is a better way to do this.
We can specify the content of the column in the .r.yaml-file.
The content in the .r.yaml-file can be a string literal, but it can also be a
data-binding as well. When the rows of a table are bound to an option, each row
has a key associated with it. When bound to an option of type Variables,
each rows key corresponds to the Variable for that row. This allows us to bind
the content of a column, to each rows key, as follows:
items:
- name: ttest
title: Independent Samples T-Test
type: Table
rows: (deps)
columns:
- name: var
title: ''
type: text
content: ($key) # <- here!
$key is a special value which maps to the rows key. Make this change, and
reinstall the module with jmvtools::install(). As can be seen the first
column is now filled in appropriately.

Data-binding is nice, because it often leads to much simpler code. The .yamlfiles are able to take care of a lot of aspects of the results objects, and allows
the R code (in the .b.R-files) to be much simpler, and focused on performing the calculations. In computer science, this is called separation of concerns
(https://en.wikipedia.org/wiki/Separation_of_concerns).
Now all we need do is add our analysis implementation to the .b.R-file. We can
fill the table in using either the rowKey or the rowNo.
.run=function() {
table <- self$results$ttest
for (dep in self$options$deps) {

,→

formula <- jmvcore::constructFormula(dep,
self$options$group)
formula <- as.formula(formula)
results <- t.test(formula, self$data)

,→

table$setRow(rowKey=dep, values=list(
set by rowKey!

#
()
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()

t=results$statistic,
df=results$parameter,
p=results$p.value
))
}
}
We can now reinstall the module using jmvtools::install() (Note that
this analysis will not work if you specify a nominal or ordinal variable as a dependent. So be sure to either use a continuous variable, or change the type of
the variable to continuous before assigning it as a dependent. We will look at the
correct way to handle nominal and ordinal variables in the next tutorial). You
should have something like the following:

Jonathon Love

19.2.2 Handling Data
So far in these tutorials, we havent really examined what the self$data data
frame actually contains. It contains the data from the dataset which is displayed
in the spreadsheet view, but exactly how these values map to the R type system
is a bit nuanced.
In jamovi there are four variable types:
• Nominal Text
• Nominal
• Ordinal
• Continuous
Nominal Text variables only ever have text values, so will come through in
the self$data data frame simply as factors. Continuous variables only
ever have numeric values, so in the self$data data frame, they are of type
numeric. However, the Nominal and Ordinal variable types are a little more
tricky. These can have both numeric and text values.
Further, there are situations where you want to treat a Nominal or Ordinal
variable as a factor (i.e. when it is used as the grouping variable for a t-test), but
other times where you want to use it as a number (i.e. when taking a mean of
say, Likert items). Some would argue that this should never happen – you should
never be taking the mean of a categorial variable, and thats possibly true – but
some people do still find it useful.
The other advantage of the dual nature of Nominal variables, is that it means
the users can ignore the variable type if they dont want to worry about it. When
working with large datasets, the process of going through and setting up all the
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columns, making sure they have the correct variable type, etc. can be long and
tedious. So only using the variable type as a guide can make it easier for the
user. This is also consistent with the way that many statistical software work,
including SPSS.
So whether a Nominal variable should be treated as a factor or a continuous
variable should be determined by context. For example, for an ANCOVA, variables assigned to factors should be treated as factors, and variables assigned to
covariates should be treated as numeric. Avoid inferring how the user wants to
treat the variable based on its type, i.e. avoid an independent variables option,
where if the user assigns a nominal variable, it is treated as a factor, and if the
user assigns a continuous variable, it is treated as a covariate – this is implied
behaviour, and users make mistakes.
In jamovi, by default, Nominal and Ordinal variables in self$data come
through as factors. The numeric values for each column are attached to the column as an attribute. You dont need to interact with this attribute directly, but
there are situations where its good to know its there.
One issue to do with these attributes, is that a number of R functions in the base
package have no respect for attributes. Using the functions na.omit, subset
and likely others on self$data, results in the discarding of these attributes.
For this reason, it is better to convert these columns to the types you want to use
(so the attributes are no longer needed) before using these functions.
To convert a Nominal or Ordinal variable (which come through as factors)
to a numeric, jmvcore provides the toNumeric() function. To convert in
the other direction, from a numeric to a factor, you can use the factor() or
as.factor() functions built into R. If toNumeric() is called on a variable
which is already numeric, it has no effect. Similarly, if as.factor() is called
on a variable which is already a factor, it has no effect. So you can call these
on every column, without needing to check whether they are already the correct
type.
Returning to our ANCOVA example, which requires a single numeric dependent
variable, one or more factors as factors, and one or more covariates as numeric,
we might begin the .run() function as follows:
.run = function() {

,→

# read the option values into shorter variable
names
dep <- self$options$dep
facs <- self$options$factors
covs <- self$options$covs
# get the data
data <- self$data
# convert to appropriate data types
data[[dep]] <- jmvcore::toNumeric(data[[dep]])
for (fac in facs)
data[[fac]] <- as.factor(data[[fac]])
for (cov in covs)
data[[cov]] <- jmvcore::toNumeric(data[[cov]])

,→

# data is now all of the appropriate type we can
begin!
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data <- na.omit(data)
...
}
In this way, one of the first things you will do in the .run() function, is setting
up all the columns from self$data to be the correct types.
Jonathon Love

19.2.3 State
The analyses demonstrated in the tutorial series so far, have been completely
state-less. This means that each time an analysis is run (for example, in response
to a user checking a checkbox), it runs the analysis from beginning to end. In
many cases, this isnt very efficient. A user may run a t-test, and then select a
checkbox requesting descriptives. Without state, an analysis will recalculate the
t-test results every time the analysis is changed, even when the changed option
has no impact on the t-test results.
For many analyses, this isnt a problem – indeed, a t-test runs very quickly, so
recalculating with every option change doesnt really pose a problem; the user
still receives the results near instantaneously. However, some analyses can take
a considerable amount of time to run, and re-running these in their entirety with
every change leads to long delays and a poor user experience. The solution to
this problem is state.
In using state, an analysis retains information from when it was previously run.
If a user makes a change to an existing analysis, the analysis can make use of the
results that were calculated previously. Using the example of a t-test, if the user
checks a checkbox requesting an additional table of descriptives, the analysis can
re-use the t-test results from the last time the analysis ran. However, if the user
changes an option which affects the t-test results – say, the type of t-test – then
the analysis should not re-use the earlier t-test results. Whether earlier results
should be used or not is determined by the clearWith property.
clearWith
Each results element in the .r.yaml-file can have a clearWith property
specified. If no clearWith property is specified, then the default value of * is
used, which means the Table or Image will be cleared if any option changes;
no earlier results will ever be used. So far in this tutorial series, all analyses have
behaved in this way.
Specifying a clearWith property lets us specify the circumstances where results should be re-used, and when not. For example, returning to our t-test, our
.a.yaml-file might contain the following options:
- name: data
type: Data
- name: deps
title: Dependent Variables
type: Variables
- name: group
()
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title: Grouping Variable
type: Variable
- name: alt
title: Alternative hypothesis
type: List
options:
- name: notEqual
title: Not equal
- name: oneGreater
title: One greater
- name: twoGreater
title: Two greater
default: notEqual
- name: varEq
title: Assume equal variances
type: Bool
default: true
We could add the clearWith property to the t-test results table in the .r.yamlfile as follows:
- items:
- name:
title:
type:
rows:

ttest
Independent Samples T-Test
Table
(deps)

clearWith:
- group
- alt
- varEq

# <-- here

columns:
- name: var
title: ''
type: text
content: ($key)
This clearWith specifies that the table is to be cleared if any of the options
group, alt or varEq change. Take note that we havent added the deps option
to this list. When the user adds additional dependent variables, we dont want it
to clear the existing rows. You can see what happens by running this example,
and adding multiple dependent variables one at a time.
Before we added this clearWith property, adding another dependent variable
caused the whole table to be cleared before being filled back in again. Now with
clearWith (without deps listed), adding an additional dependent variable just
adds another row, which is then filled in. The old rows are not cleared. This new
behaviour minimises the amount the results flicker, and allows the user to see
clearly what has changed in the results in response to their actions.
However, it should be noted that we havent actually reduced the amount of calculations being performed. Although the table is no longer cleared when certain
options are changed, our analysis implementation in the .b.R-file still loops over
all the dependent variables and performs a t-test for each. It then overrides the
value already in the table with this newly calculated value; the exact same value.
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This isnt a problem, because the t-test runs very quickly, but we can modify our
.b.R-file to not calculate values which are already present in the table. We find
out what parts of the table are already filled in with the isFilled() method.
isFilled()
The isFilled() method can be called with any of the following:
table$isFilled()
table$isFilled(rowNo=i, col)
table$isFilled(rowKey=key, col)
By specifying or omitting different arguments, it is possible to query whether the
whole table is filled, whether a particular row or column is filled, or whether a
particular cell is filled. isFilled() returns either TRUE or FALSE.
Lets return to our t-test example, to the .b.R-file. We might modify our .run()
function as follows:
.run=function() {
table <- self$results$ttest
for (dep in self$options$deps) {

,→

,→

if ( ! table$isFilled(rowKey=dep)) {
this if statement!

# <-

formula <- jmvcore::constructFormula(dep,
self$options$group)
formula <- as.formula(formula)
results <- t.test(formula, self$data)

,→

table$setRow(rowKey=dep, values=list(
set by rowKey!
t=results$statistic,
df=results$parameter,
p=results$p.value
))
}
}

#

}
Weve added an if-statement which checks if the row is already filled. If it is already filled in then it wont call the t.test() function or spend time populating
the row. In this way we can skip calculations if the appropriate results are already
filled in.
setState()
However, sometimes we dont want to just store the final results; sometimes we
want to store the intermediate objects as well. For example, we may want to
create a fit object, and then reuse this same fit object the next time the analysis is
run.
State can be saved and recovered from any results element, i.e. an Image or a
Table, using the setState() method and state property:
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table$setState(object)
object <- table$state
$state will return NULL if no state has been set.
Note that the clearWith property also applies to the state attached to a results
element. The same mechanism can be used to selectively clear the state or not,
depending on what options have changed.
When using setState() and state, an analysis will typically try and retrieve the state as one of the first things it does. If the state doesnt exist (state
has a value of NULL), then the analysis will perform the calculations to create
the object it requires and setState() that object onto a results element. Following this, the analysis can populate the tables and images from that object.
Alternatively, if the state can be retrieved, then the analysis can bypass the initial
time-consuming construction of the object, and just use the one from last time to
populate the tables and images.
WARNING: Some R objects, when serialised, take up a lot of space. If these
objects are large, then the save and restore process between analyses will be very
sluggish. As such, its worth investigating how large the objects you want to store
will be. The following will give you the serialized size of an object in bytes:
length(serialize(object), connection=NULL)
Jonathon Love

19.3 jamovi module development: User Interfaces
Jonathon Love

19.3.1 Basic UI Design
UIs for jamovi analyses are defined in the .u.yaml-file (a refresher on the files
and the relationship between them is described here ( 59)). This describes what
sort of control each option is represented by (i.e. a dropdown list, or some radio
buttons), and the order and the layout in which they will appear.
aggressive vs tame compiler mode
By default, .u.yaml-files are in aggressive compiler mode. This means
when installing jamovi modules with jmvtools::install() the .u.
yaml-files are regenerated and replaced each time. This is good early on in
the development process, but as development progresses, getting a UI just right
or adding custom behaviour requires hand editing of the .u.yaml-files. To prevent jmvtools from simply replacing all your changes, the .u.yaml-file can be
placed in tame mode. In tame mode the compiler respects your changes, and
will not interfere with your adjustments. The trade-off is that the compiler often
cant insert new controls into the UI as optimally.
To begin with wed encourage you to leave your .u.yaml-files in aggressive
mode.
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Controls
As weve seen earlier in this tutorial series with our t-test example, each option
is represented by one or more controls. Our list option was represented by a list
box, boolean options were represented by checkboxes, and Variable options were
represented as a box that variables could be dragged to.
Lets take a look at UI, and the .u.yaml-file which is responsible for it:

title: Independent Samples T-Test
name: ttestIS
jus: '3.0'
stage: 0
compilerMode: aggressive
children:
- type: VariableSupplier
persistentItems: false
stretchFactor: 1
children:
- type: TargetLayoutBox
label: Dependent Variables
children:
- type: VariablesListBox
name: deps
isTarget: true
- type: TargetLayoutBox
label: Grouping Variable
children:
- type: VariablesListBox
name: group
maxItemCount: 1
isTarget: true
- type: LayoutBox
margin: large
children:
()
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- type: ComboBox
name: alt
- type: LayoutBox
margin: large
children:
- type: CheckBox
name: varEq
As can be seen, controls are arranged in a hierarchy. At the very top is a
control of type VariableSupplier. It has two children: deps of type
VariablesListBox and group of type VariableListBox. Together,
these three controls create the variables list, and the Dependent Variables and
Grouping Variable drop targets.
Next is a LayoutBox which contains the hypothesis ComboBox, followed by
another LayoutBox containing the equality of variances CheckBox. By default, items are laid out in a grid from top to bottom.
TODO: how to layout controls in other configurations, group headings, etc.
Jonathon Love

19.3.2 Advanced UI Design
Controls
There are three different categories of controls:
• Parent Controls ( 108)
• Option Controls ( 116)
• Display Controls ( 121)
Layout controls are used to control the layout child controls in the UI. Option
controls allow the user to change the values of options for analyses. Weve already
seen some of these; the CheckBox, the ComboBox, etc. Display controls are
for presenting static information such as labels.
Option Controls
As already seen earlier in this tutorial series, different option controls are bound
to different analysis options. The name of the option control typically needs to
match the name of the option it is bound to. Changing the option control leads to
changes to the underlying option, resulting in changes to the analysis.
Not all controls can be bound to any option. It wouldnt be meaningful to bind a
checkbox to a List option for example. The following lists the different option
types, and the control types that can be bound to each:

Bool
You can use : CheckBox
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- type: CheckBox
name: #optionName
or you can use : Label
This control is read only.
- type: Label
name: #optionName
format: bool

Integer
You can use : TextBox
Allows for the value to be edited.
- type: TextBox
name: #optionName
format: number
or you can use : Label
This control is read only.
- type: Label
name: #optionName
format: number

Number
You can use : TextBox
Allows for the value to be edited.
- type: TextBox
name: #optionName
format: number
or you can use : Label
This control is read only.
- type: Label
name: #optionName
format: number

String
You can use : TextBox
Allows for the value to be edited.
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- type: TextBox
name: #optionName
or you can use : Label
This control is read only.
- type: Label
name: #optionName

List
You can use : ComboBox
- type: ComboBox
name: #optionName
or you can use : RadioButton
Use multiple RadioButtons linked to the different sub-options.
- type: RadioButton
name: #uniqueName_1
optionName: #optionName
optionPart: #optionPartName_1
- type: RadioButton
name: #uniqueName_2
optionName: #optionName
optionPart: #optionPartName_2
- type: RadioButton
name: #uniqueName_N
optionName: #optionName
optionPart: #optionPartName_N

NMXList
You can use : CheckBox
Use multiple CheckBoxs linked to the different sub-options.
- type: CheckBox
name: #uniqueName_1
optionName: #optionName
optionPart: #optionPartName_1
- type: CheckBox
name: #uniqueName_2
optionName: #optionName
optionPart: #optionPartName_2
- type: CheckBox
()

19.3. jamovi module development: User Interfaces

91

Documentation for jamovi

()

name: #uniqueName_N
optionName: #optionName
optionPart: #optionPartName_N

Variable
You can use : VariablesListBox
- type: VariableListBox
name: #optionName
isTarget: true
maxItemCount: 1
or you can use : ListBox
- type: ListBox
name: #optionName
isTarget: true
maxItemCount: 1
template:
- type: VariableLabel

Variables
You can use : VariablesListBox
- type: VariableListBox
isTarget: true
name: #optionName
or you can use : ListBox
- type: ListBox
name: #optionName
isTarget: true
template:
- type: VariableLabel

Terms
You can use : ListBox
- type: ListBox
name: #optionName
isTarget: true
template:
- type: TermLabel
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Pairs
You can use : VariablesListBox
- type: VariablesListBox
name: #optionName
isTarget: true
columns:
- name: i1
template:
- type: VariableLabel
- name: i2
template:
- type: VariableLabel
or you can use : ListBox
- type: ListBox
name: #optionName
isTarget: true
columns:
- name: i1
template:
- type: VariableLabel
- name: i2
template:
- type: VariableLabel

Array
You can use : ListBox
- type: ListBox
name: #optionName
template:
type: #depends on the option
This is jamovis most complicated control. The setup of its UI definition depends
heavily on the way the option is setup. A more detailed explanation can be found
here ( 120).
Jonathon Love

19.3.3 Advanced Customisation
Customizing UI controls
Sometimes the .u.yaml-file alone doesnt provide enough flexibility for an analysis options UI. More complex UIs can be achieved through writing additional
javascript that provides more complex behaviour. This allows much greater freedom and flexibility, and allows you to design an options UI completely from
scratch if necessary.
The options UI is customised through attaching javascript event handler functions
to the user interface. These then respond to events such as a UI loaded event, or
an option changed event in response to a user interaction.
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Additional UI functions are defined in a javascript-file with a .js-suffix, and
are placed in the jamovi/js folder of the module. The name of the .js-file
should match the names of the other .yaml-files for that analysis. For example:
• ttest.a.yaml
• ttest.r.yaml
• ttest.u.yaml
• js/ttest.js
The events .js-files follow the CommonJS javascript module spec, assigning each of the event handlers and functions to an object which is assigned to
module.exports.
IMPORTANT: For customisations to function, the jus property in the .u.
yaml-file needs to be set to 3.0.
For example:
name: ttest
title: T-Test
jus: '3.0'
compilerMode: tame
children:
- type: ComboBox
name: ttestType
module.exports = {
// event handlers and functions are defined here
// this is an example of an event handler
view_loaded: function(ui, event) {
// do something
},
// this is another example of an event handler
ttestType_changed: function(ui, event) {
let value = this.calculateValue();
// do something
},
// this is an example of an auxiliary function
calculateValue: function() {
// do something
}
};
In the above example, the view_loaded(...) event handler is invoked
with a loaded event when the analysis options UI is created for the first
time. Similarly, a changed event is fired, and the event handler function
ttestType_changed(...) is invoked when the user changes the value of
the ttestType option.
Note that jamovi ships with the Chrome developer tools, so its possible to invoke
these, and have access to the debugger, DOM viewer, etc. The dev tools are
invoked by pressing F10. (Note that sometimes jamovis internal iframes prevent
this key stroke from registering. You sometimes need to click the blue bar along
the top to move the focus back to the main window, before the F10 keystroke
will register.)
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Events
Event handlers are added by naming the function with the following pattern. Option name, followed by an underscore, followed by the event name
{optionName}_{eventName}.
For example: ttestType_changed
jamovi will automatically attach the event handler ttestType_changed(..
.) to the changed event of the ttestType option when the analysis is run.
View

Event Description
cre- Invoked at the very beginning of the options panel creation, before anyatthing is added to the DOM.
ing
loadedInvoked after the options panel has been created and the DOM has
been populated. The same analysis options panel persists as long as
jamovi is still running, and is shared by all analyses of the same type,
so this is only invoked once. This is the most common event to use for
customising the UI.
up- Invoked when the user selects a different analysis (of the same type)
dated and the options need to change to reflect the new analysis option values (This is also called when the user inserts a new analysis, when an
option panel for that analysis type already exists).

All controls

Event
changing
changed

Description
Invoked before the value of the control is changed. Invoked
after the value of the control is changed.

ListBox

Event
listItemAdded listItemRemoved

Description
Invoked when a control is added to a list box. Invoked
when a control is removed from a list box.

Suppliers

Event
updated

Description
Invoked when a variable name or level name is changes.

IMPORTANT NOTE: The use of the updated event is required for all
Supplier and VariableSupplier controls (under certain conditions). If
it is not implemented then jamovi will display the following error:
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Error: The use of a VariableSupplier control, with
,→the property >
populate: manual, requires an updated event handler
,→to be
assigned.
or:
Error: The use of a Supplier control requires an
,→updated event
handler to be assigned.
These suppliers require manual population and therefore need to be appropriately
updated in response to variable or level name changes.
Custom Control

Event
creating
updated

Description
Invoked during the creation phase of the options panel. Allows for
access to the custom control for customisation before it is made visible.
Invoked when a variable name or level name is changes.

Event handlers
All event handlers are invoked with two arguments; the ui, and the event.
The ui is a convenience object containing all the other controls in the options
panel and the DOM. All the option controls are available in the ui argument as
properties. For example:
ttestType_changed(ui, event) {
let ttype = ui.ttestType.value()
if (ttype === 'welchs')
ui.priorWidth.setValue(0.707)
}
In this example, when the user changes the ttestType option to welchs, the
priorWidth option is changed to 0.707. All options have the .value()
and .setValue() methods.
Note that each change to the values of the options triggers the re-running of the
analysis. If multiple option values need to change in response to an event, it
is better to batch these changes together, to prevent the analysis being restarted
again and again. Option changes can be batched together with the ui.view.
model.options beginEdit() and endEdit() functions as follows:
ui.view.model.options.beginEdit();
ui.figWidth.setValue(400);
ui.figHeight.setValue(300);
ui.view.model.options.endEdit();
In this example, changing the figWidth and figHeight options only triggers
the re-running of the analysis once.
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Accessing the DOM
The DOM for the root of options UI can be accessed from the ui through the
view property:
ui.view.el | the root DOM node
ui.view.$el | the root DOM node as a jQuery object
It is also possible to inspect the DOM using the chrome dev tools shipped with
jamovi (to access these, click the blue bar at the top of jamovi, and press F10).
Additionally, the DOM elements for most of the option controls are accessible
through the el and $el property. i.e.
let figWidth = ui.figWidth.el
let $figWidth = ui.figWidth.$el

Adding a custom control
Sometimes the controls built into jamovi do not provide the behaviour your analysis requires. In this scenario, its possible to create a custom control which is
placed within the DOM.
A control of type CustomControl allows for this possibility, when added to
the .u.yaml-file, and the creating event is handled in the javascript.
For example, the description of the control in the .u.yaml
- type: CustomControl
name: ttestType
and the event handler for the the .js
ttestType_creating: function(ui, event) {
let $element = ui.ttestType.$el;
// in this instance, the $element object
,→represents the root DOM node
// of the custom control. sub-nodes can be added
,→to this node, and the
// control will be laid out by the layout
,→manager in the final options
// UI
}

Options UI from scratch
Sometimes an analysis requires a very radical UI design that cant be accommodated by the standard UI controls or a custom control. If this is the case, an
entirely custom UI may need to be developed.
To achieve this, the options and their types are defined as usual in the .a.
yaml-file, however, each option is marked as hidden: true. This prevents
jmvtools from (re)adding the standard UI controls into the .u.yaml-file, allowing you to implement them yourself.
To construct the UI, all the DOM setup for the custom panel should occur in a
creating event handler for the view control.
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'use strict';
module.exports = {
view_creating: function(ui, event) {
let $panel = ui.view.$el;
// in this instance, the $panel object
,→represents the root DOM node
// of the options panel. sub-nodes can be
,→added to this node.
}
}
In addition, there is a comprehensive overview over the API for module development:
Jonathon Love

19.4 jamovi module development: API
Jonathon Love

19.4.1 Module Definition (0000.yaml-files)
Coming soon!
Jonathon Love

19.4.2 Analysis definition (.a.yaml-files)
Overview
The analysis definition is a YAML-file in the jamovi/ directory, with the extension .a.
yaml. the analysis definition describes the analysis, the way it appears in menus, and the
options it requires. The file is named to match the name of the analysis it describes, but
converted to lowercase. an example is ttestis.a.yaml.
- name: TTestIS
title: Independent Samples T-Test
menuGroup: T-Tests
version: '1.0.0'
jas: '1.0'
options:
- name: ...
type: ...
- name: ...
type: ...
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Property
name

Function
The name of the analysis. camel case. Underscores are discouraged, dots
are not permitted.
title
The title of the analysis in title case.
version The version of the analysis. Should make use of semantic versioning
(http://semver.org).
jas
The jamovi analysis spec. Should be 1.0. must be wrapped in
quotes to prevent it being interpreted as a number.
menuGroup The name of the top level menu where the analysis should appear.
menuSubgroup
Places the menu entry under a subheading (optional).
menuTitle The title to be used in the menu. If unspecified, then the title is used
(optional).
menuSubtitle
Additional text placed to the lower right of the menu entry (optional).
options An array of options that the analysis requires. these are described in
greater detail below.

Options
Options represent the options that an analysis requires in order to run. When a jamovi
module is used as an R package, they represent the arguments to the function. when used
in jamovi itself, they represent the user interface (UI) options presented to the user.
Each option has a name, a type, and some additional properties which are described in
greater detail below.
When a value is specified by the user (either through the jamovi user interface, or through
a function argument), the option checks the value and produces an error if the value is not
suitable. The checks performed by each option are also detailed below.
The different option types are as follows:
Data
Data is used for analyses which require data (almost all of them). If used, it should be the
first of the options, and should always be called data. It has no additional properties.
Example
- name: data
type: Data

Bool
Bool is used for true / false values, and is typically represented in the UI as a checkbox.
Property
title
default

default
false

Description
Name of the user interface option element
Default value for the user interface option element

Checks
The value must be true or false.
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Example
- name: bf
type: Bool
title: Bayes factor
default: false

Integer
Integer is used for values which need to be whole numbers. For floating point numbers,
use Number instead.
Property
title
default
min
max

default
0
-Inf
Inf

Description
Name of the user interface option element
Default value of the user interface option element
Permitted minimum value of the user interface option element
Permitted maximum value of the user interface option element

Checks
• the value must be a whole number
• the value must fall between the min and the max
Number
Number is used for values which need to be numeric. For whole numbers, use Integer
instead.
Property
title
default
min
max

default
0.0
-Inf
Inf

Description
Name of the user interface option element
Default value of the user interface option element
Permitted minimum value of the user interface option element
Permitted maximum value of the user interface option element

Checks
• the value must be a number
• the value must fall between the min and the max
Example
- name: ciWidth
type: Number
title: Confidence level
min: 50
max: 99.9
default: 95
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List
List is used where only one of several values may be specified, and only one at a time.
In the UI, these are typically represented as either a listbox, or a set of radio buttons.
Propdefault
erty
title
options
default <first
option>

Description
Name of the user interface option element
List of choices for the list box (must be specified as an array
of strings)
Which of the elements of options does serve as default

Checks
• the value must be one of the options
Variable
Variable is used where a variable/column from the data set needs to be specified. In
the UI, these are typically represented as a drop box, where variables can be dragged
and dropped. The value of Variable is a string (in R, a character vector of length 1)
containing the assigned variable name. If nothing is assigned it has a value of null.
Propde- Description
erty
fault
title
Name of the user interface option element
suggested
[]
Suggested variable type (shown as variable type icon at the bottom
of the variable drop box); must be a list of the following types:
continuous, ordinal, nominal, nominaltext
permitted
[]
Suggested variable type (variables of non-permitted types cant be assigned)
rejectInf
true Reject the assignment of variables containing non-finite values
rejectMissing
falseReject the assignment of variables containing missing values

Checks
• whether the value is a string
• whether the variable exists in the data set
• whether the variable type is permitted
• whether the variable contains non-finite values (if rejectInf is true)
• whether the variable contains missing values (if rejectMissing is true)
Variables
Variables is used where multiple variables / columns from the data set need to be
specified. In the UI, these are typically represented as a drop box, where variables can be
dragged and dropped. The value is an array of strings (in R, a character vector). If nothing
is assigned to Variables its value is an empty array (in R, a character vector of length
0).
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Propde- Description
erty
fault
title
Name of the user interface option element
suggested
[]
Suggested variable type (shown as variable type icon at the bottom
of the variable drop box), must be a list of the following types:
continuous, ordinal, nominal, nominaltext
permitted
[]
Suggested variable type (variables of non-permitted types cant be assigned)
rejectInf
true Reject the assignment of variables containing non-finite values
rejectMissing
falseReject the assignment of variables containing missing values

Checks
• whether the variable exists in the data set
• whether the variable type is permitted
• whether the variable contains non-finite values (if rejectInf is true)
• whether the variable contains missing values (if rejectMissing is true)
Jonathon Love

19.4.3 Results Definition (.r.yaml-files)
(work in progress)
Overview
The results definition is a YAML-file in the jamovi/ directory, with the extension .
r.yaml. the results definition describes the results produced by the analysis. The file
is named to match the name of the analysis, but converted to lowercase. An example is
ttestis.r.yaml:
- name: TTestIS
title: Independent Samples T-Test
jrs: '1.0'
items:
- name: ...
type: ...
- name: ...
type: ...
Property
name
title
jrs

Function

The name of the analysis. Must correspond to the file name.
The title to display at the top of the results.
The jamovi results spec should be 1.0. Must be wrapped in quotes
to prevent it being interpretted as a number.
items An array of results-elements that make up the results. these are described
in greater detail below.

Results
Each results-element has the following properties:
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Property

default

name
type
title
visible

true

clearWith *

Description
Name of the results-element, a string.
Type of the results-element, a string, see the list of results
element types below.
Title preceding the output from results-element in the output,
a string.
Whether the results-element is visible at initiation (true /
false).
Event to clear the results element (a string).

Different results-element-types have different additional properties.
The different results element types are as follows:
Preformatted
Preformatted represents the simplest of results-elements. It is simply a block of preformattd text.
It has no additional properties.
Table
Table is the most common result element in the results from jamovi analyses. Tables
are represented as rich HTML tables in jamovi, and as nicely formatted ASCII tables in an
interactive R session.
It can have the following properties:
Property

default

Description

An array of columns objects, see below.
An integer specifying the number of rows, or a data-binding
where one row is created per element of the bound value.
swapRowsColumns
falseWhether the rows and columns should be swapped.
notes
[
An array of strings which appear as additional notes in the foot]
notes of the table.
columns
rows

0

Column
Columns within a table can have the following properties:
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Property

default

Description

The name of the column, a string.
The title that appears at the top of the column.
numberEither number (aligned right), integer (aligned right, displayed to zero decimal places) or text (aligned left).
format
A string with comma separated values; zto, pvalue (optional).
content
The content to appear in the cells of the column (optional).
visible true true, false or a data-binding. The column will be visible if
the bound value isnt false or null.
superTitle
A title to appear above the title of the column (optional).
combineBelow
false If TRUE and multiple adjacent cells in the column contain the
same value, they will be combined into a single cell.
name
title
type

Image
Images can have the following properties:
Property

default

Description
Width of the image-element in the output (in pixels).
Height of the image-element in the output (in pixels).
R-function to call in order to render the image in the output.

width
height
renderFun
requiresData

Group
Groups can have the following properties:
Property
items

default

Description
results-elements belonging the the group, a list of strings.

Array
Arrays can have the following properties:
Property
items
template

default

Description
results-elements belonging the the array, a list of strings.

Jonathon Love

19.4.4 User-interface definition (.u.yaml-files)
Overview
The UI definition is a YAML-file in the jamovi/ directory, with the extension .u.yaml.
The UI definition is pretty straightforward. It follows a tree structure that defines the
child/parent-relationship between the controls. The top level or root control is the first
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thing that is described by the UI YAML. The file is named to match the name of the
analysis it describes, but converted to lowercase. An example is ttestis.u.yaml.
Properties

Property
name
title

jus
stage

Description
The name of the analysis.
Sets the title to be displayed at the top of the option panel.
Defines the syntax version
used by the u.yaml-file.
Sets the stage display filter.

Form
Unique string
string

string of form
ber.number

num-

0 - Released
1 - In development
2 - Proposed
compilerMode
children

Sets the compiler interaction mode.
Sets the child control definitions.

enum: tame, aggressive
Array of valid control definitions.

Example
name: descriptives
title: Descriptives
jus:
'2.0'
stage: 0
compilerMode: tame
children:
# array of child definitions

Further Detail
The root control is a ParentControl and as the name suggests serves as a parent to
child controls. All parent controls contain the property children which defines an array
of control definitions to be embedded. All UI design happens within the children node
of the root control. Control definitions are added here in the form we design.
When controls are added to the root control they are added in a list form, from top to
bottom of the options panel.
Controls
There are many different controls that can be used within the jamovi options UI panel.
Each control has been designed for a specific option type(s). For example, a CheckBox
is designed around a Bool option type, where as a ComboBox displays and writes data
to a List option. jamovi provides a solid array of basic controls to cover all the current
option types. Controls will continue to be developed as jamovi grows but the current list
covers most use cases.
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When adding child controls to any ParentControl, at the very least the type property
needs to be specified (as well as the minimum requirements for that control).
name: descriptives
title: Descriptives
jus:
'2.0'
stage: 0
compilerMode: tame
children:
- type: LayoutBox
margin: large
children:
- type: Label
label: jamovi is great?
- type: Label
label: Of cause it is!
Now we can add, move or adjust any control to meet our needs. Here is a list of controls
that can make that possible:
Jonathon Love
BaseControl (abstract)
This control type is abstract and can not be used directly.
Every jamovi user control inherits from BaseControl.
Properties
All jamovi controls have the following properties.
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Prop- Description
erty
type Set the type of control, for a list of types click here ( 89)

name The name of the control. This allows for access to the control
when customizing behavior, for example enabling / disabling. It
needs to be unique to all other controls.
stageThis is the stage of development. The control will only be visible
in the appropriate jamovi instance.

margin
The level of spacing around the control when displayed.

cell The zero-based row and column index where the control is to be
placed within the parent LayoutBox.

stretchFactor
A stretch factor greater than zero will cause the control to fill
the available horizontal space by an amount proportional to the
sum of all other sibling stretchFactors defined in the same
row. It is important to note that when specifying a non-zero
stretchFactor on a control, it is required that the parent of
the control also have a non-zero stretchFactor. Failing to
do so will result in unhelpful layout.
horizontalAlignment
Specifies the horizontal alignment of the control when placed in
the parent LayoutBox cell.

verticalAlignment
Specifies the vertical alignment of the control when placed in the
parent LayoutBox cell.

minWidth
Specifies the minimum width of the LayoutBox cell into which
the control will be placed.
minHeight
Specifies the minimum height of the LayoutBox cell into which
the control will be placed.
maxWidth
Specifies the maximum width of the LayoutBox cell into which
the control will be placed.
maxHeight
Specifies the maximum height of the LayoutBox cell into which
the control will be placed.
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Form
enum
of valid
Controls
( 108)
Unique
string
0:
released
(always
visible);
1: under
development; 2:
proposed
enum:
small,
normal,
large,
none
object
consisting
of row:
row index and
column:
column
index
number
>= 0

enum:
left,
center,
right
enum:
top,
center,
bottom
number
>= 0
number
>= 0
number
>= 0
number
>= 0
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Controls
Below is a list of controls that inherit from BaseControl.
Jonathon Love
ParentControl (abstract)
Inherits from BaseControl
This control type is abstract and can not be used directly.
Properties
A control that inherits from a ParentControl supports the embedding of child controls
through the children property.
PropDescription
erty
childrenAn array of control definitions that are to be embedded into the parent control.

Form
Array of valid Controls ( 108)

If the control is also a DisplayControl (i.e., CheckBox or RadioButton) another
property is available.
Property
style

Description

Form

Sets the layout position of child controls relative the parent.

enum: list, inline, list-inline,
inline-list

Further Details
style
• list: Children are placed below the parent in a vertical list.
• inline: Children are placed to the right of the parent in a horizontal list.
• list-inline: Children are placed below the parent in a horizontal list.
• inline-list: Children are placed to the right of the parent in a vertical list.
Controls
Below is a list of controls that inherit from ParentControl.
Jonathon Love
LayoutBox
Inherits from: BaseControl, ParentControl
A LayoutBox allows a designer to control the layout of its child controls. A
LayoutBox does not display anything itself but purely serves as a frame for placing
other controls. It can be used as a list (default), inline list, or grid.
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Properties
In addition to any inherited properties, a LayoutBox supports:
Property
style

Description

Form

Determines how the automatic layout behavior of the
control.

enum: list, inline

Further Details
style
• list: Children will be added in a vertical manner starting at cell position
column: 0, row: 0.
• inline: Children will be added in a horizontal manner starting at cell position
column: 0, row: 0.
To add to a LayoutBox in a grid format, use the cell property of the child control. As
the LayoutBox is positioning its children it will use the cell property of the control
to place it correctly. The cell property of a child control overrides the auto positioning
of the style property. If a child control does not have a cell property defined it will use
the style property to automatically place it based on the position of the previous child.
Jonathon Love
CollapseBox
Inherits from LayoutBox
The CollapseBox is a LayoutBox that can be collapsed down to a label so that advanced options can be hidden until needed.
Properties
In addition to any inherited properties, a CollapseBox supports:
Property
Description
collapsed Sets the initial collapsed state of the control.
label
Sets the text that will be displayed in the label bar of the
control.

Form
boolean
string

Jonathon Love
Supplier
Inherits from: BaseControl
Cooming soon!
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Properties
Supported Option Types
Example
Controls
Jonathon Love
VariableSupplier
Inherits from: BaseControl
Cooming soon!
Properties
Supported Option Types
Example
Controls
Jonathon Love
VariablesListBox
Inherits from: BaseControl
Cooming soon!
Properties
Supported Option Types
Example
Controls
Jonathon Love
TargetLayoutBox
Inherits from: BaseControl
Cooming soon!
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Properties
Supported Option Types
Example
Controls
Jonathon Love
RMAnovaFactorsBox
Inherits from: BaseControl
Cooming soon!
Properties
Supported Option Types
Example
Controls
• Parent Controls
Jonathon Love
CheckBox
Inherits from ParentControl, OptionControl
Properties
There are no CheckBox specific properties. All behavior can be achieved using the
inherited properties of OptionControl and ParentControl.
Supported Option Types
– Bool
– NMXList
Bool
When CheckBox is bound to a Bool option type the behavior is very simple. When
the option is TRUE, the CheckBox is checked.
Below is an example of a simple Bool option and a CheckBox that has been associated with it.
Option Definition
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- name: descStats
title: Descriptive statistics
type: Bool
default: false
description:
R: >
`TRUE` or `FALSE` (default), provide
,→descriptive statistics
UI Control Definition
- type: CheckBox
name: descStats
Note that the optionName property of the CheckBox is not specified and therefore
the option binding will use the name property of the control for the binding process
instead (see OptionControl for more details).
There is also no need to specify the label property of this OptionControl as
the title property of the option is adequate and will be automatically used by the
CheckBox. This means that a CheckBox can be defined in two lines! If the title
property of the option is not appropriate for the control then a label property can be
added to the CheckBox to override it.

NMXList
When CheckBox is bound to an NMXList a few more properties are needed for it
to work.
The below example shows an option with the name effectSize. This option has a
property called options which describes three non-mutually exclusive sub-options
that are possible within the options output. An NMXList returns an array of one or
all of these sub-options.
Now a CheckBox can be used to manipulate an NMXList option by adding or removing a specified sub-option from the underlying array.
Option Definition
- name: effectSize
type: NMXList
title: Effect Size
options:
- name: eta
title: η 2
- name: partEta
title: partial η 2
- name: omega
title: ω 2
To achieve this two properties will need to be added to the CheckBox definition: optionName and optionPart. Both these properties are inherited from
OptionControl. As has been described in OptionControl documentation,
optionName is used to determine what option the CheckBox should bind to. Under normal circumstances, it is not necessary to use optionName as the property
name can be used for the same effect. This however, becomes a problem for defining
a CheckBox that is linked to an NMXList as the name property also has a requirement to be unique across all controls. It is not allowed to have two checkboxes (or
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any other control for that matter) with the same name. Because of this, when binding
to an MNXList we are required to give the CheckBox a unique name and use the
optionName to bind to the desired NMXList.
Now binding solely to an NMXList is not a valid configuration for a CheckBox as
it requires a boolean data type to operate correctly. To overcome this, the CheckBox
definition will need to not just bind to the NMXList but also to one of the suboptions. This is achieved using the optionPart property. By assigning the name
of the desired sub-option to this property, the CheckBox will operate base on that
sub-options existence in the underlying array.
UI Control Definition
- type: CheckBox
name: effectSize_eta
optionName: effectSize
optionPart: eta
- type: CheckBox
name: effectSize_partEta
optionName: effectSize
optionPart: partEta
- type: CheckBox
name: effectSize_omega
optionName: effectSize
optionPart: omega
Three CheckBoxs for the three sub-options of the option NMXList.
Jonathon Love
RadioButton
Inherits from ParentControl, OptionControl
Properties
There are no RadioButton specific properties. All behavior can be achieved using
the inherited properties of OptionControl and ParentControl.
Supported Option Types
List
When the option binding is to a List a few properties are needed for it to work.
The below example shows an option with the name plotError. This option has a
property called options which describes three mutually exclusive sub-options that
are possible values for the options output. A List returns the name of one of these
sub-options as a string.
Now a RadioButton can be used to manipulate a List option by changing its
value to a specified sub-option name.
Option Definition
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- name: plotError
title: Error Bar Definition
type: List
options:
- name: none
title: None
- name: ci
title: Confidence interval
- name: se
title: Standard Error
default: ci
description:
R: >
'none', 'ci' (default), or 'se'. Use no error
,→bars, use confidence
intervals, or use standard errors on the plots,
,→respectively.
To achieve this two properties will need to be added to the RadioButton definition optionName and optionPart. Both these properties are inherited from
OptionControl. As has been described in OptionControl documentation,
optionName is used to determine what option the RadioButton should bind to.
Under normal circumstances, it is not necessary to use optionName as the property
name can be used for the same effect. This however, becomes a problem for defining
a RadioButton that is linked to an List as the name property also has the requirement to be unique to that UI control. It is not allowed to have two radio buttons
(or any other control for that matter) with the same name. Because of this, when binding to an List with a RadioButton we are required to give that RadioButton
a unique name and use the optionName to bind to the desired List.
Now binding solely to a List is not a valid configuration for a RadioButton
as it requires a boolean data type to operate correctly. To overcome this, the
RadioButton definition will need to not just bind to the List but also to one
of the sub-options. This is achieved using the optionPart property. By assigning
the name of the desired sub-option to this property, the RadioButton will operate
base on that sub-options name.
UI Control Definition
- type: RadioButton
name: plotError_none
optionName: plotError
optionPart: none
- type: RadioButton
name: plotError_ci
optionName: plotError
optionPart: ci
children:
- type: TextBox
name: ciWidth
label: Interval
suffix: '%'
format: number
inputPattern: '[0-9]+'
enable: (plotError_ci)
- type: RadioButton
name: plotError_se
optionName: plotError
()
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()

optionPart: se
Three RadioButtons for the three sub-options of the option bound List.
Jonathon Love
Label
A Label is a simple control that displays text. It can take two inheritance forms
depending on how it is setup. The first is a static label and the second is an option
label.
Option Label
Inherits from OptionControl, ParentControl
A Label is by default an option label unless the label property is defined. An
option Label will populate its display using the underlying option to which it has
been assigned. For further information about option binding see OptionControl.
Properties
When bound to an option, there are no Label specific properties. All behavior can be achieved using the inherited properties of OptionControl and
ParentControl.
Static Label
Inherits from BaseControl, ParentControl
A static Label is created when the label property of the control is defined. In this
form the Label control acts like any old label.
Properties
In addition to any inherited properties, a Label supports:
Property
label

Description
Sets the text to be displayed by the control.

Form
string

Example
- type: Label
label: Percentile Values
children:
- type: CheckBox
name: quart
Jonathon Love
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OptionControl (abstract)
Inherits from BaseControl
This control type is abstract and can not be used directly.
This is the abstract base of all controls that can be bound to an option. These types of
controls allow a user to see and / or set the value of an option that has been defined in the
*.a.yaml.
Properties
In addition to any inherited properties, an OptionControl supports:
Prop- Description
erty
name Sets the unique name for the control. If optionName is not defined
name will be used to data-bind to an option.

optionName
Sets the name of the option to which the control is to be data bound.
If this property is omitted and name property is used instead.
optionPart
Sets the name of the sub-option to which the control is to be data
bound. Some controls dont bind to a whole option but only to part.
For example, a RadioButton binds to a sub-option of the underlying List option (see RadioButton for an example).
labelSets the text to be displayed by the controls label. NOTE: not all
controls have labels. In the circumstance that a control does not have
a label, a defined label property is ignored.
enable
Sets a data-binding string to control the enable state of the control.

Form
Unique
string
(or
option
name)
defined
option
name
defined
option
part
name
string

string

Further Details
enable
This property is whats called a data-binding. Data-binding is where the value of a particular property is bound to the value of another UI control. When the value of the control
changes, so does the respective property value. For example we may want to bind to the
value of a CheckBox (TRUE/FALSE) to the enabling / disabling feature of a TextBox.
This would be achieved by specifying the name of the control to which you would like to
bind inside of parentheses (or brackets).
- type: CheckBox
name: pcEqGr
label: Cut points for
style: inline
verticalAlignment: center
children:
- type: TextBox
name: pcNEqGr
label: ""
suffix: equal groups
format: number
()
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()

inputPattern: "[0-9]+"
enable: (pcEqGr)
In the above example, the TextBox named pcNEqGr would enable when the
CheckBox named pcEqGr is checked.
label
The label property of an OptionControl serves only to override the title property
of the underlying option. If the label property is not defined, the control will use the
title property of the underlying option. This results in the UI control definition being
minimal, only describing information when necessary.
Option Definition
- name: descStats
title: Descriptive statistics
type: Bool
default: false
description:
R: >
`TRUE` or `FALSE` (default), provide descriptive
,→statistics
UI Control Definition
- type: CheckBox
name: descStats

Events

Event
change
changing

Description
Fires when the value of the control has changed.
Fires when the value of the control is about to change.

Controls
Below is a list of controls that inherit from OptionControl.
Jonathon Love
TextBox
Inherits from OptionControl
A TextBox allows for the displaying and editing of the value of an option in
text form.
Properties
In addition to any inherited properties, a TextBox supports:
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PropDescription
erty
format Sets the format definition that the TextBox should
use to perform string manipulations with. If no format
is specified string is assumed.
suffix Sets the text to be placed to the right of the textbox.
inputPattern
Sets the input string filter for determining valid inputs. For example, a number TextBox would have
inputPattern: '[0-9]+'
alignText
Set the horizontal alignment of the text within the
TextBox.
borderless
Toggles whether the control has a visible border or
not. This is mainly used when a TextBox is added
to the template of a ListBox.

Form
Name
of
a:
StandardFormat,
CustomFormat
string
regular expression,
string
enum: left, center,
right
bool

Jonathon Love
StandardFormat
The following are the standard jamovi formats for use with the format property of UI
controls:
Format
variable
term
number
bool
string

Description
TBA
TBA
TBA
TBA
TBA

Jonathon Love
CustomFormat
Cooming soon!
The following are the custom jamovi formats for use with the format property of UI controls:
Format
TBA

Description
TBA

Supported Option Types
• String
• Integer
• Number
• Any format that has both toString() and parsing capabilities.
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Example
- type: CheckBox
name: logOdds
children:
- type: TextBox
name: ciWidth
suffix: '%'
format: number
inputPattern: '[0-9]+'
enable: (logOdds)
The above example adds a TextBox as a child control to a CheckBox.
Jonathon Love
ComboBox
Inherits from OptionControl
A ComboBox displays the selected value from a preset list of options.
Properties
In addition to any inherited properties, a ComboBox supports:
Prop- Description
erty
options
Sets the options to be displayed in the drop-down
list. This property is to be used as an override of
the options property of the underlying option.

Form
array of objects consisting of name: reference
name, title: display
text

Supported Option Types
List
When the option binding is to a List a few properties are needed for it to work.
The below example shows an option with the name ss. This option has a property called
options which describes three mutually exclusive sub-options that are possible values
for the options output. A List returns the name of one of these sub-options as a string.
Now a ComboBox can be used to manipulate a List option by changing its value to the
option selected in the drop-down.
Option Definition
- name: ss
title: Sum of squares
type: List
options:
- title: Type 1
name: '1'
- title: Type 2
()
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name: '2'
- title: Type 3
name: '3'
default: '3'
description:
R: >
`'1'`, `'2'` or `'3'` (default), the sum of squares
to use
A ComboBox can completely encapsulate a List option which makes its definition very
simple. The control will use the options title as a label and options as the contents
for the drop-down. label and options can be defined in the control definition if it is
required to override the values of the option.
UI Control Definition
- type: ComboBox
name: ss
Jonathon Love
ListBox
Inherits from: BaseControl
Cooming soon!
Properties
Supported Option Types
Example
Controls
Jonathon Love
VariableLabel
Inherits from: BaseControl
Cooming soon!
Properties
Supported Option Types
Example
Controls
Jonathon Love
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TermLabel
Inherits from: BaseControl
Cooming soon!
Properties
Supported Option Types
Example
Controls
Jonathon Love
DisplayControl (abstract)
Inherits from: BaseControl
Properties
(work in progress)
Controls
Below is a list of controls that inherit from DisplayControl.
Jonathon Love
Output
Inherits from: BaseControl
Cooming soon!
Properties
Supported Option Types
Example
Controls
Jonathon Love

19.4.5 Elements to assign results to (in R)
Overview
This document describes the properties and methods of the results elements:
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• Table (most commonly used, therefore described in detail ( 122))
• Image
• Group
• Array
• Preformatted
• Html
The values of properties can be accessed using the $ operator. For example, to retrieve the
title of an element, one can go:
element$title
The methods of a results elements are called using the $ operator as well. For example:
element$setTitle('An awesome title')

Elements
The following properties and methods are common to all results elements:
Property
name
title
visible
status
rowKeys
state

Description
A string specifying the name of the element.
A string specifying the title of the element.
Whether the element is visible or not (true or false, default: true)
A string, one of complete, error, inited, running.
A list of keys.
The state of the element

Method
Description
setStatus(status) Sets the elements status; should be one of complete,
error, inited, running.
setVisible(visible=TRUE)
Overrides the elements default visibility.
setTitle(title)
Sets the elements title.
setError(message) Sets the elements status to error, and assigns the error
message.
setState(object) Sets the state object on the element.
Jonathon Love

19.4.6 Assign results to tables (in R)
This document describes the properties and methods of a jamovi table-object.
The values of properties can be accessed using the $ operator, followed by the name. For
example, to retrieve the title of a table, one can go:
table$title
The methods of a table object are called using the $ operator as well. For example:
table$setRow(rowKey=1, values=list(t=2.3, df=2, p=0.45))
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Property
name
title
visible
status

Description

A string specifying the name of the table.
A string specifying the title of the table.
Whether the table is visible or not (true or false, default: true).
The status of the table. A string, one of complete, error, inited,
running.
rowKeys A list of keys.
state
The state of the table.
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MethodDescription
setStatus(status)
Sets the tables status, should be one of complete, error, inited,
running.
setVisible(visible=TRUE)
Overrides the tables default visibility.
setTitle(title)
Sets the tables title.
setError(message)
Sets the tables status to error, and assigns the error message.
setState(object)
Sets the state object on the table.
addColumn(name,
Adds a new column to the table.
)
addRow(rowKey,
Adds a row to the table. rowKey is an object which uniquely identifies the
row – for many cases, simply providing the index is sufficient. values is a
values)
named list with the values to place in the cells of that row. The names must
correspond to the column names. Not all column values must be provided,
and if a blank row is desired, the values argument can be omitted entirely. A
more detailed description of possible values is given in the table below.
deleteRows()
Deletes all the rows in the table.
setRow(rowKey,
Sets the values in an existing row. rowKey is a key uniquely identifying
the row, rowNo is a number specifying the row number. Either of these two
values)
options has to be used. values is a named list of values. The names must
setRow(rowNo,
correspond to the column names. Not all column values need to be provided.
values)
setCell(rowKey,
Sets the value of a cell. Generally setRow() is more efficient.
col,
value)
setCell(rowNo,
col,
value)
getCell(rowKey,
Retrieves a cell.
col)
getCell(rowNo,
col)
addFormat(rowKey,
Adds additional formatting to a cell. col can be an index or a name. Format can be one of: Cell.BEGIN_GROUP, Cell.END_GROUP, Cell.
col, BEGIN_END_GROUP or Cell.NEGATIVE‘. Cell.BEGIN_GROUP adds additional padding above the cell, Cell.END_GROUP below. Cell.NEGATIVE
format)
colours the value red.
addFormat(rowNo,
col,
format)
addFootnote(rowKey,
Adds a footnote to the cell.
col,
note)
addFootnote(rowNo,
col,
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note)
addSymbol(rowKey,
Adds a symbol to a cell – for example an asterisk denoting significance.
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The following arguments are possible for addColumn:
Argument
name
index

Type

Description

string
integer

title

string

The name of the column
The index to insert the column at. If unspecified, the column
is appended.
The title to appear at the top of the column. If unspecified,
the name is used.
The title to appear above column titles.
Whether the column should be visible. If a string is specified,
this must be a data-binding to an option.

superTitle
string
visible TRUE
FALSE
string
content string
type

/
/

string

format string
combineBelow
TRUE
FALSE

/

Either a string that will be placed in every cell, or a databinding.
integer, number or text; text is left aligned,
number is right aligned, integer is formatted to zero decimal places.
A comma separated list of values, such as zto, pvalue.
If TRUE, when cells in the column are contiguous and contain the same value, the lower cells will be made blank.

: Note that you must explicitly name either the rowNo or the rowKey argument
when calling this method:
setRow(rowNo = ...)
setRow(rowKey = ...)
setCell(rowKey = ..., col, value)
setCell(rowNo = ..., col, value)
addFormat(rowKey = ..., col, format)
addFormat(rowNo = ..., col, format)
to differentiate between the rowKey=... and the rowNo=... argument.
If you have questions about developing modules for jamovi, or feedback on how we can improve
the developer hub, were keen to hear from you. There are forums available at forum.jamovi.org
(https://forum.jamovi.org), a communication platform at jamovi.slack.com or you can reach out via
e-mail to contact <at> jamovi.org.
For those interested in the jamovi platform, it is hosted on GitHub (https://github.com/jamovi/jamovi).
Dont forget to star us!
Underneath, you will find further information about the structure of the project, the jamovi-file-format
and possible projects for the Google Summer of Code:
Jonathon Love

19.5 Further information
Jonathon Love
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19.5.1 Structure of the the jamovi sources
The jamovi source structure contains the following components:
directory
electron/
server/

contents

the electron app which represents the
entry point of the program
the server code written in python and
built on top of tornado
enthe background processing engine
gine/ (written in C++, making use of R)
client/ the html, javascript and css (make up
the user interface for jamovi)
exthe example data sets
amples/
platplatform specific files (icons, etc.)
form/

build command

artifacts

npm install

default, app.asar

python3 setup.py
build_ext --inplace
make

jamovi-server
(python module)
jamovi-engine
(an executable)
js, css, html

npm install
(these can be copied verbatim)

The electron/, server/, engine/ and client/ subprojects can be built by navigating into
their directories and issuing the build command listed in the table above.
Final structure
After building each of these subprojects, the results of the builds are assembled into a final tree for
installation. the final jamovi folder structure for Ubuntu is as follows:
/usr/lib/jamovi/
bin/
|
locales/
|
|
...
|
resources/
|
|
electron.asar
|
|
default_app.asar
|
jamovi
|
env.conf
|
...
Resources
jamovi
client/
|
|
assets/
|
|
|
...
|
|
...
|
examples/
|
|
...
|
server/
|
jamovi/server/
modules
base
|
R/
|
...
jmv/
...
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bin/
The electron executable is the entry point for jamovi. it represents a combined web browser interface
and nodejs interpreter. In constructing the bin/ folder, its contents are simply taken from electron
release archives (available from https://electron.atom.io), with three exceptions:
• the jamovi executable
• resources/default_app.asar
• env.conf
The jamovi executable is simply the electron executable renamed.
The resources/default_app.asar is the default electron app which electron goes looking
for when it starts up. This needs to be replaced with the default_app.asar produced by the
electron component of jamovi (from the electron/ folder in the repo).
env.conf contains the path settings and environmental variables that jamovi requires. variables
which end in PATH or HOME are resolved relative to the env.conf. On Ubuntu, its contents are:
[ENV]
R_HOME=/usr/lib/R
R_LIBS=/usr/lib/R/site-library:/usr/lib/R/library
PYTHONPATH=../Resources/jamovi/server
JAMOVI_HOME=..
JAMOVI_MODULES_PATH=../Resources/modules
JAMOVI_EXAMPLES_PATH=../Resources/jamovi/examples
JAMOVI_CLIENT_PATH=../Resources/jamovi/client
JAMOVI_SERVER_CMD=/usr/bin/python3 -u -m jamovi.server 0

Resources/jamovi/client
This folder contains the following files from the client/ subproject:
index.html
main.js
main.css
analysisui.html
analysisui.js
analysisui.css
resultsview.html
resultsview.js
resultsview.css
assets/*

Resources/jamovi/server
This folder should contain the following files and folders from the server subproject:
jamovi/server/
jamovi/core.*.so
jamovi/__init__.py
jamovi/__pycache__
Note that the PYTHONPATH in env.conf is Resources/jamovi/server, so the final path of
the jamovi/server/ directory will look a bit silly:
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Resources/jamovi/server/jamovi/server

Resources/jamovi/examples
This is just the contents from the examples/ subfolder
Sebastian Jentschke (https://www.uib.no/en/persons/Sebastian.Jentschke)

19.5.2 jamovi File Format (.omv)
.omv-files are ZIP-archives that contain a number of files.
• meta (newer versions, > 1.8) / META-INF/MANIFEST.MF (older versions)
• metadata.json
• xdata.json
• data.bin
• strings.bin (optional: if an variable with the measureType = ID and the dataType =
Text exist in the data set)
• index.html
• (optional: if analyses were conducted and are stored in the .omv-file, there are subfolders, one
for each analysis, containing, e.g., figures and the syntax for the analysis)
The metadata.json-file is the most useful starting point when trying to decode .omv-files, at
least if one is interested in, e.g., importing the data. The package jmvReadWrite on CRAN
(https://cran.r-project.org/package=jmvReadWrite) can be used to read or write .omv-files in R.
However, sometimes, one is only interested in having a brief look at results. In such case, it is
sufficient to extract the .omv-file (typically with right-clicking and choosing Extract). Afterwards,
just go into the folder that was extracted and click on index.html.
meta / META-INF/MANIFEST.MF
The manifest-file (meta since version 1.6, META-INF/MANIFEST.MF in earlier versions of
jamovi) contains four lines defining what version of the data and the jamovi archive were used to
create the .omv-file. An example of the content is shown below.
Manifest-Version: 1.0
Data-Archive-Version: 1.0.2
jamovi-Archive-Version: 11.0
Created-By: jamovi 2.2.3.0

metadata.json
The file is stored in JSON (JavaScript Object Notation) which is a lightweight data-interchange format. It is quite similar to YAML (but unfortunately a little less easy to read). However, there are
several packages that permit to import or export JSON, e.g., rjson inside R. Inside the metadata.
json-file, the name of the top level hierarchy is dataSet. This top-level hierarchy contains the
following branches:
• rowCount: number of rows in the data set
• columnCount: number of rows in the data set
• removedRows: positions where rows were removed (default: empty)
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there can be several lists with pairs of index and count under removedRows (if rows were
removed at different positions in the data file)
– index: line where lines where removed (after this line)
– count: number of removed lines
• addedRows: positions where rows were added (default: empty)
there can be several lists with pairs of start and end under addedRows (if new rows were
added at several positions in the data file)
– start: line from where lines where removed (after this line)
– end: line from where lines where removed (up to this line)
• fields: contains description for every data column (one field per each column)
– name: column name
– id: column id (numerical; unique column number)
– columnType: content that is contained in the column
Data (default), Computed, Recoded, Filter
– dataType: type of data contained in the column
Integer (default), Decimal, Text
– measureType: scale level of the data in the column
ID, Nominal (default), Ordinal, Continuous, None
– formula (for Computed Variables): formula used for calculations or filters
(default: )
– formulaMessage: error message for malformed formulas (default: )
– parentId: ID of the parent object (default: 0)
– width: column width in the jamovi data editor (default: 100)
– type: variable class used to store the data in the binary file
integer: 4 byte per cell, data type: long integer
number: 8 byte per cell, data type: double
string: C-style zero-terminated character strings
generally are data read from data.bin with text data stored as integer and the text
containedas variable levels contained in xdata.json; there is one exception, though,
which is if an variable with the measureType = ID is a text variable
– importName: name of the column when it was originally imported
(default: same as name; if created new)
– description: variable description / label (default: )
– transform: for transformed variables?
– edits: marks which rows in the table where edited (can contain several ranges as those
listed below)
start (row)
end (row)
– missingValues: contains a list with strings containing which values are defined as
missing values (default: empty); an entry could look like == 0 defining the 0 as a missing
value; there can be several such entries if more than one value is defined as indicating a
missing value
– trimValues: TRUE / FALSE (retain unused levels – trimValues‘‘: T doesnt retain
them)
– filterNo (only columnType Filter): unique ID for the filter
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– active (only columnType Filter): TRUE / FALSE (filter active)
• transforms: contains a description for every transformation rule (those rules can be applied
to several columns)
– name: name of the transformation rule (e.g., Transform 1)
– id: transformation id (numerical; unique number for the transformation)
– suffix: ? (default: )
– formula: formula for the transformation (e.g., MATCH($source, VC, OJ))
– formulaMessage: error message if the calculation of the transformation failed
– measureType: scale level of the transformation
ID, Nominal, Ordinal, Continuous, None (default)
– description: variable description / label (default: )
xdata.json
This file also uses JSON-format. It contains value-label-combinations. Each variable containing
variable labels has an entry with the name of the variable as a branch name. This branch then contains
the entries for the labels.
• variable name: variable name, matches a column name in the data frame
– labels: contains a list with three values for each value labels
(e.g., [1, Females, Females]); there is one entry for each value-label-comination (i.e, there
likely would be a second entry with, e.g. [2, Males, Males])
data.bin
This file contains the data matrix that you can see in your jamovi-spreadsheet stored as binary data.
Data are organized as columns. The arrangement of columns follows the order of the fields in
metadata.json (the value of name of the field is the column name).
In order to read data from the binary file, one needs to iterate through each column, determine as as
which variable type the data are stored: integer (long, 4 byte) or numeric (double, 8 bytes),
and then to read the data from the column by repeating reading the number of rows (rowCount).
Often the functions to read binary data let you give the number of occurences so that you can read a
column at once.
if

(mtaDta$dataSet$fields[[i]]$type == 'integer') {
colRaw = readBin(binHdl, integer(), n = rowNum)
} else if (mtaDta$dataSet$fields[[i]]$type == 'number') {
colRaw = readBin(binHdl, double(), n = rowNum)
} else if (mtaDta$dataSet$fields[[i]]$type == 'string') {
colRaw = as.data.frame(readBin(strHdl, character(), n =
,→rowNum))
readBin(binHdl,
integer(), n = rowNum)
}
The R-code above demonstrates the steps during reading: i counts over the columns, and determines
from the type of each field of the dataSet contained in metadata.json (here assigned to
the variable mtaDta) what type (either integer() or double() has to be read. n = permits to
define the number of repetitions (how many cells). It is set to rowNum (which contains the value of
rowCount).
The condition where type is string is a very special one and happens rarely. One has in this case
to read the C-style zero-terminated character strings from the strings.bin-file and at the same
time has to discard the respective column (containing integer()-values) from the data.bin-file.
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index.html
As mentioned above, the index.html can be obtained from extracting the .omv-file of interest
and the opening it in a browser. This should match the output that you can see in the right-hand panel
with the results in jamovi. There might be tiny differences though (e.g., comments that you can create
with jamovi [version 1.4 or above] might not show, etc.). Remember that you have to extract all files
(not only index.html) if you want to see the figures as well.
Jonathon Love

19.5.3 Contribute to jamovi as a GSoC project
(coming soon)
08-07-2019
Weve refined the advanced UI customization ( 93) in jamovi 1.0.4 and newer. This is not backwards
compatible, so we discourage its use in existing modules for the time being (Until the 1.0.4+ is is in
broader use). People developing or releasing modules for the first time are encouraged to make use
of it.
09-06-2017
Weve added a new document to our tutorial series describing how jamovi analyses can use state
( 84). State is used with longer running analyses, and allows the analysis to re-use results that were
calculated previously. This can lead to much faster analyses, and a much nicer user experience.
20-04-2017: Changes to dev tools for jamovi 0.7.3
Weve just released a beta of jamovi 0.7.3, which brings some significant improvements, and minor
changes to developing jamovi modules.
Changes to dependency resolution
In the past, were had a number of difficulties with dependency resolution for jamovi modules. Sometimes jmvtools would install more dependencies than were necessary, and other times not enough.
This stemmed from contamination of the R library path, from R packages installed on the system. In
this release weve successfully isolated the system libraries from the jmvtools, and only the required
dependencies will now be installed.
Improvements to .u.yaml-files
Previously, .u.yaml-files (the UI definition) were automatically generated from .a.yaml-files
(the analysis definition). This was sometimes problematic when additional changes were made to the
.a.yaml-files. It wasnt always clear which changes should be propagated to the .u.yaml-files,
and which should not.
In the 0.7.3, the .a.yaml and .u.yaml-files work together. The .u.yaml-file, by default, contains minimal information (mostly just describing the layout), and the property values, for example
labels, are taken directly from the .a.yaml-file. For many people, they will only need to edit the
.a.yaml-file, and jmvtools can take care of the .u.yaml-file itself. More documentation for UI
Design will be coming soon.
.u.yaml-files using this new scheme will have the jus, near the top of the file, specified as 2.0.
.u.yaml-files using the older jus of 1.0 will be automatically upgraded. Upgraded files will be
placed in tame compilerMode (explained next), you may want to change it to aggressive.
compilerMode: aggressive vs tame
jmvtools also introduces a new option in .u.yaml-files: compilerMode. By default, .u.yamlfiles are created in aggressive mode. This means that jmvtools will take a heavy handed
approach when updating the .u.yaml-files. If new options are added to the .a.yaml-file, it will
aggressively add them into the .u.yaml-file, overwriting any manual changes.
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In contrast, the compilerMode of tame does not overwrite manual changes in the u.yaml-file.
The trade off is that it often cant position UI elements as optimally.
We recommend beginning with your .u.yaml-files in compilerMode set to aggressive, and
when you begin to refine your UI by adding custom changes to your .u.yaml-files swap over
to compilerMode set to tame so that your changes are preserved. Again, for a lot of people,
aggressive mode will be all that they will ever need.
Outstanding issues
For the time being, changes to the .a.yaml and / or the .u.yaml-files, will still require you to shut
jamovi down and restart it before youll see the changes to the UI. We hope to fix this issue in the next
few weeks.
On windows, jmvtools is still not able to find the jamovi installation by default. You will still need to
pass the home option, or set the jamovi_home option.
02-04-2017: Added dev mode to jamovi 0.7.2.7
jamovi 0.7.2.7 Adds dev mode, providing a stack trace when an analysis errors for whatever reason.
The tutorial has been updated to describe this: Debugging an analysis ( 67).
Sebastian Jentschke (https://www.uib.no/en/persons/Sebastian.Jentschke)

132

Chapter 19. developer hub

CHAPTER

TWENTY

FROM SPSS TO JAMOVI

The majority of users and institutions migrating to jamovi previously used SPSS. jamovis interface, although in many ways quite different, should feel immediately familiar to
people who have used SPSS before.
Comparison of analyses ( 133) provides an overview of which analysis functions are available in SPSS and the respective functions in jamovi.

20.1 Comparison of analyses available in SPSS and jamovi
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SPSS

jamovi

Already at first glance, it becomes clear that
jamovi currently has fewer features than SPSS.
BUT:
(1) There is a (ever increasing) made available
via modules (press the + sign in the right upper
corner of the jamovi window to add them).
(2) The features implemented already cover
standard needs (90% of the most frequently
used analyses in psychology).
Feel free to check out which modules
(https://www.jamovi.org/library.html) are
available: There is also quite a wealth of
modules covering functions that are not
available in SPSS but very useful (e.g., for
meta-analyses, structural equation models,
etc.).
If you are willing to use some R code (e.g., in
conjunction with the jamovi-module Rj) then
you can (most presumably) do every analysis
you can imagine.

Reports
Reports → Codebook
Reports → OLAP Cubes
Reports → Case summaries
Reports → Reports Summaries in Rows
Reports → Reports Summaries in Columns
Descriptive Statistics
Descriptive Statistics → Frequencies
Descriptive Statistics → Descriptives
Descriptive Statistics → Explore
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N/A
N/A
Exploration → Descriptives has the same functionality
N/A
N/A
Exploration → Descriptives combines all three
procedures
tick ńFrequency tablesż to get an output that is
similar to that of ńFrequenciesż in SPSS
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20.1 –
jamovi
Frequencies → (Contingency tables) → Independent samples
Descriptive Statistics → Ratio
N/A
Bayesian Statistics
requires the jamovi-module ńjsqż
Bayesian Statistics → One Sample Normal
T-Test → Bayesian One Sample T-Test
Bayesian Statistics → One Sample Binomial
Frequencies → Bayesian Proportion Test
Bayesian Statistics → One Sample Poisson
Frequencies → Bayesian Contingency Tables
Bayesian Statistics → Related Sample Normal T-Test → Bayesian Paired Samples T-Test
Bayesian Statistics → Independent Samples T-Test → Bayesian Independent Samples TNormal
Test
Bayesian Statistics → Pearson Correlation
Regression → Bayesian Correlation Matrix /
Bayesian Correlation Pairs
Bayesian Statistics → Linear Regression
Regression → Bayesian Linear Regression
Bayesian Statistics → One-way ANOVA
ANOVA → Bayesian ANOVA (can handle several factors while SPSS is limited to one factor)
Bayesian Statistics → Log-Linear Models
Frequencies → Bayesian Log-Linear Regression
Compare Means
Compare Means → Means
Exploration → Descriptives replaces / integrates that functionality, choose the drop-down
menu ńStatisticsż and set ticks at ńMeanż, ńNż
and ńStd. deviationż
Compare Means → Independent-Samples T T-Test → Independent Samples T-Test
Test
Compare Means → Paired-Samples T Test
T-Test → Paired Samples T-Test
Compare Means → One-Sample T Test
T-Test → One Sample T-Test
Compare Means → One-Way ANOVA
ANOVA → One-Way ANOVA
General Linear Model
General Linear Model → Univariate
ANOVA → One-Way ANOVA
General Linear Model → Multivariate
ANOVA → MANCOVA
General Linear Model → Repeated Measures
ANOVA → Repeated Measures ANOVA
General Linear Model → Variance Compo- N/A
nents
Generalized Linear Models
requires the jamovi-module ńGAMLjż
Generalized Linear Models → Generalized
Linear Models
Generalized Linear Models → Generalized Estimating Equations
Mixed Models
requires the jamovi-module ńGAMLjż
Mixed Models → Linear
Mixed Models → Generalized Linear
Correlate
Correlate → Bivariate
Regression → Correlation Matrix
Correlate → Partial
Regression → Partial Correlation
Correlate → Distances
N/A
Regression
Regression → Automatic Linear Models
N/A
Regression → Linear
Regression → Linear Regression
Regression → Ordinal
Regression → (Logistic Regression) → Ordinal
Outcomes
Regression → Curve Estimation
N/A
Regression → Partial Least Squares
N/A
Loglinear
Loglinear → General
Frequencies → Log-Linear Regression
SPSS
Descriptive Statistics → Crosstabs

20.1. Comparison of analyses available in SPSS and jamovi
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SPSS
Loglinear → Logit
Loglinear → Model Selection
Classify
Classify → Nearest Neighbor
Classify → Discriminant

20.1 –
jamovi
N/A
N/A

Classify → TwoStep Cluster
Classify → Hierarchical Cluster
Classify → K-Means Cluster
Dimension Reduction
Dimension Reduction → Factor

Scale
Scale → Reliability Analysis
Scale → Multidimensional Scaling
Nonparametric Tests
Nonparametric Tests → One Sample
Nonparametric Tests → Independent Samples
Nonparametric Tests → Related Samples
Nonparametric Tests → Legacy Dialogs →
Chi-Square
Nonparametric Tests → Legacy Dialogs → Binomial
Nonparametric Tests → Legacy Dialogs →
Runs
Nonparametric Tests → Legacy Dialogs → 1Sample K-S

Nonparametric Tests → Legacy Dialogs → 2
Independent Samples
Nonparametric Tests → Legacy Dialogs → 2
Related Samples
Nonparametric Tests → Legacy Dialogs → K
Independent Samples
Nonparametric Tests → Legacy Dialogs → K
Related Samples
Survival
Survival → Life Tables
Survival → Kaplan-Meier
Survival → Cox Regression
Survival → Cox w/ Time-Dep Cov
Multiple Response
Multiple Response → Define Variable Sets
Multiple Response → Frequencies
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N/A
N/A, can be calculated using R-code
(https://www.statmethods.net/advstats/discriminant.html)
and the R-library ńMASSż
N/A
N/A, can be calculated using R-code
(https://www.statmethods.net/advstats/cluster.html)
and the R-library ńpvclustż

Factor → (Data reduction) → Principal
Component Analysis
Factor → (Data reduction) → Exploratory
Factor Analysis1

Factor → (Scale analysis) → Reliability analysis
N/A
N/A, the tests itself are available (see below),
but not a common start menu that allows a selection based on your data (e.g., between- or
within-subject)
Frequencies → (One Sample Proportion Tests)
→ N Outcomes (x2 goodness of fit)
Frequencies → (One Sample Proportion Tests)
→ 2 Outcomes (Binomial test)
N/A
Shapiro-Wilks available under Exploration →
Descriptives, choose drop-down menu ńStatisticsż and tick ńShapiro-Wilksż (KolmogoroffSmirnov available via the additional module
moretests)
T-Test → Independent Samples T-Test, set tickbox ńMann-Whitney Uż
T-Test → Paired Samples T-Test, set tick-box
ńWilcoxon Rankż
ANOVA → (Non-Parametric) → One-Way
ANOVA (Kruskal-Wallis)
ANOVA → (Non-Parametric) → Repeated
Measures ANOVA (Friedman)
requires the jamovi-module ńDeath watchż

N/A
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SPSS
Multiple Response → Crosstabs
ROC Curve
ROC Curve

20.1 –
jamovi

Simulation
Simulation
Spatial and Temporal Modeling
Spatial and Temporal Modeling → Spatial
Modeling

N/A, accessible via R packages (e.g., ROCR
eller pROC)
N/A
N/A

20.2 Side-by-side
The pages in this section show in side-by-side comparisons how something is done in
SPSS and in jamovi. For this demonstration, the examples from Andy Fields (2017)
(https://edge.sagepub.com/field5e) book are used.
Sebastian Jentschke (https://www.uib.no/en/persons/Sebastian.Jentschke)

20.2.1 From SPSS to jamovi: t-test for independent samples
This comparison shows how a t-test for independent samples is performed in SPSS and
jamovi. How the test is conducted in SPSS follows the description in chapter 10.8 of
Field (2017) (https://edge.sagepub.com/field5e), especially Figure 10.4 and Output 10.3 10.4. It uses the data set Invisibility.sav which can be downloaded from the web page
accompanying the book (https://edge.sagepub.com/field5e/student-resources/datasets).
1 Whereas SPSS puts both methods into one procedure (FACTOR) makes jamovi a conceptual difference between Principal Component
Analysis aiming at data reduction (i.e., reducing the number of dimension that are required to describe the data) and Exploratory Factor
Analysis aiming at extracting underlying latent variables.
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SPSS
In SPSS you can run an independent t-test
using: Analyze → Compare Means →
Independent Samples T-test

jamovi
In jamovi you do this using: Analyses (tab)
→ T-Tests → Independent Samples
T-Test

In SPSS, Mischevious acts is moved to
the variable box Test variables(s) and
Cloak of invisibility to variable box
Grouping variables. Afterwards, press
the button Define Groups... (underneath
the variable box Grouping variables)
and enter 0 under Group 1 and 1 under
Group 2.

In jamovi, the variable Mischief is
moved to the variable box Dependent
Variable(s), and the variable Cloak
is moved to the variable box Grouping
Variable. If you wish to obtain an identical
output to SPSS, one has to switch on the
Levenes Test for the Equality of Variances,
by ticking Homogeneity Test under
Assumption Checks; the table with the
descriptive statistics for the two groups can be
selected by ticking Descriptives under
Additional Statistics.

If one compares the outputs of SPSS and jamovi, the results are the same. However, the output of
jamovi appears much clearer. The main results can be found in slightly different places in SPSS
and jamovi.

138
In SPSS, the output table Independent
Samples T-Test starts with Levenes Test
for the Equality of Variances. If it is NOT

Chapter 20. From SPSS to jamovi
If the p-value in the table Homogeneity of
Variances Test (Levene's) is significant (p < 0.05), then you have to correct for that
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Sebastian Jentschke (https://www.uib.no/en/persons/Sebastian.Jentschke)

20.2.2 From SPSS to jamovi: t-test for paired samples
This comparison shows how a t-test for independent samples is performed in SPSS and
jamovi. As a first step, it demonstrates the calculation of the statistics underlying the t-test
for paired samples. For this calculation, first, the average number of mischieveous acts for
each person is calculated before a mean of these individual averages is calculated for the
whole group. The individual is then adjusted for that group mean. The aim of this calculation is to show that by using repeated measurements, one can control for some proportion
of the variance which is caused by individual differences in performance. In connection
with this, the standard error of mean becomes smaller (which means that effects easier
can become significant (as compared to a between-subjects design). This is described in
chapter 10.9.2 of Field (2017) (https://edge.sagepub.com/field5e), especially Figure 10.7
to 10.10.
It uses the data set Invisibility RM.sav which can be obtained from the web page accompanying the book (https://edge.sagepub.com/field5e/student-resources/datasets). The data
set describes a repeated-measures-design where first the baseline-number of mischieveous
acts (during one week) is determined for each participant (variable No_Cloak) before
they are handed a cloak that makes them invisible. After receiving the cloak, the number of
mischieveous acts is recorded for the following week (variable Cloak) during which they
can make themselves invisible (which is assumed to increase the number of mischieveous
acts committed).
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SPSS
In SPSS you can create variables
using: Transform → Compute
Variable...

jamovi
In jamovi you do this using: Data (tab) → Compute

Both in SPSS and jamovi, you can calculate the average of the two columns No_Cloak and
Cloak by using the calculation term MEAN(No_Cloak, Cloak) (as shown in the images below). Alternatively, you can choose the function to calculate the mean from the available functions
(press fx in jamovi to open a input window where you can select those functions).

Now we would like to calculate the group mean for the individual means of the two conditions
(No_Cloak and Cloak). To do this, we calculate descriptive statistics.
In
SPSS
this
is
done In jamovi this is done using:
Analyzes →
with:
Analyze
→ Exploration → Descriptives.
In the input
Descriptive Statistics
panel, you assign the variable with the individual mean
→ Descriptives. In the input Mean to Variables.
window, you assign the variable
with the individual mean Mean to
Variable(s).
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After clicking Options in the input window, one can adjust which
statistics one wishes to be calculated. For now, we just need to
Mean and could (in principle) just
untick all other values.

In jamovi, one can adjust which statistics one wishes to be
calculated in the drop-down-menu Statistics. There,
we untick all settings except for Mean.
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From SPSS to jamovi: t-test for paired samples
After having demonstrated the beneficial effect of repeated-measures-designs on the standard error of mean, we conduct a t-test for paired samples. Using this test, we compare whether the number of mischieveous acts has increased after receiving a cloak of
invisibility (variable Cloak) in comparison to the number of mischieveous acts at baseline (variable No_Cloak). This analysis is described in chapter 10.9.3 of Field (2017),
especially Figure 10.12 and Output 10.8 - 10.9. We use the same data set Invisibility
RM.sav which can be downloaded from the web page accompanying Andy Fields book
(https://edge.sagepub.com/field5e/student-resources/datasets).
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SPSS
In SPSS you can set up a t-test for paired samples using: Analyze → Compare means
→ Paired Samples T-Test.

jamovi
In jamovi you do this using: Analyses
(tab) → T-Tests → Paired Samples
T-Test

In the input window that opens, the two
variables No invisibility cloak and
Invisibility cloak are assigned to the
field Paired variables.

In the input panel that opens, the variables
No_Cloak and Cloak are moved to the variable input box Paired Variables.

Afterwards, we press the Options button to
set the confidence interval to 95%. We, furthermore, select Exclude cases analysis
by analysis (however, the latter setting
only matters if we compare two pairs of variables and if those two pairs differ in for which
participant those missing values occur).

In jamovi, do we go further down in the input
panel and tick Mean Difference and its
Confidence interval underneath. We,
furthermore, tick Descriptives to obtain
a output that is similar to SPSS. Finally,
we set the radio box to Exclude cases
analysis by analysis (the same comment as for SPSS applies; the setting wont matter unless we compare at least two pairs of variables differing in which participants have missing values).

The results from SPSS and jamovi are identical, but they are arranged slightly differently. SPSS
gives the mean difference (blue box) first, before giving the t-statistics and their respective degrees
of freedom and p-value (red box), in jamovi it is the other way round (statistics – red box –
first and mean difference – blue box – afterwards). Another table underneath (green box) gives
the descriptive statistics for the two variables that were compared. Except from that jamovi also
reports the Median, and a slightly different way to arrange the columns (SPSS begins with the
Mean and has the N afterwards, jamovi vice versa) the two tables are identical. The numerical
values for the statistics are identical: t = -3.804, df = 11, p = 0.003.
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20.2.3 From SPSS to jamovi: Non-parametric analyses
This comparison shows how a Mann-Whitney test is conducted in SPSS and
jamovi. The SPSS test follows the description in chapter 7.4.3 in Field (2017)
(https://edge.sagepub.com/field5e), especially figure 7.6 - 7.8 and output 7.2. It uses the
data set Drug.sav which can be downloaded from the web page accompanying the book
(https://edge.sagepub.com/field5e/student-resources/datasets).
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SPSS
In SPSS, a Mann-Whitney test can be run using:
Analyze → Nonparametric Tests ``
→ ``Independent Samples.

jamovi
In jamovi this is done using the following steps:
Analyses → T-tests → Independent
Samples T-Test.

In SPSS, choose Fields from the
menu. Then, click Use custom field
assignments and move the variables
Sunday_BDI and Wednesday_BDI to
Test Fields, and the variable Drug to
Groups.

In jamovi,
move Sunday_BDI and
Wednesday_BDI to the Dependent
Variables variable box, and Drug to the
Grouping Variable box. Then, tick the
box for Mann-Whitney U.

Open the Settings window, and click
Customize tests.
Tick the box for
Mann-Whitney U (2 samples).
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From SPSS to jamovi: Non-parametric analyses
This comparison shows how a Wilcoxon signed-rank test is conducted in SPSS and
jamovi. The SPSS test follows the description in chapter 7.5.2 in Field (2017)
(https://edge.sagepub.com/field5e), especially figure 7.9 and output 7.3 - 7.4. It uses the
data set Drug.sav which can be downloaded from the web page accompanying the book
(https://edge.sagepub.com/field5e/student-resources/datasets).
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SPSS
In SPSS, first split the file using Data →
Split File.

jamovi
In jamovi, the file can be split using:
Variables → Filters. In the window
that appears, write = Drug == "Ecstasy"
and then save the output. Open the original file again and repeat these steps but write
the following command instead: = Drug ==
"Alcohol". Now you will have two separate
files, one for each drug.

In the Split File window, click
Organize output by groups. Then,
move the Drug variable to the box called
Groups Based on. Lastly, click Sort
the file by grouping variables.
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From SPSS to jamovi: Non-parametric analyses
This comparison shows how a Kruskal-Wallis test is conducted in SPSS and
jamovi. The SPSS test follows the description in chapter 7.6.4 in Field (2017)
(https://edge.sagepub.com/field5e), especially figure 7.13 and output 7.5 - 7.6. It uses the
data set Soya.sav which can be downloaded from the web page accompanying the book
(https://edge.sagepub.com/field5e/student-resources/datasets).
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SPSS
In SPSS, a Kruskal-Wallis test can be run using:
Analyze → Nonparametric Tests ``
→ ``Independent Samples.

jamovi
In jamovi this is done using the following steps:
Analyses → ANOVA → One-Way ANOVA
Kruskal-Wallis.

In SPSS, choose Fields from the
menu. Then, click Use custom field
assignments and move the Sperm variable
to Test Fields, and the variable Soya to
Groups.

In jamovi, move Sperm to the Dependent
Variables box and Soya to the Grouping
Variable box. Then, tick the box for DSCF
pairwise comparisons.

Open the Settings window, and click
Customize tests.
Tick the box for
Kruskal-Wallis 1-way ANOVA (k
samples), and use the drop-down menu next
to Multiple comparisons to select All
pairwise.

When comparing the outputs, the results in SPSS and jamovi are slightly different. In addition,
the results from jamovi appear much clearer.
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20.2.4 From SPSS to jamovi: Analysis of Covariance (ANCOVA)
This comparison shows how a regression with one predictor and two dummy variables is
performed in SPSS and jamovi. The SPSS test follows the description in chapter 13.3 of
Field (2017) (https://edge.sagepub.com/field5e), especially Output 13.1 - 13.2. It uses the
data set Puppy Love Dummy.sav which can be downloaded from the web page accompanying the book (https://edge.sagepub.com/field5e/student-resources/datasets).
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SPSS
In SPSS you can run a regression using:
Analyze → Regression → → Linear.

jamovi
In jamovi you do this using: Analyses →
Regression → Linear Regression.

In SPSS, move Happiness to the variable
box Dependent and Puppy_love to the
variable box Independent(s).

In jamovi, move Happiness to the
variable
box
Dependent Variable,
Puppy_love
to
the
variable
box
Covariates, and Low_Control and
High_Control to the Factors box.

Press the Next button to create a new block
of Independent(s), and move the variables Low_Control and High_Control
into this box.

Create a new block of independent variables using Model Builder. Press + Add
New Block and move Low_Control and
High_Control into Block 2.
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From SPSS to jamovi: Analysis of Covariance (ANCOVA)
This comparison shows how to test if the covariate is independent of
the independent variable, as described in chapter 13.5.3 of Field (2017)
(https://edge.sagepub.com/field5e), especially output 13.3. It uses the data set Puppy
Love Dummy.sav which can be downloaded from the web page accompanying the book
(https://edge.sagepub.com/field5e/student-resources/datasets).
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SPSS
In SPSS you can run this test using Analyze
→ Compare Means → One Way ANOVA.

jamovi
In jamovi you do this using: Analyses →
ANOVA → ANCOVA.

In SPSS, move Puppy_love to the variable
box Dependent List and Dose to the variable box Factor.

In jamovi, move Puppy_love to the variable box Dependent Variable and Dose
to the variable box Fixed Factors.

When comparing the outputs in SPSS and jamovi, the results are exactly the same. The only
difference is that jamovi does not provide a row with the total sum of squares and degrees of
freedom.
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In the ANCOVA table, you can find the degrees In jamovi, these values are found in the equivaof freedom between groups and within groups, lent table (ANCOVA - Puppy_love).
as well as the F-value and its significance level.
The results from this analysis indicate that for
all three puppy therapy groups, the love for
puppies were about the same.
In both SPSS and in jamovi, the degrees of freedom can be found in the second, the F-value in the
fourth, and the p-value in the fifth column.
The numerical values are the same in both SPSS and jamovi: F*(2, 27) = 1.98, *p = 0.16.
If you wish to replicate those analyses using syntax, you can use the commands below (in jamovi,
just copy to code below to Rj ( 181)). Alternatively, you can download the SPSS output files and
Chapter 20. From SPSS to jamovi
the jamovi files with the analyses from below the syntax.
ONEWAY Puppy_love BY Dose

jmv::ancova(
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From SPSS to jamovi: Analysis of Covariance (ANCOVA)
This comparison shows how to conduct an analysis of covariance in SPSS and jamovi.
The SPSS test follows the description in chapter 13.5.4 - 13.5.6 in Field (2017)
(https://edge.sagepub.com/field5e), especially figure 13.5 - 13.7 (excluding Options)
and outputs 13.6 - 13.11 (excluding Bootstrap, as this is not [yet] an option in jamovi).
It uses the data set Puppy Love.sav which can be downloaded from the web page accompanying the book (https://edge.sagepub.com/field5e/student-resources/datasets).
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SPSS
In SPSS, you can run this test using:
Analyze → General Linear Model →
Univariate.

jamovi
In jamovi you do this using: Analyses →
ANOVA → ANCOVA.

In SPSS, move Happiness to the
Dependent Variable box, Dose to the
Fixed Factor(s) box, and Puppy_love
into Covariate(s).

In jamovi, move Happiness to the
Dependent Variable box, Dose to
the Fixed Factors box and Puppy_love
into Covariates.

Then, open the dialog box called Contrasts,
and click the drop-down menu to select Simple.
Change the Reference
Category to First, and press Change.

Open the Contrasts window, and select
simple from the drop-down menu.

Select EM Means from the sidebar. Move
Dose to the box called Display Means
for:, press Compare main effects and
select Sidak in the drop-down list.

Then, move Dose to Term 1 in the
Estimated Marginal Means
window. Tick the box for Marginal means
tables as shown in the picture below.
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From SPSS to jamovi: Analysis of Covariance (ANCOVA)
This comparison shows how an analysis of covariance which excludes the covariate is
conducted in SPSS and jamovi. The SPSS test follows the description in chapter 13.6.1 13.6.4 in Field (2017) (https://edge.sagepub.com/field5e), especially figure 13.5 - 13.7 (excluding the covariate in figure 13.5 and Options in figure 13.7) and output 13.5. It uses
the data set Puppy Love.sav which can be downloaded from the web page accompanying
the book (https://edge.sagepub.com/field5e/student-resources/datasets).
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SPSS
In SPSS, you can run this test using:
Analyze → General Linear Model →
Univariate.

jamovi
In jamovi, you can create an analysis of covariance using: Analyses → ANOVA →
ANCOVA.

In SPSS, move Happiness to the
Dependent Variable box and Dose
to the Fixed Factor(s) box.

In jamovi, move Happiness to Dependent
Variable and Dose to Fixed Factors.

Open the dialog box called Contrasts, and
click the drop-down menu to select Simple.
Change the Reference Category to
First, and press press Change.

Open the Contrasts window, and select
simple from the drop-down menu.

Select EM Means from the sidebar. Move
Dose to the box called Display Means
for:, press Compare main effects and
select Sidak in the drop-down list.

In the Estimated Marginal Means window, move Dose to Term 1. Tick Tick
the box for Marginal means tables as
shown in the picture below.
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From SPSS to jamovi: Analysis of Covariance (ANCOVA)
This comparison shows how to test the assumption of homogeneity of regression slopes in
SPSS and jamovi. The SPSS test follows the description in chapter 13.7 in Field (2017)
(https://edge.sagepub.com/field5e), especially figure 13.9 and output 13.12. It uses the data
set Puppy Love Dummy.sav which can be downloaded from the web page accompanying
the book (https://edge.sagepub.com/field5e/student-resources/datasets).
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SPSS
In SPSS, you can run this test using:
Analyze → General Linear Model →
Univariate.

jamovi
In jamovi you do this using: Analyses →
ANOVA → ANCOVA.

In SPSS, move Happiness to the
Dependent Variable box, Dose to the
Fixed Factor(s) box, and Puppy_love
to the Covariate(s) box.

In jamovi, move the Happiness variable to
Dependent Variable, the Dose variable
to Fixed Factors, and the Puppy_love
variable to Covariates.

Access the Model window, and click Build
terms. Then, mark the variables Dose and
Puppy_love, open the drop-down menu and
choose Interaction.

Next, open the Model window. Mark both
Dose and Puppy_love, then click the arrow with the drop-down menu and click
Interaction.

Comparisons between the output in SPSS and jamovi shows that the results are the same.
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20.2.5 From SPSS to jamovi: Correlation
This comparison shows how a Pearsons correlation is conducted in SPSS and
jamovi. The SPSS test follows the description in chapter 8.4.1-8.4.2 in Field (2017)
(https://edge.sagepub.com/field5e), especially figure 8.7-8.8 and output 8.1. It uses the
data set Exam Anxiety.sav which can be downloaded from the web page accompanying
the book (https://edge.sagepub.com/field5e/student-resources/datasets).
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SPSS
In SPSS you can run a correlation using:
Analyze → Correlate → Bivariate.

jamovi
In jamovi you do this using: Analyses →
Regression → Correlation Matrix.

In SPSS, move the variables Revise,
Exam and Anxiety to the variable box
Variables. In addition, make sure the
box called Pearson under Correlation
Coefficients is ticked.

In jamovi, move the variables Revise,
Exam and Anxiety into the box
on the right.
Check Pearson under
Correlation Coefficients
and
Report significance,
Flag
significant correlations and N
under Additional Options.

The results are essentially the same in SPSS and in jamovi.
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From SPSS to jamovi: Correlation
This comparison shows how a Spearmans correlation is conducted in SPSS and
jamovi. The SPSS test follows the description in chapter 8.4.3 in Field (2017)
(https://edge.sagepub.com/field5e), especially output 8.2. It uses the data set The
Biggest Liar.sav which can be downloaded from the web page accompanying the book
(https://edge.sagepub.com/field5e/student-resources/datasets).
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SPSS
In SPSS you can run a correlation using:
Analyze → Correlate → Bivariate.

jamovi
In jamovi you do this using: Analyses →
Regression → Correlation Matrix.

In SPSS, move the
and Position
Variables.
In
called Spearman
Coefficients.

In jamovi, move the variables Creativity
and Position into the box on
the right.
Tick Spearman under
Correlation Coefficients
and
Report significance,
Flag
significant correlations and N
under Additional Options.

variables Creativity
to the variable box
addition, tick the box
under Correlation

The results in SPSS and in jamovi are the same.
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In SPSS, you can tell if a correlation is significant by noting the amount of asterisks after the
correlation coefficient. The correlation matrix
shows the correlation coefficient, the p-value,
and the sample size (N).

jamovi, in accordance with APA-style, flags
significant correlations using one (p < .05), two
Chapter
20. asterisks.
From SPSS
to jamovi
(p < .01) or three
(p < .001)
In contrast, in SPSS all correlations above p < .01
level are simply marked using two instead of
three asterisks.
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From SPSS to jamovi: Correlation
This comparison shows how a Kendalls tau correlation is conducted in SPSS and
jamovi. The SPSS test follows the description in chapter 8.4.4 in Field (2017)
(https://edge.sagepub.com/field5e), especially output 8.3. It uses the data set The
Biggest Liar.sav which can be downloaded from the web page accompanying the book
(https://edge.sagepub.com/field5e/student-resources/datasets).
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SPSS
In SPSS you can run a correlation using:
Analyze → Correlate → Bivariate.

jamovi
In jamovi you do this using: Analyses →
Regression → Correlation Matrix.

In SPSS, move the variables Creativity
and Position to the variable box
Variables. Then, tick Kendalls tau-b
under Correlation Coefficients.

In jamovi, move the variables Creativity
and Position into the box on the
right.
Tick Kendalls tau-b under
Correlation Coefficients
and
Report significance,
Flag
significant correlations and N
under Additional Options.

The results in SPSS and jamovi are identical.
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significant correlations using one (p < .05), two
(p < .01) or three (p < .001) asterisks. In con-
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From SPSS to jamovi: Correlation
This comparison shows how a point-biserial correlation is conducted in SPSS and
jamovi. The SPSS test follows the description in chapter 8.4.5 in Field (2017)
(https://edge.sagepub.com/field5e), especially output 8.4. It uses the data set Roaming cats.sav which can be downloaded from the web page accompanying the book
(https://edge.sagepub.com/field5e/student-resources/datasets).
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SPSS
In SPSS you can run a correlation using:
Analyze → Correlate → Bivariate.

jamovi
In jamovi you do this using: Analyses →
Regression → Correlation Matrix.

In SPSS, move the variables Time `` and
``Sex to the variable box Variables.
Then, tick Pearson under Correlation
Coefficients.

In jamovi, move the variables Time and Sex
into the box on the right. Tick Pearson
under
Correlation Coefficients
and
Report significance,
Flag
significant correlations and N
under Additional Options.

The results are the same in SPSS and in jamovi.
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From SPSS to jamovi: Correlation
This comparison shows how a semi-partial (or partial) correlation is conducted in SPSS
and jamovi.
The SPSS test follows the description in chapter 8.5.3 in Field (2017)
(https://edge.sagepub.com/field5e), especially figure 8.11 and output 8.5. It uses the data set
Exam Anxiety.sav which can be downloaded from the web page accompanying the book
(https://edge.sagepub.com/field5e/student-resources/datasets).
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SPSS
In SPSS you can run a partial correlation using:
Analyze → Correlate → Partial.

jamovi
In jamovi you do this using:
→
Regression
→
Correlation.

In SPSS, move the variables Exam ``
and ``Anxiety to the variable box
Variables, and Revise into the box called
Controlling for.

In jamovi, move the variables Exam and
Anxiety into the Variables box and
Revise into the variable box Control
Variables.
Tick Pearson under
Correlation Coefficients``and
``Report significance
under
Additional Options.

Analyses
Partial

The results are the same in SPSS and in jamovi.
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20.2.6 From SPSS to jamovi: Linear regression
This comparison shows how a linear model with one predictor is conducted in SPSS
and jamovi. The SPSS test follows the description in chapter 9.7 in Field (2017)
(https://edge.sagepub.com/field5e), especially figure 9.13, and output 9.2-9.4. It uses the
data set Album Sales.sav which can be downloaded from the web page accompanying the
book (https://edge.sagepub.com/field5e/student-resources/datasets).
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SPSS
In SPSS, the following steps activates a linear regression: Analyze → Regression →
Linear.

jamovi
In jamovi, this can be done using:
Analyses → Regression → Linear
Regression.

In SPSS, move the variable Sales to the
Dependent box and the variable Adverts
to the Independent(s) box. Click Ok.

In jamovi, move Sales to the Dependent
Variable box and Adverts to the
Covariates box.

Then, open the Model Coefficients
window and press ANOVA test and
Standardized estimate.

In the window called Model Fit, click R, R2
and Adjusted R2 .
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From SPSS to jamovi: Linear regression
This comparison shows how a linear model with several predictors is conducted in SPSS
and jamovi. The SPSS test follows the description in chapter 9.10 - 9.11 in Field
(2017) (https://edge.sagepub.com/field5e), especially figure 9.15-9.19 and 9.22-9.23 as
well as output 9.5-9.12. It uses the data set Album Sales.sav which can be downloaded
from the web page accompanying the book (https://edge.sagepub.com/field5e/studentresources/datasets).
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SPSS
In SPSS, the following steps activates a linear regression: Analyze → Regression →
Linear.

jamovi
In jamovi, this can be done using:
Analyses → Regression → Linear
Regression.

Move the variable Sales to the variable box
Dependent and the variable Adverts to the
variable box Independent(s).

Move Sales to the Dependent Variable
box, and the variables Adverts, Airplay
and Image to the box called Covariates.

Press Next to create a new block, and add
the variables Airplay and Image to this
Independent(s) box.

In the Model Builder window, create a new
block by clicking + Add New Block and
move the variables Airplay and Image to
Block 2.

In the Statistics dialog box, select the options shown in the picture below.

Under
Assumption Checks
click
Collinearity statistics,
Q-Q
plot of residuals,
Residuals
plots and Cooks distance.
Chapter 20. From SPSS to jamovi
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20.2.7 From SPSS to jamovi: Logistic Regression
This comparison shows how a binary logistic regression is conducted in SPSS and
jamovi. The SPSS test follows the description in chapter 20.5 - 20.6 in Field (2017)
(https://edge.sagepub.com/field5e), especially figure 20.7 - 20.10 and output 20.1 20.5 (bootstrap excluded). It uses the data file Eel.sav which can be downloaded
from the web page accompanying the book (https://edge.sagepub.com/field5e/studentresources/datasets).
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SPSS
In SPSS you can run a binary logistic regression using: Analyze → Regression →
Binary Logistic.

jamovi
In jamovi you do this using: Analyses
→
Regression
→
2 Outcomes
Binominal.

In SPSS, move Cured to the Dependent
variable box and Intervention to the
Covariates variable box.

In jamovi, move the variable Cured to
Dependent Variable and the variables Duration and Intervention to
Covariates.

Click Next and add Duration to this new
block.

Create two new blocks by clicking + Add
New Block in the Model Builder dropdown menu.
Add the Duration variable to Block 2, and add Duration and
Intervention to Block 3 by marking
them both and clicking Interaction in the
drop-down menu.

Create a third block by clicking Next one more
time, and create an interaction by marking both
Intervention and Duration and moving
them to the block by pressing the arrow.
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20.2.8 From SPSS to jamovi: Analysis of frequencies
This comparison shows how a Chi-square test is conducted in SPSS and jamovi.
The SPSS test follows the description in chapters 19.7.2-19.7.3 in Field (2017)
(https://edge.sagepub.com/field5e), especially figures 19.4-19.5 and output 19.2-19.4. It
uses the data set Cats Weight.sav which can be downloaded from the web page accompanying the book (https://edge.sagepub.com/field5e/student-resources/datasets).
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SPSS
In SPSS, you run a chi-square test using :
Analyze → Descriptive Statistics
→ Crosstabs. Before this, you can weight
cases by following these steps: Data →
Weight Cases.

jamovi
In jamovi, this can be done using:
Analyses
→
Frequencies
→
Independent Samples - χ2 test
of association.

In the Weight Cases window, click
Weight cases by and move Frequency
to the box called Frequency Variable.

In jamovi, move Training to Rows, Dance
to Columns, and Frequency to Counts
(optional).

Chapter 20. From SPSS to jamovi
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From SPSS to jamovi: Analysis of frequencies
This comparison shows how a loglinear analysis is conducted in SPSS and
jamovi. The SPSS test follows the description in chapter 19.9.2 in Field (2017)
(https://edge.sagepub.com/field5e), especially figure 19.7 and output 19.7 - 19.10. It uses
the data set Cats and Dogs.sav which can be downloaded from the web page accompanying the book (https://edge.sagepub.com/field5e/student-resources/datasets).
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SPSS
In SPSS, you can run a loglinear analysis using: Analyze → Loglinear → Model
Selection.

jamovi
In jamovi, this can be done using: Analyses
→ Frequencies → Log- Linear
Regression.

In SPSS, move the variables Animal,
Training and Dance to the Factor(s)
box. Then, mark all three variables and
click Define Range.
In this window,
set Minimum as 0 and Maximum as 1.
Click Continue. In the box called Model
Building,
click Enter in single
step.

In jamovi, move Animal, Training and
Dance to Factors.
Open the Model
Builder window, click + Add New
Block and move the three variables to this
block.

Add another block. Mark all three variables
and choose All 2 way from the drop-down
menu. Then, add a third block and mark all
three variables. Open the drop-down menu and
Chapter 20. From SPSS to jamovi
click All 3 way.
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CHAPTER

TWENTYONE

JAMOVI AND R

There are a few ways to use jamovi and R together. The first is to use of the Rj Editor ( 181), a module
available from the jamovi library that allows executing R code from within jamovi.
Another is to use the jmv R package ( 183) which makes all the analyses included with jamovi available from an interactive R session (such as in RStudio). jamovi can also provide the equivalent R
syntax for each analysis with Syntax mode ( 13).
Sebastian Jentschke (https://www.uib.no/en/persons/Sebastian.Jentschke)

21.1 Rj Editor for jamovi
21.1.1 Preparation
First you have to install the module ( 53) Rj from the jamovi library. This will create a ńRż-icon in
the icon bar.

21.1.2 Running R commands
Click on the ńRż icon
and select ńRj Editorż.

This opens an input field on the left side where you can use R commands.

You can access your dataset with the variable data. The first line selects the first three columns of
your dataset. Alternatively, you can use variable names as shown in the second line.
181
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summary(data[1:3])
summary(data[, c('var1', 'var2', 'var3')])
Sometimes you may need a list of all your variables as a string (e.g., for using them in connection with
functions in Computed variables). Of course, you can as well restrict the variables with the column
indices as in the command above. Afterwards, you can just copy the output text and insert it, e.g.,
into a function for a computed variable: SUM([insert text you copied])
paste0(names(data), collapse = ", ")
paste0(names(data[2:10]), collapse = ", ")
But you can also use functions from R libraries (e.g., stats). When doing so, you may have to
precede these functions with the name of the package and ::.
stats::aggregate(as.numeric(data[, 'var1']), list(data[, 'gender
,→']), mean)
It may take a bit of time to figure out how to use these functions, especially to discover, e.g., which
format is required for the data matrices you use as input to functions (those may need to be converted
to numbers with as.numeric() or to a list with list). But once you managed that, you have
unlimited access to (almost) any kind of statistical analysis you can imagine.
The following commands permits you to list the wealth of R libraries included with jamovi and Rj:
sort(rownames(installed.packages()))
Some of these libraries are especially interesting:
• stats (https://www.rdocumentation.org/packages/stats) to get access to a wealth of statistical
analyses (e.g., stats::glm for fitting Generalized Linear Models or stats:kmeans for
running k-means cluster analyses)
• lme4 (https://www.rdocumentation.org/packages/lme4) to calculate Linear, Generalized Linear, and Nonlinear mixed modells
• MASS (https://www.rdocumentation.org/packages/MASS) implements analyses from Venables
og Ripleys famous book ńModern Applied Statistics with Sż (which includes, e.e., linear discriminant analysis MASS::lda)
• lavaan (https://www.rdocumentation.org/packages/lavaan) to run a wide range of analyses
with latent variables (incl. confirmatory factor analysis, structural equation modeling and latent
growth curve models)
• BayesFactor (https://www.rdocumentation.org/packages/BayesFactor) to run several types
of Bayes-analyses to complement your ńclassicalż (frequentist) statistics (e.g. the Bayesequivalent of the t-test; NB: it is of course easier to use the jamovi-module ńjsqż for that)
• cluster (https://www.rdocumentation.org/packages/cluster) to run several types of cluster
analyses
• ggplot2 (https://www.rdocumentation.org/packages/ggplot2) to produce (almost) any type of
fancy figures (http://www.ggplot2-exts.org/gallery/) you can imagine
• there are also several of Hadley Wickhams tidyverse (https://www.tidyverse.org)
libraries included,
e.g.,
dplyr (https://www.rdocumentation.org/packages/dplyr),
stringr
(https://www.rdocumentation.org/packages/stringr)
or
tidyselect
(https://www.rdocumentation.org/packages/tidyselect)
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21.1.3 Switch between R-versions

Per default, Rj uses the R-installation that is included with jamovi. For most circumstances this will be sufficient (not the least because quite a wealth of libraries is
included; see above). However, there might be occasions where you would like to
use the R-installation on your computer; typically, if you want to use libraries that
are not included in jamovis R-version. To do this, click on the cogwheel symbol
in the top-right corner of the Rj-input field. A window opens where you can set
whether you would like to use jamovis R version (ńjamovi Rż in the dropdown box
at the bottom) or your systems R version (ńSystem Rż). Please note that this option
this option is not available for certain system-and-R-version-combinations (e.g., R
> 3.4 on Linux).
Sebastian Jentschke, Jonathon Love (https://www.jamovi.org)

21.2 The jmv R package
For some use-cases, its preferable to be able use the jamovi (https://www.jamovi.org) analyses from
R. This is provided by the jmv R package. All the analyses included with jamovi are available from
within R using this package.

21.2.1 Preparation
jmv is available from CRAN (a central repository for publicly available R-packages). To install jmv,
open an interactive R session (e.g. RStudio) and type the first line (the >-mark at the begin of the line
is the input-mark of R and must not be copied / typed). The package haven is required if you want
to read or write files from SPSS, SAS or Stata and can be installed using the second line. If you want
to read and write jamovis .omv-files you can use the package jmvReadWrite which is installed
using the third line. Finally, the package jmvconnect permits to access data sets that you currently
have opened in jamovi.
More information about the analyses jmv provides or how to use the other packages is available using
the R help system, or from the overview below.
install.packages('jmv')
install.packages('haven')
install.packages('jmvReadWrite')
install.packages('jmvconnect')

21.2.2 Use of jamovi syntax in R
For examples on how to use jmv, jamovi can be placed in Syntax mode. Syntax mode produces the R
syntax required to reproduce jamovi analyses in R. To enable the syntax mode, you have to click the
properties icon () in the top-right corner. Set a tick at syntax mode in the properties window. Close
the properties with the arrow-icon (→) at the top-right.

21.2. The jmv R package
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The main window changes to text mode and you can run analyses and afterwards rightclick on the command the appears at the top of each analysis to export or copy the syntax.

Alternatively, you can write syntax directly. To do this, open R or RStudio and type the command in
the first line. As during the description of the installation above; the second line is required if you
want to use files from SPSS, SAS or Stata; the third line for reading jamovis .omv-files, and the
fourth line for directly accessing datasets opened in your current jamovi-session.
library(jmv)
library(haven)
library(jmvReadWrite)
library(jmvconnect)
Afterwards, you are ready to analyze your data. Typically, you have to load a dataset first. Use the
first line if you have a .csv-file (sep has to be set to the separator between data cells, e.g., ,, ;,
etc.), the second line for loading SPSS .sav-files, or the third line for loading jamovis .omv-files:
data = read.csv("data.csv", header = TRUE, sep = ",")
()
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()

data = haven::read_sav("data.sav")
data = jmvReadWrite::read_omv("data.omv")
With those data, you can run whatever analysis you like (you will find an overview of available
functions a little further down on this page). For example, to run a simple descriptive-statisticsanalysis:
jmv::descriptives(data = data, vars = vars(var1, var2))
or for a correlation between to variables (quite basic in the first and more advanced - adding two nonparametric measures and plots - in the second line; please note that pearson = TRUE is not necessary
because it is the default):
jmv::corrMatrix(data = data, vars = vars(var1, var2), pearson =
,→TRUE, sig = TRUE)
jmv::corrMatrix(data = data, vars = vars(var1, var2), spearman =
,→TRUE, kendall = TRUE, sig = FALSE, flag = TRUE, plots = TRUE)

21.2.3 Overview over the analyses contained in jmv
Exploration
Ravi Selker, Jonathon Love, Damian Dropmann (https://www.jamovi.org)
Descriptives (descriptives)
Description
Descriptives are an assortment of summarising statistics, and visualizations which allow
exploring the shape and distribution of data. It is good practice to explore your data with
descriptives before proceeding to more formal tests.
Usage
descriptives(
data,
vars,
splitBy = NULL,
freq = FALSE,
hist = FALSE,
dens = FALSE,
bar = FALSE,
barCounts = FALSE,
box = FALSE,
violin = FALSE,
dot = FALSE,
dotType = "jitter",
qq = FALSE,
n = TRUE,
missing = TRUE,
mean = TRUE,
median = TRUE,
()
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185

Documentation for jamovi

()

mode = FALSE,
sum = FALSE,
sd = TRUE,
variance = FALSE,
range = FALSE,
min = TRUE,
max = TRUE,
se = FALSE,
skew = FALSE,
kurt = FALSE,
sw = FALSE,
quart = FALSE,
pcEqGr = FALSE,
pcNEqGr = 4,
formula
)

Arguments

data
vars
splitBy
freq
hist
dens
bar
barCounts
box
violin
dot
dotType
qq
n
missing
mean
median
mode
sum
sd
variance
range
min
max
se
skew
kurt
sw
quart
pcEqGr
pcNEqGr
formula
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the data as a data frame
a vector of strings naming the variables of interest in data
a vector of strings naming the variables used to split vars
TRUE or FALSE (default), provide frequency tables (nominal, ordinal variables only)
TRUE or FALSE (default), provide histograms (continuous variables only)
TRUE or FALSE (default), provide density plots (continuous variables only)
TRUE or FALSE (default), provide bar plots (nominal, ordinal variables only)
TRUE or FALSE (default), add counts to the bar plots
TRUE or FALSE (default), provide box plots (continuous variables only)
TRUE or FALSE (default), provide violin plots (continuous variables only)
TRUE or FALSE (default), provide dot plots (continuous variables only)
.
TRUE or FALSE (default), provide Q-Q plots (continuous variables only)
TRUE (default) or FALSE, provide the sample size
TRUE (default) or FALSE, provide the number of missing values
TRUE (default) or FALSE, provide the mean
TRUE (default) or FALSE, provide the median
TRUE or FALSE (default), provide the mode
TRUE or FALSE (default), provide the sum
TRUE (default) or FALSE, provide the standard deviation
TRUE or FALSE (default), provide the variance
TRUE or FALSE (default), provide the range
TRUE or FALSE (default), provide the minimum
TRUE or FALSE (default), provide the maximum
TRUE or FALSE (default), provide the standard error
TRUE or FALSE (default), provide the skewness
TRUE or FALSE (default), provide the kurtosis
TRUE or FALSE (default), provide Shapiro-Wilk p-value
TRUE or FALSE (default), provide quartiles
TRUE or FALSE (default), provide quantiles
an integer (default: 4) specifying the number of equal groups
(optional) the formula to use, see the examples
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Output
A results object containing:
results$descriptives
results$frequencies

a table of the descriptive statistics
an array of frequency tables

Tables can be converted to data frames with asDF or as.data.frame(). For example:
results$descriptives$asDF
as.data.frame(results$descriptives)
Examples
data('mtcars')
dat <- mtcars
# frequency tables can be provided for factors
dat$gear <- as.factor(dat$gear)
descriptives(dat, vars = vars(mpg, cyl, disp, gear), freq = TRUE)
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#

DESCRIPTIVES
Descriptives
------------------------------------------mpg
cyl
disp
gear
------------------------------------------N
32
32
32
32
Missing
0
0
0
0
Mean
20.1
6.19
231
3.69
Median
19.2
6.00
196
4.00
Minimum
10.4
4.00
71.1
3
Maximum
33.9
8.00
472
5
-------------------------------------------

FREQUENCIES
Frequencies of gear
-------------------Levels
Counts
-------------------3
15
4
12
5
5
--------------------

# spliting by a variable
descriptives(formula = disp + mpg ~ cyl, dat,
median=F, min=F, max=F, n=F, missing=F)
# providing histograms
()
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()

descriptives(formula = mpg ~ cyl, dat, hist=T,
median=F, min=F, max=F, n=F, missing=F)
# splitting by multiple variables
descriptives(formula = mpg ~ cyl:gear, dat,
median=F, min=F, max=F, missing=F)

T-Tests
Ravi Selker, Jonathon Love, Damian Dropmann (https://www.jamovi.org)
Independent Samples T-Test (ttestIS)
Description
The Students Independent samples t-test (sometimes called a two-samples t-test) is used
to test the null hypothesis that two groups have the same mean. A low p-value suggests
that the null hypothesis is not true, and therefore the group means are different.
Usage
ttestIS(
data,
vars,
group,
students = TRUE,
bf = FALSE,
bfPrior = 0.707,
welchs = FALSE,
mann = FALSE,
hypothesis = "different",
norm = FALSE,
qq = FALSE,
eqv = FALSE,
meanDiff = FALSE,
ci = FALSE,
ciWidth = 95,
effectSize = FALSE,
ciES = FALSE,
ciWidthES = 95,
desc = FALSE,
plots = FALSE,
miss = "perAnalysis",
formula
)
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Arguments

data the data as a data frame
vars the dependent variables (not necessary when using a formula, see the examples)
group the grouping variable with two levels (not necessary when using a formula, see the examples)
students
TRUE (default) or FALSE, perform Students t-tests
bf
TRUE or FALSE (default), provide Bayes factors
bfPrior
a number between 0.5 and 2 (default 0.707), the prior width to use in calculating Bayes
factors
welchsTRUE or FALSE (default), perform Welchs t-tests
mann TRUE or FALSE (default), perform Mann-Whitney U tests
hypothesis
'different' (default), 'oneGreater' or 'twoGreater', the alternative hypothesis; group 1 different to group 2, group 1 greater than group 2, and group 2 greater
than group 1 respectively
norm TRUE or FALSE (default), perform Shapiro-Wilk tests of normality
qq
TRUE or FALSE (default), provide Q-Q plots of residuals
eqv
TRUE or FALSE (default), perform Levenes tests for homogeneity of variances
meanDiff
TRUE or FALSE (default), provide means and standard errors
ci
TRUE or FALSE (default), provide confidence intervals
ciWidth
a number between 50 and 99.9 (default: 95), the width of confidence intervals
effectSize
TRUE or FALSE (default), provide effect sizes
ciES TRUE or FALSE (default), provide confidence intervals for the effect-sizes
ciWidthES
a number between 50 and 99.9 (default: 95), the width of confidence intervals for the
effect sizes
desc TRUE or FALSE (default), provide descriptive statistics
plots TRUE or FALSE (default), provide descriptive plots
miss 'perAnalysis' or 'listwise', how to handle missing values; 'perAnalysis'
excludes missing values for individual dependent variables, 'listwise' excludes a
row from all analyses if one of its entries is missing.
formula
(optional) the formula to use, see the examples

Details
The Students independent t-test assumes that the data from each group are from a normal
distribution, and that the variances of these groups are equal. If unwilling to assume the
groups have equal variances, the Welchs t-test can be used in its place. If one is additionally unwilling to assume the data from each group are from a normal distribution, the
non-parametric Mann-Whitney U test can be used instead (however, note that the MannWhitney U test has a slightly different null hypothesis; that the distributions of each group
are equal).
Output
A results object containing:
results$ttest
results$assum$norm
results$assum$eqv
results$desc
results$plots

a table containing the t-test results
a table containing the normality tests
a table containing the homogeneity of variances tests
a table containing the group descriptives
an array of groups of plots

Tables can be converted to data frames with asDF or as.data.frame(). For example:
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results$ttest$asDF
as.data.frame(results$ttest)
Examples
data('ToothGrowth')
ttestIS(formula = len ~ supp, data = ToothGrowth)
#
#
#
#
#
#
#
#
#
#

INDEPENDENT SAMPLES T-TEST
Independent Samples T-Test
---------------------------------------------------statistic
df
p
---------------------------------------------------len
Student's t
1.92
58.0
0.060
----------------------------------------------------

Ravi Selker, Jonathon Love, Damian Dropmann (https://www.jamovi.org)
Paired Samples T-Test (ttestPS)
Description
The Students paired samples t-test (sometimes called a dependent-samples t-test) is used
to test the null hypothesis that the difference between pairs of measurements is equal to
zero. A low p-value suggests that the null hypothesis is not true, and that the difference
between the measurement pairs is not zero.
Usage
ttestPS(
data,
pairs,
students = TRUE,
bf = FALSE,
bfPrior = 0.707,
wilcoxon = FALSE,
hypothesis = "different",
norm = FALSE,
qq = FALSE,
meanDiff = FALSE,
ci = FALSE,
ciWidth = 95,
effectSize = FALSE,
ciES = FALSE,
ciWidthES = 95,
desc = FALSE,
plots = FALSE,
miss = "perAnalysis"
)

190

Chapter 21. jamovi and R

Documentation for jamovi

Arguments

data the data as a data frame
pairs a list of lists specifying the pairs of measurement in data
students
TRUE (default) or FALSE, perform Students t-tests
bf
TRUE or FALSE (default), provide Bayes factors
bfPrior
a number between 0.5 and 2 (default 0.707), the prior width to use in calculating Bayes
factors
wilcoxon
TRUE or FALSE (default), perform Wilcoxon signed rank tests
hypothesis
'different' (default), 'oneGreater' or 'twoGreater', the alternative hypothesis; measure 1 different to measure 2, measure 1 greater than measure 2, and measure 2 greater than measure 1 respectively
norm TRUE or FALSE (default), perform Shapiro-wilk normality tests
qq
TRUE or FALSE (default), provide a Q-Q plot of residuals
meanDiff
TRUE or FALSE (default), provide means and standard errors
ci
TRUE or FALSE (default), provide confidence intervals
ciWidth
a number between 50 and 99.9 (default: 95), the width of confidence intervals
effectSize
TRUE or FALSE (default), provide effect sizes
ciES TRUE or FALSE (default), provide confidence intervals for the effect-sizes
ciWidthES
a number between 50 and 99.9 (default: 95), the width of confidence intervals for the
effect sizes
desc TRUE or FALSE (default), provide descriptive statistics
plots TRUE or FALSE (default), provide descriptive plots
miss 'perAnalysis' or 'listwise', how to handle missing values; 'perAnalysis'
excludes missing values for individual dependent variables, 'listwise' excludes a
row from all analyses if one of its entries is missing

Details
The Students paired samples t-test assumes that pair differences follow a normal distribution – in the case that one is unwilling to assume this, the non-parametric Wilcoxon
signed-rank can be used in its place (however, note that the Wilcoxon signed-rank has a
slightly different null hypothesis; that the two groups of measurements follow the same
distribution).
Output
A results object containing:
results$ttest
results$norm
results$desc
results$plots

a table containing the t-test results
a table containing the normality test results
a table containing the descriptives
an array of the descriptive plots

Tables can be converted to data frames with asDF or as.data.frame(). For example:
results$ttest$asDF
as.data.frame(results$ttest)
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Examples
data('bugs', package = 'jmv')
ttestPS(bugs, pairs = list(
list(i1 = 'LDLF', i2 = 'LDHF')))
#
#
#
#
#
#
#
#
#
#

PAIRED SAMPLES T-TEST
Paired Samples T-Test
-------------------------------------------------------------statistic
df
p
-------------------------------------------------------------LDLF
LDHF
Student's t
-6.65
90.0
< .001
--------------------------------------------------------------

Ravi Selker, Jonathon Love, Damian Dropmann (https://www.jamovi.org)
One Sample T-Test
(ttestOneS)
Description
The Students One-sample t-test is used to test the null hypothesis that the true mean is
equal to a particular value (typically zero). A low p-value suggests that the null hypothesis
is not true, and therefore the true mean must be different from the test value.
Usage
ttestOneS(
data,
vars,
students = TRUE,
bf = FALSE,
bfPrior = 0.707,
wilcoxon = FALSE,
testValue = 0,
hypothesis = "dt",
norm = FALSE,
qq = FALSE,
meanDiff = FALSE,
ci = FALSE,
ciWidth = 95,
effectSize = FALSE,
ciES = FALSE,
ciWidthES = 95,
desc = FALSE,
plots = FALSE,
miss = "perAnalysis",
mann = FALSE
)
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Arguments

data the data as a data frame
vars a vector of strings naming the variables of interest in data
students
TRUE (default) or FALSE, perform Students t-tests
bf
TRUE or FALSE (default), provide Bayes factors
bfPrior
a number between 0.5 and 2.0 (default 0.707), the prior width to use in calculating Bayes
factors
wilcoxon
TRUE or FALSE (default), perform Wilcoxon signed rank tests
testValue
a number specifying the value of the null hypothesis
hypothesis
'dt' (default), 'gt' or 'lt', the alternative hypothesis; different to testValue,
greater than testValue, and less than testValue respectively
norm TRUE or FALSE (default), perform Shapiro-wilk tests of normality
qq
TRUE or FALSE (default), provide a Q-Q plot of residuals
meanDiff
TRUE or FALSE (default), provide means and standard deviations
ci
TRUE or FALSE (default), provide confidence intervals for the mean difference
ciWidth
a number between 50 and 99.9 (default: 95), the width of confidence intervals
effectSize
TRUE or FALSE (default), provide Cohens d effect sizes
ciES TRUE or FALSE (default), provide confidence intervals for the effect-sizes
ciWidthES
a number between 50 and 99.9 (default: 95), the width of confidence intervals for the
effect sizes
desc TRUE or FALSE (default), provide descriptive statistics
plots TRUE or FALSE (default), provide descriptive plots
miss 'perAnalysis' or 'listwise', how to handle missing values; 'perAnalysis'
excludes missing values for individual dependent variables, 'listwise' excludes a
row from all analyses if one of its entries is missing.

Details
The Students One-sample t-test assumes that the data are from a normal distribution – in
the case that one is unwilling to assume this, the non-parametric Wilcoxon signed-rank can
be used in its place (however, note that the Wilcoxon signed-rank has a slightly different
null hypothesis; that the median is equal to the test value).
Output
A results object containing:
results$ttest
results$normality
results$descriptives
results$plots
results$qq

a table containing the t-test results
a table containing the normality test results
a table containing the descriptives
an image of the descriptive plots
an array of Q-Q plots

Tables can be converted to data frames with asDF or as.data.frame(). For example:
results$ttest$asDF
as.data.frame(results$ttest)
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Examples
data('ToothGrowth')
ttestOneS(ToothGrowth, vars = vars(len, dose))
#
#
#
#
#
#
#
#
#
#
#

ONE SAMPLE T-TEST
One Sample T-Test
-----------------------------------------------------statistic
df
p
-----------------------------------------------------len
Student's t
19.1
59.0
< .001
dose
Student's t
14.4
59.0
< .001
------------------------------------------------------

ANOVA
Ravi Selker, Jonathon Love, Damian Dropmann (https://www.jamovi.org)
One-Way ANOVA (anovaOneW)
Description
The Analysis of Variance (ANOVA) is used to explore the relationship between a continuous dependent variable, and one or more categorical explanatory variables. This One-Way ANOVA is a
simplified version of the normal ANOVA, allowing only a single explanatory factor, however also
providing a Welchs ANOVA. The Welchs ANOVA has the advantage that it need not assume that the
variances of all groups are equal.
Usage
anovaOneW(
data,
deps,
group,
welchs = TRUE,
fishers = FALSE,
miss = "perAnalysis",
desc = FALSE,
descPlot = FALSE,
norm = FALSE,
qq = FALSE,
eqv = FALSE,
phMethod = "none",
phMeanDif = TRUE,
phSig = TRUE,
phTest = FALSE,
phFlag = FALSE,
formula
)
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Arguments

data the data as a data frame
deps a string naming the dependent variables in data
groupa string naming the grouping or independent variable in data
welchs
TRUE (default) or FALSE, perform Welchs one-way ANOVA which does not assume equal
variances
fishers
TRUE or FALSE (default), perform Fishers one-way ANOVA which assumes equal variances
miss 'perAnalysis' or 'listwise', how to handle missing values; 'perAnalysis'
excludes missing values for individual dependent variables, 'listwise' excludes a row
from all analyses if one of its entries is missing.
desc TRUE or FALSE (default), provide descriptive statistics
descPlot
TRUE or FALSE (default), provide descriptive plots
norm TRUE or FALSE (default), perform Shapiro-Wilk test of normality
qq
TRUE or FALSE (default), provide a Q-Q plot of residuals
eqv TRUE or FALSE (default), perform Levenes test for homogeneity of variances
phMethod
'none', 'gamesHowell' or 'tukey', which post-hoc tests to provide; 'none'
shows no post-hoc tests, shows 'gamesHowell' shows Games-Howell post-hoc tests
where no equivalence of variances is assumed, and 'tukey' Tukey post-hoc tests where
equivalence of variances is assumed
phMeanDif
TRUE (default) or FALSE, provide mean differences for post-hoc tests
phSigTRUE (default) or FALSE, provide significance levels for post-hoc tests
phTest
TRUE or FALSE (default), provide test results (t-value and degrees of freedom) for posthoc tests
phFlag
TRUE or FALSE (default), flag significant post-hoc comparisons
formula
(optional) the formula to use, see the examples

Details
For convenience, this method allows specifying multiple dependent variables, resulting in
multiple independent tests.
Note that the Welchs ANOVA is the same procedure as the Welchs independent samples
t-test.
Output
A results object containing:
results$anova
results$desc
results$assump$norm
results$assump$eqv
results$plots
results$postHoc

a table of the test results
a table containing the group descriptives
a table containing the normality tests
a table of homogeneity of variances tests
an array of groups of plots
an array of post-hoc tables

Tables can be converted to data frames with asDF or as.data.frame(). For example:
results$anova$asDF
as.data.frame(results$anova)
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Examples
data('ToothGrowth')
dat <- ToothGrowth
dat$dose <- factor(dat$dose)
anovaOneW(formula = len ~ dose, data = dat)
#
#
#
#
#
#
#
#
#
#

ONE-WAY ANOVA
One-Way ANOVA (Welch's)
---------------------------------------F
df1
df2
p
---------------------------------------len
68.4
2
37.7
< .001
----------------------------------------

Ravi Selker, Jonathon Love, Damian Dropmann (https://www.jamovi.org)
ANOVA (ANOVA)
Description
The Analysis of Variance (ANOVA) is used to explore the relationship between a continuous dependent variable, and one or more categorical explanatory variables.
Usage
ANOVA(
data,
dep,
factors = NULL,
effectSize = NULL,
modelTest = FALSE,
modelTerms = NULL,
ss = "3",
homo = FALSE,
norm = FALSE,
qq = FALSE,
contrasts = NULL,
postHoc = NULL,
postHocCorr = list("tukey"),
postHocES = list(),
postHocEsCi = FALSE,
postHocEsCiWidth = 95,
emMeans = list(list()),
emmPlots = TRUE,
emmPlotData = FALSE,
emmPlotError = "ci",
emmTables = FALSE,
emmWeights = TRUE,
ciWidthEmm = 95,
()
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()

formula
)

Arguments

the data as a data frame
the dependent variable from data, variable must be numeric (not necessary when
providing a formula, see examples)
factors
the explanatory factors in data (not necessary when providing a formula, see examples)
effectSizeone or more of 'eta', 'partEta', or 'omega'; use eta2 , partial eta2 , and
omega2 effect sizes, respectively
modelTest TRUE or FALSE (default); perform an overall model test
modelTermsa formula describing the terms to go into the model (not necessary when providing
a formula, see examples)
ss
'1', '2' or '3' (default), the sum of squares to use
homo
TRUE or FALSE (default), perform homogeneity tests
norm
TRUE or FALSE (default), perform Shapiro-Wilk tests of normality
qq
TRUE or FALSE (default), provide a Q-Q plot of residuals
contrasts a list of lists specifying the factor and type of contrast to use, one of
'deviation', 'simple', 'difference', 'helmert', 'repeated' or
'polynomial'
postHoc
a formula containing the terms to perform post-hoc tests on (see the examples)
postHocCorr
one or more of 'none', 'tukey', 'scheffe', 'bonf', or 'holm'; provide
no, Tukey, Scheffe, Bonferroni, and Holm Post Hoc corrections respectively
postHocES a possible value of 'd'; provide Cohens d measure of effect size for the post-hoc
tests
postHocEsCi
TRUE or FALSE (default), provide confidence intervals for the post-hoc effect sizes
postHocEsCiWidth
a number between 50 and 99.9 (default: 95), the width of confidence intervals for
the post-hoc effect sizes
emMeans
a formula containing the terms to estimate marginal means for (see the examples)
emmPlots TRUE (default) or FALSE, provide estimated marginal means plots
emmPlotData
TRUE or FALSE (default), plot the data on top of the marginal means
emmPlotError
'none', 'ci' (default), or 'se'. Use no error bars, use confidence intervals, or
use standard errors on the marginal mean plots, respectively
emmTables TRUE or FALSE (default), provide estimated marginal means tables
emmWeightsTRUE (default) or FALSE, weigh each cell equally or weigh them according to the
cell frequency
ciWidthEmma number between 50 and 99.9 (default: 95) specifying the confidence interval
width for the estimated marginal means
formula
(optional) the formula to use, see the examples
data
dep

Details
ANOVA assumes that the residuals are normally distributed, and that the variances of
all groups are equal. If one is unwilling to assume that the variances are equal, then a
Welchs test can be used instead (however, the Welchs test does not support more than one
explanatory factor). Alternatively, if one is unwilling to assume that the data is normally
distributed, a non-parametric approach (such as Kruskal-Wallis) can be used.
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Output
A results object containing:
results$main
results$model
results$assump$homo
results$assump$norm
results$assump$qq
results$contrasts
results$postHoc
results$emm

a table of ANOVA results
the underlying aov object
a table of homogeneity tests
a table of normality tests
a q-q plot
an array of contrasts tables
an array of post-hoc tables
an array of the estimated marginal means plots + tables

Tables can be converted to data frames with asDF or as.data.frame(). For example:
results$main$asDF
as.data.frame(results$main)
Examples
data('ToothGrowth')
ANOVA(formula = len ~ dose * supp, data = ToothGrowth)
#
#
#
#
#

ANOVA

ANOVA
---------------------------------------------------------------,→------#
Sum of Squares
df
Mean Square
F
p
# ---------------------------------------------------------------,→------#
dose
2426
2
1213.2
92.00
,→< .001
#
supp
205
1
205.4
15.57
,→< .001
#
dose:supp
108
2
54.2
4.11
,→0.022
#
Residuals
712
54
13.2
# ---------------------------------------------------------------,→------#
ANOVA(
formula = len ~ dose * supp,
data = ToothGrowth,
emMeans = ~ supp + dose:supp, # est. marginal means for supp
,→and dose:supp
emmPlots = TRUE,
# produce plots of those
,→marginal means
emmTables = TRUE)
# produce tables of those
,→marginal means
Ravi Selker, Jonathon Love, Damian Dropmann (https://www.jamovi.org)
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Repeated Measures ANOVA
(anovaRM)
Description
The Repeated Measures ANOVA is used to explore the relationship between a continuous
dependent variable and one or more categorical explanatory variables, where one or more
of the explanatory variables are within subjects (where multiple measurements are from
the same subject). Additionally, this analysis allows the inclusion of covariates, allowing
for repeated measures ANCOVAs as well.
Usage
anovaRM(
data,
rm = list(list(label = "RM Factor 1", levels = list("Level 1",
,→"Level 2"))),
rmCells = NULL,
bs = NULL,
cov = NULL,
effectSize = NULL,
depLabel = "Dependent",
rmTerms = NULL,
bsTerms = NULL,
ss = "3",
spherTests = FALSE,
spherCorr = list("none"),
leveneTest = FALSE,
contrasts = NULL,
postHoc = NULL,
postHocCorr = list("tukey"),
emMeans = list(list()),
emmPlots = TRUE,
emmTables = FALSE,
emmWeights = TRUE,
ciWidthEmm = 95,
emmPlotData = FALSE,
emmPlotError = "ci",
groupSumm = FALSE
)
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Arguments

the data as a data frame
a list of lists, where each list describes the label (as a string) and the levels (as
vector of strings) of a particular repeated measures factor
rmCellsa list of lists, where each list decribes a repeated measure (as a string) from data
defined as measure and the particular combination of levels from rm that it belongs
to (as a vector of strings) defined as cell
bs
a vector of strings naming the between subjects factors from data
cov
a vector of strings naming the covariates from data. Variables must be numeric
effectSize
one or more of 'eta', 'partEta', or 'omega'; use eta2 , partial eta2 , and omega2
effect sizes, respectively
depLabel
a string (default: Dependent) describing the label used for the dependent variable
throughout the analysis
rmTermsa list of character vectors describing the repeated measures terms to go into the model
bsTermsa list of character vectors describing the between subjects terms to go into the model
ss
'2' or '3' (default), the sum of squares to use
spherTests
TRUE or FALSE (default), perform sphericity tests
spherCorr
one or more of 'none' (default), 'GG', or 'HF'; use no p-value correction, the
Greenhouse-Geisser p-value correction, and the Huynh-Feldt p-value correction for
shericity, respectively
leveneTest
TRUE or FALSE (default), test for homogeneity of variances (i.e., Levenes test)
contrasts
in development
postHoca list of character vectors describing the post-hoc tests that need to be computed
postHocCorr
one or more of 'none', 'tukey' (default), 'scheffe', 'bonf', or 'holm'; use
no, Tukey, Scheffe, Bonferroni and Holm posthoc corrections, respectively
emMeansa list of lists specifying the variables for which the estimated marginal means need to
be calculate. Supports up to three variables per term.
emmPlots
TRUE (default) or FALSE, provide estimated marginal means plots
emmTables
TRUE or FALSE (default), provide estimated marginal means tables
emmWeights
TRUE (default) or FALSE, weigh each cell equally or weigh them according to the cell
frequency
ciWidthEmm
a number between 50 and 99.9 (default: 95) specifying the confidence interval width
for the estimated marginal means
emmPlotData
TRUE or FALSE (default), plot the data on top of the marginal means
emmPlotError
'none', 'ci' (default), or 'se'. Use no error bars, use confidence intervals, or use
standard errors on the marginal mean plots, respectively
groupSumm
TRUE or FALSE (default), report a summary of the different groups
data
rm

Details
This analysis requires that the data be in wide format, where each row represents a subject (as opposed
to long format, where each measurement of the dependent variable is represented as a row).
A non-parametric equivalent of the repeated measures ANOVA also exists; the Friedman test. However, it has the limitation of only being able to test a single factor.
Output
A results object containing:
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results$rmTable
results$bsTable
results$assump$spherTable
results$assump$leveneTable
results$contrasts
results$postHoc
results$emm
results$groupSummary

a table
a table
a table
a table
an array of tables
an array of tables
an array of the estimated marginal means plots + tables
a summary of the groups

Tables can be converted to data frames with asDF or as.data.frame(). For example:
results$rmTable$asDF
as.data.frame(results$rmTable)
Examples
data('bugs', package = 'jmv')
anovaRM(
data = bugs,
rm = list(
list(
label = 'Frightening',
levels = c('Low', 'High'))),
rmCells = list(
list(
measure = 'LDLF',
cell = 'Low'),
list(
measure = 'LDHF',
cell = 'High')),
rmTerms = list(
'Frightening'))
#
#
#
#
#

REPEATED MEASURES ANOVA

Within Subjects Effects
---------------------------------------------------------------,→------#
Sum of Squares
df
Mean Square
F
p
# ---------------------------------------------------------------,→------#
Frightening
126
1
126.11
44.2
,→< .001
#
Residual
257
90
2.85
# ---------------------------------------------------------------,→------#
Note. Type 3 Sums of Squares
#
#
#
# Between Subjects Effects
# ---------------------------------------------------------------,→()
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()

#
#

Sum of Squares
df
Mean Square
F
p
---------------------------------------------------------------,→#
Residual
954
90
10.6
# ---------------------------------------------------------------,→#
Note. Type 3 Sums of Squares
#
Ravi Selker, Jonathon Love, Damian Dropmann (https://www.jamovi.org)
ANCOVA (ancova)
Description
The Analysis of Covariance (ANCOVA) is used to explore the relationship between a
continuous dependent variable, one or more categorical explanatory variables, and one or
more continuous explanatory variables (or covariates). It is essentially the same analysis
as ANOVA, but with the addition of covariates.
Usage
ancova(
data,
dep,
factors = NULL,
covs = NULL,
effectSize = NULL,
modelTest = FALSE,
modelTerms = NULL,
ss = "3",
homo = FALSE,
norm = FALSE,
qq = FALSE,
contrasts = NULL,
postHoc = NULL,
postHocCorr = list("tukey"),
postHocES = list(),
postHocEsCi = FALSE,
postHocEsCiWidth = 95,
emMeans = list(list()),
emmPlots = TRUE,
emmPlotData = FALSE,
emmPlotError = "ci",
emmTables = FALSE,
emmWeights = TRUE,
ciWidthEmm = 95,
formula
)
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Arguments

the data as a data frame
the dependent variable from data, variable must be numeric (not necessary when
providing a formula, see examples)
factors
the explanatory factors in data (not necessary when providing a formula, see examples)
covs
the explanatory covariates (not necessary when providing a formula, see examples)
effectSizeone or more of 'eta', 'partEta', or 'omega'; use eta2 , partial eta2 , and
omega2 effect sizes, respectively
modelTest TRUE or FALSE (default); perform an overall model test
modelTermsa formula describing the terms to go into the model (not necessary when providing
a formula, see examples)
ss
'1', '2' or '3' (default), the sum of squares to use
homo
TRUE or FALSE (default), perform homogeneity tests
norm
TRUE or FALSE (default), perform Shapiro-Wilk tests of normality
qq
TRUE or FALSE (default), provide a Q-Q plot of residuals
contrasts a list of lists specifying the factor and type of contrast to use, one of
'deviation', 'simple', 'difference', 'helmert', 'repeated' or
'polynomial'
postHoc
a formula containing the terms to perform post-hoc tests on (see the examples)
postHocCorr
one or more of 'none', 'tukey', 'scheffe', 'bonf', or 'holm'; provide
no, Tukey, Scheffe, Bonferroni, and Holm Post Hoc corrections respectively
postHocES a possible value of 'd'; provide Cohens d measure of effect size for the post-hoc
tests
postHocEsCi
TRUE or FALSE (default), provide confidence intervals for the post-hoc effect sizes
postHocEsCiWidth
a number between 50 and 99.9 (default: 95), the width of confidence intervals for
the post-hoc effect sizes
emMeans
a formula containing the terms to estimate marginal means for (see the examples)
emmPlots TRUE (default) or FALSE, provide estimated marginal means plots
emmPlotData
TRUE or FALSE (default), plot the data on top of the marginal means
emmPlotError
'none', 'ci' (default), or 'se'. Use no error bars, use confidence intervals, or
use standard errors on the marginal mean plots, respectively
emmTables TRUE or FALSE (default), provide estimated marginal means tables
emmWeightsTRUE (default) or FALSE, weigh each cell equally or weigh them according to the
cell frequency
ciWidthEmma number between 50 and 99.9 (default: 95) specifying the confidence interval
width for the estimated marginal means
formula
(optional) the formula to use, see the examples
data
dep

Output
A results object containing:
results$main
results$model
results$assump$homo
results$assump$norm
results$assump$qq
results$contrasts
results$postHoc
results$emm

a table of ANCOVA results
The underlying aov object
a table of homogeneity tests
a table of normality tests
a q-q plot
an array of contrasts tables
an array of post-hoc tables
an array of the estimated marginal means plots + tables

Tables can be converted to data frames with asDF or as.data.frame(). For example:
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results$main$asDF
as.data.frame(results$main)
Examples
data('ToothGrowth')
ancova(formula = len ~ supp + dose, data = ToothGrowth)
#
#
#
#
#

ANCOVA

ANCOVA
---------------------------------------------------------------,→------#
Sum of Squares
df
Mean Square
F
p
# ---------------------------------------------------------------,→------#
supp
205
1
205.4
11.4
,→0.001
#
dose
2224
1
2224.3
124.0
,→< .001
#
Residuals
1023
57
17.9
# ---------------------------------------------------------------,→------#
ancova(
formula = len ~ supp + dose,
data = ToothGrowth,
postHoc = ~ supp,
emMeans = ~ supp)
Ravi Selker, Jonathon Love, Damian Dropmann (https://www.jamovi.org)
MANCOVA (mancova)
Description
Multivariate Analysis of (Co)Variance (MANCOVA) is used to explore the relationship between multiple dependent variables, and one or more categorical and/or continuous explanatory variables.
Usage
mancova(
data,
deps,
factors = NULL,
covs = NULL,
multivar = list("pillai", "wilks", "hotel", "roy"),
boxM = FALSE,
shapiro = FALSE,
()
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()

qqPlot = FALSE
)

Arguments

data the data as a data frame
deps a string naming the dependent variable from data, variable must be numeric
factorsa vector of strings naming the factors from data
covs a vector of strings naming the covariates from data
multivar
one or more of 'pillai', 'wilks', 'hotel', or 'roy'; use Pillais Trace, Wilks
Lambda, Hotellings Trace, and Roys Largest Root multivariate statistics, respectively
boxM TRUE or FALSE (default), provide Boxs M test
shapiroTRUE or FALSE (default), provide Shapiro-Wilk test
qqPlot TRUE or FALSE (default), provide a Q-Q plot of multivariate normality

Output
A results object containing:
results$multivar
results$univar
results$assump$boxM
results$assump$shapiro
results$assump$qqPlot

a table
a table
a table
a table
an image

Tables can be converted to data frames with asDF or as.data.frame(). For example:
results$multivar$asDF
as.data.frame(results$multivar)
Examples
data('iris')
mancova(data = iris,
deps = vars(Sepal.Length, Sepal.Width, Petal.Length, Petal.
,→Width),
factors = Species)
#
#
#
#
#

MANCOVA

Multivariate Tests
---------------------------------------------------------------,→----------#
value
F
df1
df2
,→
p
# ---------------------------------------------------------------,→----------#
Species
Pillai's Trace
1.19
53.5
8
290
,→
< .001
()
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()

#

Wilks' Lambda

0.0234

199

8

288

32.5

581

8

286

< .001

,→

#

Hotelling's Trace
< .001

,→

#

Roy's Largest Root
32.2
1167
4
145
< .001
# ---------------------------------------------------------------,→----------#
#
# Univariate Tests
# ---------------------------------------------------------------,→------------------------------#
Dependent Variable
Sum of Squares
df
,→Mean Square
F
p
# ---------------------------------------------------------------,→------------------------------#
Species
Sepal.Length
63.21
2
,→
31.6061
119.3
< .001
#
Sepal.Width
11.34
2
,→
5.6725
49.2
< .001
#
Petal.Length
437.10
2
,→ 218.5514
1180.2
< .001
#
Petal.Width
80.41
2
,→
40.2067
960.0
< .001
#
Residuals
Sepal.Length
38.96
147
,→
0.2650
#
Sepal.Width
16.96
147
,→
0.1154
#
Petal.Length
27.22
147
,→
0.1852
#
Petal.Width
6.16
147
,→
0.0419
# ---------------------------------------------------------------,→------------------------------#
,→

Ravi Selker, Jonathon Love, Damian Dropmann (https://www.jamovi.org)
One-Way ANOVA (non-parametric; anovaNP)
Description
The Kruskal-Wallis test is used to explore the relationship between a continuous dependent
variable, and a categorical explanatory variable. It is analagous to ANOVA, but with the
advantage of being non-parametric and having fewer assumptions. However, it has the
limitation that it can only test a single explanatory variable at a time.
Usage
anovaNP(
data,
deps,
group,
()
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()

es = FALSE,
pairs = FALSE,
formula
)

Arguments

data
deps
group
es
pairs
formula

the data as a data frame
a string naming the dependent variable in data
a string naming the grouping or independent variable in data
TRUE or FALSE (default), provide effect-sizes
TRUE or FALSE (default), perform pairwise comparisons
(optional) the formula to use, see the examples

Output
A results object containing:
results$table
results$comparisons

a table of the test results
an array of pairwise comparison tables

Tables can be converted to data frames with asDF or as.data.frame(). For example:
results$table$asDF
as.data.frame(results$table)
Examples
data('ToothGrowth')
anovaNP(formula = len ~ dose, data=ToothGrowth)
#
#
#
#
#
#
#
#
#
#

ONE-WAY ANOVA (NON-PARAMETRIC)
Kruskal-Wallis
------------------------------X2
df
p
------------------------------len
40.7
2
< .001
-------------------------------

Ravi Selker, Jonathon Love, Damian Dropmann (https://www.jamovi.org)
Repeated Measures ANOVA (non-parametric; anovaRMNP)
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Description
The Friedman test is used to explore the relationship between a continuous dependent
variable and a categorical explanatory variable, where the explanatory variable is within
subjects (where multiple measurements are from the same subject). It is analagous to
Repeated Measures ANOVA, but with the advantage of being non-parametric, and not
requiring the assumptions of normality or homogeneity of variances. However, it has the
limitation that it can only test a single explanatory variable at a time.
Usage
anovaRMNP(
data,
measures,
pairs = FALSE,
desc = FALSE,
plots = FALSE,
plotType = "means"
)

Arguments

data
measures
pairs
desc
plots
plotType

the data as a data frame
a vector of strings naming the repeated measures variables
TRUE or FALSE (default), perform pairwise comparisons
TRUE or FALSE (default), provide descriptive statistics
TRUE or FALSE (default), provide a descriptive plot
'means' (default) or 'medians', the error bars to use in the plot

Output
A results object containing:
results$table
results$comp
results$desc
results$plot

a table of the Friedman test results
a table of the pairwise comparisons
a table containing the descriptives
a descriptives plot

Tables can be converted to data frames with asDF or as.data.frame(). For example:
results$table$asDF
as.data.frame(results$table)
Examples
data('bugs', package = 'jmv')
anovaRMNP(bugs, measures = vars(LDLF, LDHF, HDLF, HDHF))
#
()
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()

#
#
#
#
#
#
#
#
#

REPEATED MEASURES ANOVA (NON-PARAMETRIC)
Friedman
-----------------------X2
df
p
-----------------------55.8
3
< .001
------------------------

Regression
Ravi Selker, Jonathon Love, Damian Dropmann (https://www.jamovi.org)
Correlation Matrix (corrMatrix)
Description
Correlation matrices are a way to examine linear relationships between two or more continuous variables.
Usage
corrMatrix(
data,
vars,
pearson = TRUE,
spearman = FALSE,
kendall = FALSE,
sig = TRUE,
flag = FALSE,
n = FALSE,
ci = FALSE,
ciWidth = 95,
plots = FALSE,
plotDens = FALSE,
plotStats = FALSE,
hypothesis = "corr"
)
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Arguments

data
the data as a data frame
vars
a vector of strings naming the variables to correlate in data
pearson TRUE (default) or FALSE, provide Pearsons R
spearmanTRUE or FALSE (default), provide Spearmans rho
kendall TRUE or FALSE (default), provide Kendalls tau-b
sig
TRUE (default) or FALSE, provide significance levels
flag
TRUE or FALSE (default), flag significant correlations
n
TRUE or FALSE (default), provide the number of cases
ci
TRUE or FALSE (default), provide confidence intervals
ciWidth a number between 50 and 99.9 (default: 95), the width of confidence intervals to
provide
plots
TRUE or FALSE (default), provide a correlation matrix plot
plotDensTRUE or FALSE (default), provide densities in the correlation matrix plot
plotStats
TRUE or FALSE (default), provide statistics in the correlation matrix plot
hypothesis
one of 'corr' (default), 'pos', 'neg' specifying the alernative hypothesis; correlated, correlated positively, correlated negatively respectively.

Details
For each pair of variables, a Pearsons r value indicates the strength and direction of the relationship
between those two variables. A positive value indicates a positive relationship (higher values of
one variable predict higher values of the other variable). A negative Pearsons r indicates a negative
relationship (higher values of one variable predict lower values of the other variable, and vice-versa).
A value of zero indicates no relationship (whether a variable is high or low, does not tell us anything
about the value of the other variable).
More formally, it is possible to test the null hypothesis that the correlation is zero and calculate a
p-value. If the p-value is low, it suggests the correlation co-efficient is not zero, and there is a linear
(or more complex) relationship between the two variables.
Output
A results object containing:
results$matrix
results$plot

a correlation matrix table
a correlation matrix plot

Tables can be converted to data frames with asDF or as.data.frame(). For example:
results$matrix$asDF
as.data.frame(results$matrix)
Examples
data('mtcars')
corrMatrix(mtcars, vars = vars(mpg, cyl, disp, hp))
#
#

CORRELATION MATRIX
()
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#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#

Correlation Matrix
-------------------------------------------------------------mpg
cyl
disp
hp
-------------------------------------------------------------mpg
Pearson's r
-0.852
-0.848
-0.776
p-value
< .001
< .001
< .001
cyl

Pearson's r
p-value

disp

Pearson's r
p-value

0.902
< .001

0.832
< .001
0.791
< .001

hp

Pearson's r
p-value
--------------------------------------------------------------

Ravi Selker, Jonathon Love, Damian Dropmann (https://www.jamovi.org)
Partial Correlation (corrPart)
Description
Partial correlation matrices are a way to examine linear relationships between two or more continuous
variables while controlling for other variables
Usage
corrPart(
data,
vars,
controls,
pearson = TRUE,
spearman = FALSE,
kendall = FALSE,
type = "part",
sig = TRUE,
flag = FALSE,
n = FALSE,
hypothesis = "corr"
)
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Arguments

data
the data as a data frame
vars
a vector of strings naming the variables to correlate in data
controlsa vector of strings naming the control variables in data
pearson TRUE (default) or FALSE, provide Pearsons R
spearmanTRUE or FALSE (default), provide Spearmans rho
kendall TRUE or FALSE (default), provide Kendalls tau-b
type
one of 'part' (default) or 'semi' specifying the type of partial correlation to calculate; partial or semipartial correlation.
sig
TRUE (default) or FALSE, provide significance levels
flag
TRUE or FALSE (default), flag significant correlations
n
TRUE or FALSE (default), provide the number of cases
hypothesis
one of 'corr' (default), 'pos', 'neg' specifying the alernative hypothesis; correlated, correlated positively, correlated negatively respectively.

Details
For each pair of variables, a Pearsons r value indicates the strength and direction of the
relationship between those two variables. A positive value indicates a positive relationship
(higher values of one variable predict higher values of the other variable). A negative
Pearsons r indicates a negative relationship (higher values of one variable predict lower
values of the other variable, and vice-versa). A value of zero indicates no relationship
(whether a variable is high or low, does not tell us anything about the value of the other
variable).
More formally, it is possible to test the null hypothesis that the correlation is zero and
calculate a p-value. If the p-value is low, it suggests the correlation co-efficient is not zero,
and there is a linear (or more complex) relationship between the two variables.
Output
A results object containing:
results$matrix

a (semi)partial correlation matrix table

Tables can be converted to data frames with asDF or as.data.frame(). For example:
results$matrix$asDF
as.data.frame(results$matrix)
Examples
data('mtcars')
corrPart(mtcars, vars = vars(mpg, cyl, disp), controls = vars(hp))
#
#
#
#
#

PARTIAL CORRELATION
Partial Correlation
---------------------------------------------------()
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()

#
#
#
#
#
#
#
#
#
#
#
#
#

mpg
cyl
disp
---------------------------------------------------mpg
Pearson's r
p-value
cyl

Pearson's r
p-value

-0.590
< .001

disp

Pearson's r
-0.606
0.719
p-value
< .001
< .001
---------------------------------------------------Note. controlling for 'hp'

Ravi Selker, Jonathon Love, Damian Dropmann (https://www.jamovi.org)
Linear Regression (linReg)
Description
Linear regression is used to explore the relationship between a continuous dependent variable, and one or more continuous and / or categorical explanatory variables. Other statistical methods, such as ANOVA and ANCOVA, are in reality just forms of linear regression.
Usage
linReg(
data,
dep,
covs = NULL,
factors = NULL,
blocks = list(list()),
refLevels = NULL,
intercept = "refLevel",
r = TRUE,
r2 = TRUE,
r2Adj = FALSE,
aic = FALSE,
bic = FALSE,
rmse = FALSE,
modelTest = FALSE,
anova = FALSE,
ci = FALSE,
ciWidth = 95,
stdEst = FALSE,
ciStdEst = FALSE,
ciWidthStdEst = 95,
coefPlot = FALSE,
norm = FALSE,
qqPlot = FALSE,
resPlots = FALSE,
durbin = FALSE,
collin = FALSE,
cooks = FALSE,
()
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()

emMeans = list(list()),
ciEmm = TRUE,
ciWidthEmm = 95,
emmPlots = TRUE,
emmTables = FALSE,
emmWeights = TRUE
)

Arguments

data
dep
covs
factors
blocks
refLevels
intercept
r
r2
r2Adj
aic
bic
rmse
modelTest
anova
ci
ciWidth
stdEst
ciStdEst
ciWidthStdEst
coefPlot
norm
qqPlot
resPlots
durbin
collin
cooks
emMeans
ciEmm
ciWidthEmm
emmPlots
emmTables
emmWeights

the data as a data frame
the dependent variable from data, variable must be numeric
the covariates from data
the fixed factors from data
a list containing vectors of strings that name the predictors that are added to the model. The elements are ad
a list of lists specifying reference levels of the dependent variable and all the factors
'refLevel' (default) or 'grandMean', coding of the intercept. Either creates contrast so that the inter
TRUE (default) or FALSE, provide the statistical measure R for the models
TRUE (default) or FALSE, provide the statistical measure R-squared for the models
TRUE or FALSE (default), provide the statistical measure adjusted R-squared for the models
TRUE or FALSE (default), provide Aikaikes Information Criterion (AIC) for the models
TRUE or FALSE (default), provide Bayesian Information Criterion (BIC) for the models
TRUE or FALSE (default), provide RMSE for the models
TRUE (default) or FALSE, provide the model comparison between the models and the NULL model
TRUE or FALSE (default), provide the omnibus ANOVA test for the predictors
TRUE or FALSE (default), provide a confidence interval for the model coefficients
a number between 50 and 99.9 (default: 95) specifying the confidence interval width
TRUE or FALSE (default), provide a standardized estimate for the model coefficients
TRUE or FALSE (default), provide a confidence interval for the model coefficient standardized estimates
a number between 50 and 99.9 (default: 95) specifying the confidence interval width
TRUE or FALSE (default), provide a coefficient plot where for each predictor the estimated coefficient and
TRUE or FALSE (default), perform a Shapiro-Wilk test on the residuals
TRUE or FALSE (default), provide a Q-Q plot of residuals
TRUE or FALSE (default), provide residual plots where the dependent variable and each covariate is plotted
TRUE or FALSE (default), provide results of the Durbin-Watson test for autocorrelation
TRUE or FALSE (default), provide VIF and tolerence collinearity statistics
TRUE or FALSE (default), provide summary statistics for the Cooks distance
a formula containing the terms to estimate marginal means for, supports up to three variables per term
TRUE (default) or FALSE, provide a confidence interval for the estimated marginal means
a number between 50 and 99.9 (default: 95) specifying the confidence interval width for the estimated marg
TRUE (default) or FALSE, provide estimated marginal means plots
TRUE or FALSE (default), provide estimated marginal means tables
TRUE (default) or FALSE, weigh each cell equally or weigh them according to the cell frequency

Output
A results object containing:
results$modelFit
results$modelComp
results$models
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a table
a table
an array of model specific results
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Tables can be converted to data frames with asDF or as.data.frame(). For example:
results$modelFit$asDF
as.data.frame(results$modelFit)
Examples
data('Prestige', package='carData')
linReg(data = Prestige, dep = income,
covs = vars(education, prestige, women),
blocks = list(list('education', 'prestige', 'women')))
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#

LINEAR REGRESSION
Model Fit Measures
--------------------------Model
R
R2
--------------------------1
0.802
0.643
---------------------------

MODEL SPECIFIC RESULTS
MODEL 1

Model Coefficients
-------------------------------------------------------Predictor
Estimate
SE
t
p
-------------------------------------------------------Intercept
-253.8
1086.16
-0.234
0.816
women
-50.9
8.56
-5.948
< .001
prestige
141.4
29.91
4.729
< .001
education
177.2
187.63
0.944
0.347
--------------------------------------------------------

Ravi Selker, Jonathon Love, Damian Dropmann (https://www.jamovi.org)
Binomial Logistic Regression (logRegBin)
Description
Binomial Logistic Regression
Usage
logRegBin(
data,
dep,
()
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covs = NULL,
factors = NULL,
blocks = list(list()),
refLevels = NULL,
modelTest = FALSE,
dev = TRUE,
aic = TRUE,
bic = FALSE,
pseudoR2 = list("r2mf"),
omni = FALSE,
ci = FALSE,
ciWidth = 95,
OR = FALSE,
ciOR = FALSE,
ciWidthOR = 95,
emMeans = list(list()),
ciEmm = TRUE,
ciWidthEmm = 95,
emmPlots = TRUE,
emmTables = FALSE,
emmWeights = TRUE,
class = FALSE,
acc = FALSE,
spec = FALSE,
sens = FALSE,
auc = FALSE,
rocPlot = FALSE,
cutOff = 0.5,
cutOffPlot = FALSE,
collin = FALSE,
boxTidwell = FALSE,
cooks = FALSE
)

Arguments

data
dep
covs
factors
blocks
refLevels
modelTest
dev
aic
bic
pseudoR2
omni
ci
ciWidth
OR
ciOR
ciWidthOR
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the data as a data frame
a string naming the dependent variable from data, variable must be a factor
a vector of strings naming the covariates from data
a vector of strings naming the fixed factors from data
a list containing vectors of strings that name the predictors that are added to the model. The elements are added
a list of lists specifying reference levels of the dependent variable and all the factors
TRUE or FALSE (default), provide the model comparison between the models and the NULL model
TRUE (default) or FALSE, provide the deviance (or -2LogLikelihood) for the models
TRUE (default) or FALSE, provide Aikaikes Information Criterion (AIC) for the models
TRUE or FALSE (default), provide Bayesian Information Criterion (BIC) for the models
one or more of 'r2mf', 'r2cs', or 'r2n'; use McFaddens, Cox & Snell, and Nagelkerke pseudo-R2 , respec
TRUE or FALSE (default), provide the omnibus likelihood ratio tests for the predictors
TRUE or FALSE (default), provide a confidence interval for the model coefficient estimates
a number between 50 and 99.9 (default: 95) specifying the confidence interval width
TRUE or FALSE (default), provide the exponential of the log-odds ratio estimate, or the odds ratio estimate
TRUE or FALSE (default), provide a confidence interval for the model coefficient odds ratio estimates
a number between 50 and 99.9 (default: 95) specifying the confidence interval width
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emMeans
ciEmm
ciWidthEmm
emmPlots
emmTables
emmWeights
class
acc
spec
sens
auc
rocPlot
cutOff
cutOffPlot
collin
boxTidwell
cooks

21.3 –
a list of lists specifying the variables for which the estimated marginal means need to be calculate. Supports up t
TRUE (default) or FALSE, provide a confidence interval for the estimated marginal means
a number between 50 and 99.9 (default: 95) specifying the confidence interval width for the estimated marginal
TRUE (default) or FALSE, provide estimated marginal means plots
TRUE or FALSE (default), provide estimated marginal means tables
TRUE (default) or FALSE, weigh each cell equally or weigh them according to the cell frequency
TRUE or FALSE (default), provide a predicted classification table (or confusion matrix)
TRUE or FALSE (default), provide the predicted accuracy of outcomes grouped by the cut-off value
TRUE or FALSE (default), provide the predicted specificity of outcomes grouped by the cut-off value
TRUE or FALSE (default), provide the predicted sensitivity of outcomes grouped by the cut-off value
TRUE or FALSE (default), provide the area under the ROC curve (AUC)
TRUE or FALSE (default), provide a ROC curve plot
TRUE or FALSE (default), set a cut-off used for the predictions
TRUE or FALSE (default), provide a cut-off plot
TRUE or FALSE (default), provide VIF and tolerence collinearity statistics
TRUE or FALSE (default), provide Box-Tidwell test for linearity of the logit
TRUE or FALSE (default), provide summary statistics for the Cooks distance

Output
A results object containing:
results$modelFit
results$modelComp
results$models

a table
a table
an array of model specific results

Tables can be converted to data frames with asDF or as.data.frame(). For example:
results$modelFit$asDF
as.data.frame(results$modelFit)
Examples
data('birthwt', package='MASS')
dat <- data.frame(
low = factor(birthwt$low),
age = birthwt$age,
bwt = birthwt$bwt)
logRegBin(data = dat, dep = low,
covs = vars(age, bwt),
blocks = list(list("age", "bwt")),
refLevels = list(list(var="low", ref="0")))
#
#
#
#
#
#
#
#

BINOMIAL LOGISTIC REGRESSION
Model Fit Measures
--------------------------------------Model
Deviance
AIC
R2 -McF
--------------------------------------1
4.97e-7
6.00
1.000
()
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()

#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#

---------------------------------------

MODEL SPECIFIC RESULTS
MODEL 1
Model Coefficients
-----------------------------------------------------------Predictor
Estimate
SE
Z
p
-----------------------------------------------------------Intercept
2974.73225
218237.2
0.0136
0.989
age
-0.00653
482.7
-1.35e-5
1.000
bwt
-1.18532
87.0
-0.0136
0.989
-----------------------------------------------------------Note. Estimates represent the log odds of "low = 1"
vs. "low = 0"

Ravi Selker, Jonathon Love, Damian Dropmann (https://www.jamovi.org)
Multinomial Logistic Regression (logRegMulti)
Description
Multinomial Logistic Regression
Usage
logRegMulti(
data,
dep,
covs = NULL,
factors = NULL,
blocks = list(list()),
refLevels = NULL,
modelTest = FALSE,
dev = TRUE,
aic = TRUE,
bic = FALSE,
pseudoR2 = list("r2mf"),
omni = FALSE,
ci = FALSE,
ciWidth = 95,
OR = FALSE,
ciOR = FALSE,
ciWidthOR = 95,
emMeans = list(list()),
ciEmm = TRUE,
ciWidthEmm = 95,
emmPlots = TRUE,
emmTables = FALSE,
()
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()

emmWeights = TRUE
)

Arguments

the data as a data frame
a string naming the dependent variable from data, variable must be a factor
a vector of strings naming the covariates from data
a vector of strings naming the fixed factors from data
a list containing vectors of strings that name the predictors that are added to the model.
The elements are added to the model according to their order in the list
refLevels
a list of lists specifying reference levels of the dependent variable and all the factors
modelTest
TRUE or FALSE (default), provide the model comparison between the models and the
NULL model
dev
TRUE (default) or FALSE, provide the deviance (or -2LogLikelihood) for the models
aic
TRUE (default) or FALSE, provide Aikaikes Information Criterion (AIC) for the models
bic
TRUE or FALSE (default), provide Bayesian Information Criterion (BIC) for the models
pseudoR2one or more of 'r2mf', 'r2cs', or 'r2n'; use McFaddens, Cox & Snell, and
Nagelkerke pseudo-R2 , respectively
omni
TRUE or FALSE (default), provide the omnibus likelihood ratio tests for the predictors
ci
TRUE or FALSE (default), provide a confidence interval for the model coefficient estimates
ciWidth a number between 50 and 99.9 (default: 95) specifying the confidence interval width
OR
TRUE or FALSE (default), provide the exponential of the log-odds ratio estimate, or
the odds ratio estimate
ciOR
TRUE or FALSE (default), provide a confidence interval for the model coefficient odds
ratio estimates
ciWidthOR
a number between 50 and 99.9 (default: 95) specifying the confidence interval width
emMeans a list of lists specifying the variables for which the estimated marginal means need to
be calculate. Supports up to three variables per term.
ciEmm
TRUE (default) or FALSE, provide a confidence interval for the estimated marginal
means
ciWidthEmm
a number between 50 and 99.9 (default: 95) specifying the confidence interval width
for the estimated marginal means
emmPlotsTRUE (default) or FALSE, provide estimated marginal means plots
emmTables
TRUE or FALSE (default), provide estimated marginal means tables
emmWeights
TRUE (default) or FALSE, weigh each cell equally or weigh them according to the cell
frequency
data
dep
covs
factors
blocks

Output
A results object containing:
results$modelFit
results$modelComp
results$models

a table
a table
an array of model specific results

Tables can be converted to data frames with asDF or as.data.frame(). For example:
results$modelFit$asDF
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as.data.frame(results$modelFit)
Examples
data('birthwt', package='MASS')
dat <- data.frame(
race = factor(birthwt$race),
age = birthwt$age,
low = factor(birthwt$low))
logRegMulti(data = dat, dep = race,
covs = age, factors = low,
blocks = list(list("age", "low")),
refLevels = list(
list(var="race", ref="1"),
list(var="low", ref="0")))
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#

MULTINOMIAL LOGISTIC REGRESSION
Model Fit Measures
-------------------------------------Model
Deviance
AIC
R2 -McF
-------------------------------------1
360
372
0.0333
--------------------------------------

MODEL SPECIFIC RESULTS
MODEL 1
Model Coefficients
--------------------------------------------------------------race
Predictor
Estimate
SE
Z
p
--------------------------------------------------------------2 - 1
Intercept
0.8155
1.1186
0.729
0.466
age
-0.1038
0.0487
-2.131
0.033
low:
1 - 0
0.7527
0.4700
1.601
0.109
3 - 1
Intercept
1.0123
0.7798
1.298
0.194
age
-0.0663
0.0324
-2.047
0.041
low:
1 - 0
0.5677
0.3522
1.612
0.107
---------------------------------------------------------------

Ravi Selker, Jonathon Love, Damian Dropmann (https://www.jamovi.org)
Ordinal Logistic Regression (logRegOrd)
Description
Ordinal Logistic Regression
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Usage
logRegOrd(
data,
dep,
covs = NULL,
factors = NULL,
blocks = list(list()),
refLevels = NULL,
modelTest = FALSE,
dev = TRUE,
aic = TRUE,
bic = FALSE,
pseudoR2 = list("r2mf"),
omni = FALSE,
thres = FALSE,
ci = FALSE,
ciWidth = 95,
OR = FALSE,
ciOR = FALSE,
ciWidthOR = 95
)

Arguments

data
the data as a data frame
dep
a string naming the dependent variable from data, variable must be a factor
covs
a vector of strings naming the covariates from data
factorsa vector of strings naming the fixed factors from data
blocks a list containing vectors of strings that name the predictors that are added to the model.
The elements are added to the model according to their order in the list
refLevels
a list of lists specifying reference levels of the dependent variable and all the factors
modelTest
TRUE or FALSE (default), provide the model comparison between the models and the
NULL model
dev
TRUE (default) or FALSE, provide the deviance (or -2LogLikelihood) for the models
aic
TRUE (default) or FALSE, provide Aikaikes Information Criterion (AIC) for the models
bic
TRUE or FALSE (default), provide Bayesian Information Criterion (BIC) for the models
pseudoR2
one or more of 'r2mf', 'r2cs', or 'r2n'; use McFaddens, Cox & Snell, and
Nagelkerke pseudo-R2 , respectively
omni
TRUE or FALSE (default), provide the omnibus likelihood ratio tests for the predictors
thres TRUE or FALSE (default), provide the thresholds that are used as cut-off scores for the
levels of the dependent variable
ci
TRUE or FALSE (default), provide a confidence interval for the model coefficient estimates
ciWidtha number between 50 and 99.9 (default: 95) specifying the confidence interval width
OR
TRUE or FALSE (default), provide the exponential of the log-odds ratio estimate, or the
odds ratio estimate
ciOR
TRUE or FALSE (default), provide a confidence interval for the model coefficient odds
ratio estimates
ciWidthOR
a number between 50 and 99.9 (default: 95) specifying the confidence interval width

Output
A results object containing:
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results$modelFit
results$modelComp
results$models

a table
a table
an array of model specific results

Tables can be converted to data frames with asDF or as.data.frame(). For example:
results$modelFit$asDF
as.data.frame(results$modelFit)
Examples
set.seed(1337)
y <- factor(sample(1:3, 100, replace = TRUE))
x1 <- rnorm(100)
x2 <- rnorm(100)
df <- data.frame(y=y, x1=x1, x2=x2)
logRegOrd(data = df, dep = y,
covs = vars(x1, x2),
blocks = list(list("x1", "x2")))
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#

ORDINAL LOGISTIC REGRESSION
Model Fit Measures
--------------------------------------Model
Deviance
AIC
R2 -McF
--------------------------------------1
218
226
5.68e-4
---------------------------------------

MODEL SPECIFIC RESULTS
MODEL 1
Model Coefficients
---------------------------------------------------Predictor
Estimate
SE
Z
p
---------------------------------------------------x1
0.0579
0.193
0.300
0.764
x2
0.0330
0.172
0.192
0.848
----------------------------------------------------

Frequencies
Ravi Selker, Jonathon Love, Damian Dropmann (https://www.jamovi.org)
Proportion Test (2 Outcomes; propTest2)
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Description
The Binomial test is used to test the Null hypothesis that the proportion of observations
match some expected value. If the p-value is low, this suggests that the Null hypothesis is
false, and that the true proportion must be some other value.
Usage
propTest2(
data,
vars,
areCounts = FALSE,
testValue = 0.5,
hypothesis = "notequal",
ci = FALSE,
ciWidth = 95,
bf = FALSE,
priorA = 1,
priorB = 1,
ciBayes = FALSE,
ciBayesWidth = 95,
postPlots = FALSE
)

Arguments

data
vars
areCounts
testValue
hypothesis
ci
ciWidth
bf
priorA
priorB
ciBayes
ciBayesWidth
postPlots

the data as a data frame
a vector of strings naming the variables of interest in data
TRUE or FALSE (default), the variables are counts
a number (default: 0.5), the value for the null hypothesis
'notequal' (default), 'greater' or 'less', the alternative hypothesis
TRUE or FALSE (default), provide confidence intervals
a number between 50 and 99.9 (default: 95), the confidence interval width
TRUE or FALSE (default), provide Bayes factors
a number (default: 1), the beta prior a parameter
a number (default: 1), the beta prior b parameter
TRUE or FALSE (default), provide Bayesian credible intervals
a number between 50 and 99.9 (default: 95), the credible interval width
TRUE or FALSE (default), provide posterior plots

Output
A results object containing:
results$table
results$postPlots

a table of the proportions and test results
an array of the posterior plots

Tables can be converted to data frames with asDF or as.data.frame(). For example:
results$table$asDF
as.data.frame(results$table)
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Examples
dat <- data.frame(x=c(8, 15))
propTest2(dat, vars = x, areCounts = TRUE)
#
#
#
#
#
#
#
#
#
#
#
#

PROPORTION TEST (2 OUTCOMES)
Binomial Test
------------------------------------------------------Level
Count
Total
Proportion
p
------------------------------------------------------x
1
8
23
0.348
0.210
2
15
23
0.652
0.210
------------------------------------------------------Note. Ha is proportion != 0.5

Ravi Selker, Jonathon Love, Damian Dropmann (https://www.jamovi.org)
Proportion Test (N Outcomes; propTestN)
Description
The X2 Goodness of fit test (not to be confused with the X2 test of independence), tests the
Null hypothesis that the proportions of observations match some expected proportions. If
the p-value is low, this suggests that the Null hypothesis is false, and that the true proportions are different to those tested.
Usage
propTestN(
data,
var,
counts = NULL,
expected = FALSE,
ratio = NULL,
formula)

Arguments

data
var
counts
expected
ratio
formula
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the data as a data frame
the variable of interest in data (not necessary when using a formula, see the examples)
the counts in data
TRUE or FALSE (default), whether expected counts should be displayed
a vector of numbers: the expected proportions
(optional) the formula to use, see the examples
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Output
A results object containing:
results$props
results$tests

a table of the proportions
a table of the test results

Tables can be converted to data frames with asDF or as.data.frame(). For example:
results$props$asDF
as.data.frame(results$props)
Examples
data('HairEyeColor')
dat <- as.data.frame(HairEyeColor)
propTestN(formula = Freq ~ Eye, data = dat, ratio = c(1,1,1,1))
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#

PROPORTION TEST (N OUTCOMES)
Proportions
-------------------------------Level
Count
Proportion
-------------------------------Brown
220
0.372
Blue
215
0.363
Hazel
93
0.157
Green
64
0.108
--------------------------------

X2 Goodness of Fit
----------------------X2
df
p
----------------------133
3
< .001
-----------------------

Ravi Selker, Jonathon Love, Damian Dropmann (https://www.jamovi.org)
Contingency Tables (contTables)
Description
The X2 test of association (not to be confused with the X2 goodness of fit) is used to test
whether two categorical variables are independent or associated. If the p-value is low, it
suggests the variables are not independent, and that there is a relationship between the two
variables.

21.2. The jmv R package

225

Documentation for jamovi

Usage
contTables(
data,
rows,
cols,
counts = NULL,
layers = NULL,
chiSq = TRUE,
chiSqCorr = FALSE,
likeRat = FALSE,
fisher = FALSE,
contCoef = FALSE,
phiCra = FALSE,
logOdds = FALSE,
odds = FALSE,
relRisk = FALSE,
ci = TRUE,
ciWidth = 95,
gamma = FALSE,
taub = FALSE,
obs = TRUE,
exp = FALSE,
pcRow = FALSE,
pcCol = FALSE,
pcTot = FALSE,
formula
)
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Arguments

the data as a data frame
the variable to use as the rows in the contingency table (not necessary when providing
a formula, see the examples)
cols
the variable to use as the columns in the contingency table (not necessary when providing a formula, see the examples)
counts
the variable to use as the counts in the contingency table (not necessary when providing a formula, see the examples)
layers
the variables to use to split the contingency table (not necessary when providing a
formula, see the examples)
chiSq
TRUE (default) or FALSE, provide X2
chiSqCorrTRUE or FALSE (default), provide X2 with continuity correction
likeRat TRUE or FALSE (default), provide the likelihood ratio
fisher
TRUE or FALSE (default), provide Fishers exact test
contCoef TRUE or FALSE (default), provide the contingency coefficient
phiCra
TRUE or FALSE (default), provide Phi and Cramers V
logOdds TRUE or FALSE (default), provide the log odds ratio (only available for 2x2 tables)
odds
TRUE or FALSE (default), provide the odds ratio (only available for 2x2 tables)
relRisk TRUE or FALSE (default), provide the relative risk (only available for 2x2 tables)
ci
TRUE or FALSE (default), provide confidence intervals for the comparative measures
ciWidth a number between 50 and 99.9 (default: 95), width of the confidence intervals to
provide
gamma
TRUE or FALSE (default), provide gamma
taub
TRUE or FALSE (default), provide Kendalls tau-b
obs
TRUE or FALSE (default), provide the observed counts
exp
TRUE or FALSE (default), provide the expected counts
pcRow
TRUE or FALSE (default), provide row percentages
pcCol
TRUE or FALSE (default), provide column percentages
pcTot
TRUE or FALSE (default), provide total percentages
formula (optional) the formula to use, see the examples
data
rows

Output
A results object containing:
results$freqs
results$chiSq
results$odds
results$nom
results$gamma
results$taub

a table of proportions
a table of X2 test results
a table of comparative measures
a table of the nominal test results
a table of the gamma test results
a table of the Kendalls tau-b test results

Tables can be converted to data frames with asDF or as.data.frame(). For example:
results$freqs$asDF
as.data.frame(results$freqs)
Examples
data('HairEyeColor')
dat <- as.data.frame(HairEyeColor)
()
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contTables(formula = Freq ~ Hair:Eye, dat)
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#

CONTINGENCY TABLES
Contingency Tables
----------------------------------------------------Hair
Brown
Blue
Hazel
Green
Total
----------------------------------------------------Black
68
20
15
5
108
Brown
119
84
54
29
286
Red
26
17
14
14
71
Blond
7
94
10
16
127
Total
220
215
93
64
592
-----------------------------------------------------

X2 Tests
------------------------------Value
df
p
------------------------------X2
138
9
< .001
N
592
-------------------------------

# Alternatively, omit the left of the formula (`Freq`) if each row
# represents a single observation:
contTables(formula = ~ Hair:Eye, dat)
Ravi Selker, Jonathon Love, Damian Dropmann (https://www.jamovi.org)
Paired Samples Contingency Tables (contTablesPaired)
Description
McNemar test
Usage
contTablesPaired(
data,
rows,
cols,
counts = NULL,
chiSq = TRUE,
chiSqCorr = FALSE,
exact = FALSE,
pcRow = FALSE,
pcCol = FALSE,
formula
)
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Arguments

the data as a data frame
the variable to use as the rows in the contingency table (not necessary when providing
a formula, see the examples)
cols
the variable to use as the columns in the contingency table (not necessary when providing a formula, see the examples)
counts
the variable to use as the counts in the contingency table (not necessary when providing a formula, see the examples)
chiSq
TRUE (default) or FALSE, provide X2
chiSqCorrTRUE or FALSE (default), provide X2 with continuity correction
exact
TRUE or FALSE (default), provide an exact log odds ratio (requires exact2x2 to be
installed)
pcRow
TRUE or FALSE (default), provide row percentages
pcCol
TRUE or FALSE (default), provide column percentages
formula (optional) the formula to use, see the examples
data
rows

Output
A results object containing:
results$freqs
results$test

a proportions table
a table of test results

Tables can be converted to data frames with asDF or as.data.frame(). For example:
results$freqs$asDF
as.data.frame(results$freqs)
Examples
dat <- data.frame(
`1st survey` = c('Approve', 'Approve', 'Disapprove',
,→'Disapprove'),
`2nd survey` = c('Approve', 'Disapprove', 'Approve',
,→'Disapprove'),
`Counts` = c(794, 150, 86, 570),
check.names=FALSE)
contTablesPaired(formula = Counts ~ `1st survey`:`2nd survey`,
,→data = dat)
#
#
#
#
#
#
#
#
#
#
#

PAIRED SAMPLES CONTINGENCY TABLES
Contingency Tables
-----------------------------------------------1st survey
Approve
Disapprove
Total
-----------------------------------------------Approve
794
150
944
Disapprove
86
570
656
Total
720
880
1600
-----------------------------------------------()
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#
#
#
#
#
#
#
#
#
#

McNemar Test
----------------------------------------------------Value
df
p
----------------------------------------------------X2
17.4
1
< .001
X2 continuity correction
16.8
1
< .001
-----------------------------------------------------

# Alternatively, omit the left of the formula (`Counts`) from the
# formula if each row represents a single observation:
contTablesPaired(formula = ~ `1st survey`:`2nd survey`, data = dat)
Ravi Selker, Jonathon Love, Damian Dropmann (https://www.jamovi.org)
Log-Linear Regression (logLinear)
Description
Log-Linear Regression
Usage
logLinear(
data,
factors = NULL,
counts = NULL,
blocks = list(list()),
refLevels = NULL,
modelTest = FALSE,
dev = TRUE,
aic = TRUE,
bic = FALSE,
pseudoR2 = list("r2mf"),
omni = FALSE,
ci = FALSE,
ciWidth = 95,
RR = FALSE,
ciRR = FALSE,
ciWidthRR = 95,
emMeans = list(list()),
ciEmm = TRUE,
ciWidthEmm = 95,
emmPlots = TRUE,
emmTables = FALSE,
emmWeights = TRUE
)
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Arguments

data
the data as a data frame
factors a vector of strings naming the factors from data
counts a string naming a variable in data containing counts, or NULL if each row represents
a single observation
blocks a list containing vectors of strings that name the predictors that are added to the model.
The elements are added to the model according to their order in the list
refLevels
a list of lists specifying reference levels of the dependent variable and all the factors
modelTest
TRUE or FALSE (default), provide the model comparison between the models and the
NULL model
dev
TRUE (default) or FALSE, provide the deviance (or -2LogLikelihood) for the models
aic
TRUE (default) or FALSE, provide Aikaikes Information Criterion (AIC) for the models
bic
TRUE or FALSE (default), provide Bayesian Information Criterion (BIC) for the models
pseudoR2one or more of 'r2mf', 'r2cs', or 'r2n'; use McFaddens, Cox & Snell, and
Nagelkerke pseudo-R2 , respectively
omni
TRUE or FALSE (default), provide the omnibus likelihood ratio tests for the predictors
ci
TRUE or FALSE (default), provide a confidence interval for the model coefficient estimates
ciWidth a number between 50 and 99.9 (default: 95) specifying the confidence interval width
RR
TRUE or FALSE (default), provide the exponential of the log-rate ratio estimate, or the
rate ratio estimate
ciRR
TRUE or FALSE (default), provide a confidence interval for the model coefficient rate
ratio estimates
ciWidthRR
a number between 50 and 99.9 (default: 95) specifying the confidence interval width
emMeans a list of lists specifying the variables for which the estimated marginal means need to
be calculate. Supports up to three variables per term.
ciEmm
TRUE (default) or FALSE, provide a confidence interval for the estimated marginal
means
ciWidthEmm
a number between 50 and 99.9 (default: 95) specifying the confidence interval width
for the estimated marginal means
emmPlotsTRUE (default) or FALSE, provide estimated marginal means plots
emmTables
TRUE or FALSE (default), provide estimated marginal means tables
emmWeights
TRUE (default) or FALSE, weigh each cell equally or weigh them according to the cell
frequency

Output
A results object containing:
results$modelFit
results$modelComp
results$models

a table
a table
an array of model specific results

Tables can be converted to data frames with asDF or as.data.frame(). For example:
results$modelFit$asDF
as.data.frame(results$modelFit)
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Examples
data('mtcars')
tab <- table('gear'=mtcars$gear, 'cyl'=mtcars$cyl)
dat <- as.data.frame(tab)
logLinear(data = dat, factors = vars(gear, cyl), counts = Freq,
blocks = list(list("gear", "cyl", c("gear", "cyl"))),
refLevels = list(
list(var="gear", ref="3"),
list(var="cyl", ref="4")))
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#
#

LOG-LINEAR REGRESSION
Model Fit Measures
--------------------------------------Model
Deviance
AIC
R2 -McF
--------------------------------------1
4.12e-10
41.4
1.000
---------------------------------------

MODEL SPECIFIC RESULTS
MODEL 1

Model Coefficients
---------------------------------------------------------------,→-#
Predictor
Estimate
SE
Z
p
# ---------------------------------------------------------------,→-#
Intercept
-4.71e-16
1.00
-4.71e-16
1.000
#
gear:
#
4 - 3
2.079
1.06
1.961
0.050
#
5 - 3
0.693
1.22
0.566
0.571
#
cyl:
#
6 - 4
0.693
1.22
0.566
0.571
#
8 - 4
2.485
1.04
2.387
0.017
#
gear:cyl:
#
(4 - 3):(6 - 4)
-1.386
1.37
-1.012
0.311
#
(5 - 3):(6 - 4)
-1.386
1.73
-0.800
0.423
#
(4 - 3):(8 - 4)
-26.867
42247.17
-6.36e -4
0.999
#
(5 - 3):(8 - 4)
-2.485
1.44
-1.722
0.085
# ---------------------------------------------------------------,→-#

Factor analyses
Ravi Selker, Jonathon Love, Damian Dropmann (https://www.jamovi.org)
Reliability Analysis (reliability)
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Description
Reliability Analysis
Usage
reliability(
data,
vars,
alphaScale = TRUE,
omegaScale = FALSE,
meanScale = FALSE,
sdScale = FALSE,
corPlot = FALSE,
alphaItems = FALSE,
omegaItems = FALSE,
meanItems = FALSE,
sdItems = FALSE,
itemRestCor = FALSE,
revItems = NULL
)

Arguments

the data as a data frame
a vector of strings naming the variables of interest in data
TRUE (default) or FALSE, provide Cronbachs alpha
TRUE or FALSE (default), provide McDonalds omega
TRUE or FALSE (default), provide the mean
TRUE or FALSE (default), provide the standard deviation
TRUE or FALSE (default), provide a correlation plot
TRUE or FALSE (default), provide what the Cronbachs alpha would be if the item
was dropped
omegaItems TRUE or FALSE (default), provide what the McDonalds omega would be if the
item was dropped
meanItems TRUE or FALSE (default), provide item means
sdItems
TRUE or FALSE (default), provide item standard deviations
itemRestCor TRUE or FALSE (default), provide item-rest correlations
revItems
a vector containing strings naming the varibales that are reverse scaled
data
vars
alphaScale
omegaScale
meanScale
sdScale
corPlot
alphaItems

Output
A results object containing:
results$scale
results$items
results$corPlot

a table
a table
an image

Tables can be converted to data frames with asDF or as.data.frame(). For example:
results$scale$asDF
as.data.frame(results$scale)
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Examples
data('iris')
reliability(iris, vars = c('Sepal.Length', 'Sepal.Width', 'Petal.
,→Length', 'Petal.Width'),
omegaScale = TRUE)
#
#
#
#
#
#
#
#
#
#

RELIABILITY ANALYSIS
Scale Reliability Statistics
----------------------------------------Cronbach's alpha
McDonald's omega
----------------------------------------scale
0.708
0.848
-----------------------------------------

Ravi Selker, Jonathon Love, Damian Dropmann (https://www.jamovi.org)
Principal Component Analysis (pca)
Description
Principal Component Analysis
Usage
pca(
data,
vars,
nFactorMethod = "parallel",
nFactors = 1,
minEigen = 1,
rotation = "varimax",
hideLoadings = 0.3,
sortLoadings = FALSE,
screePlot = FALSE,
eigen = FALSE,
factorCor = FALSE,
factorSummary = FALSE,
kmo = FALSE,
bartlett = FALSE
)
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Arguments

data
the data as a data frame
vars
a vector of strings naming the variables of interest in data
nFactorMethod
'parallel' (default), 'eigen' or 'fixed', the way to determine the number of factors
nFactors an integer (default: 1), the number of components in the model
minEigen a number (default: 1), the minimal eigenvalue for a component to be included in
the model
rotation 'none', 'varimax' (default), 'quartimax', 'promax', 'oblimin', or
'simplimax', the rotation to use in estimation
hideLoadings
a number (default: 0.3), hide loadings below this value
sortLoadings
TRUE or FALSE (default), sort the factor loadings by size
screePlot TRUE or FALSE (default), show scree plot
eigen
TRUE or FALSE (default), show eigenvalue table
factorCor TRUE or FALSE (default), show factor correlations
factorSummary
TRUE or FALSE (default), show factor summary
kmo
TRUE or FALSE (default), show Kaiser-Meyer-Olkin (KMO) measure of sampling
adequacy (MSA) results
bartlett TRUE or FALSE (default), show Bartletts test of sphericity results

Output
A results object containing:
results$loadings
results$factorStats$factorSummary
results$factorStats$factorCor
results$modelFit$fit
results$assump$bartlett
results$assump$kmo
results$eigen$initEigen
results$eigen$screePlot

a table
a table
a table
a table
a table
a table
a table
an image

Tables can be converted to data frames with asDF or as.data.frame(). For example:
results$loadings$asDF
as.data.frame(results$loadings)
Examples
data('iris')
pca(iris, vars = vars(Sepal.Length, Sepal.Width, Petal.Length,
,→Petal.Width))
#
#
#
#
#
#
#

PRINCIPAL COMPONENT ANALYSIS
Component Loadings
---------------------------------------1
Uniqueness
---------------------------------------()
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()

#
#
#
#
#
#
#

Sepal.Length
0.890
0.2076
Sepal.Width
-0.460
0.7883
Petal.Length
0.992
0.0168
Petal.Width
0.965
0.0688
---------------------------------------Note. 'varimax' rotation was used

Ravi Selker, Jonathon Love, Damian Dropmann (https://www.jamovi.org)
Exploratory Factor Analysis (efa)
Description
Exploratory Factor Analysis
Usage
efa(
data,
vars,
nFactorMethod = "parallel",
nFactors = 1,
minEigen = 1,
extraction = "minres",
rotation = "oblimin",
hideLoadings = 0.3,
sortLoadings = FALSE,
screePlot = FALSE,
eigen = FALSE,
factorCor = FALSE,
factorSummary = FALSE,
modelFit = FALSE,
kmo = FALSE,
bartlett = FALSE
)
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Arguments

data
the data as a data frame
vars
a vector of strings naming the variables of interest in data
nFactorMethod
'parallel' (default), 'eigen' or 'fixed', the way to determine the number
of factors
nFactors an integer (default: 1), the number of factors in the model
minEigen a number (default: 1), the minimal eigenvalue for a factor to be included in the
model
extraction'minres' (default), 'ml', or 'pa' use respectively minimum residual, maximum likelihood, or prinicipal axis as the factor extraction method
rotation 'none', 'varimax', 'quartimax', 'promax', 'oblimin' (default), or
'simplimax', the rotation to use in estimation
hideLoadings
a number (default: 0.3), hide factor loadings below this value
sortLoadings
TRUE or FALSE (default), sort the factor loadings by size
screePlot TRUE or FALSE (default), show scree plot
eigen
TRUE or FALSE (default), show eigenvalue table
factorCor TRUE or FALSE (default), show factor correlations
factorSummary
TRUE or FALSE (default), show factor summary
modelFit TRUE or FALSE (default), show model fit measures and test
kmo
TRUE or FALSE (default), show Kaiser-Meyer-Olkin (KMO) measure of sampling
adequacy (MSA) results
bartlett TRUE or FALSE (default), show Bartletts test of sphericity results

Output
A results object containing:
results$text

a preformatted

Examples
data('iris')
efa(iris, vars = vars(Sepal.Length, Sepal.Width, Petal.Length,
,→Petal.Width))
#
#
#
#
#
#
#
#
#
#
#
#
#
#

EXPLORATORY FACTOR ANALYSIS
Factor Loadings
-----------------------------------------------1
2
Uniqueness
-----------------------------------------------Sepal.Length
0.993
0.10181
Sepal.Width
0.725
0.42199
Petal.Length
0.933
0.00483
Petal.Width
0.897
0.07088
-----------------------------------------------Note. 'oblimin' rotation was used

Ravi Selker, Jonathon Love, Damian Dropmann (https://www.jamovi.org)
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Confirmatory Factor Analysis
(cfa)
Description
Confirmatory Factor Analysis
Usage
cfa(
data,
factors = list(list(label = "Factor 1", vars = list())),
resCov,
miss = "fiml",
constrain = "facVar",
estTest = TRUE,
ci = FALSE,
ciWidth = 95,
stdEst = FALSE,
factCovEst = TRUE,
factInterceptEst = FALSE,
resCovEst = FALSE,
resInterceptEst = FALSE,
fitMeasures = list("cfi", "tli", "rmsea"),
modelTest = TRUE,
pathDiagram = FALSE,
corRes = FALSE,
hlCorRes = 0.1,
mi = FALSE,
hlMI = 3
)
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Arguments

data
the data as a data frame
factors a list containing named lists that define the label of the factor and the vars that
belong to that factor
resCov a list of lists specifying the residual covariances that need to be estimated
miss
'listwise' or 'fiml', how to handle missing values; 'listwise' excludes a
row from all analyses if one of its entries is missing, 'fiml' uses a full information
maximum likelihood method to estimate the model.
constrain'facVar' or 'facInd', how to contrain the model; 'facVar' fixes the factor
variances to one, 'facInd' fixes each factor to the scale of its first indicator.
estTest TRUE (default) or FALSE, provide Z and p values for the model estimates
ci
TRUE or FALSE (default), provide a confidence interval for the model estimates
ciWidth a number between 50 and 99.9 (default: 95) specifying the confidence interval width
that is used as 'ci'
stdEst TRUE or FALSE (default), provide a standardized estimate for the model estimates
factCovEst
TRUE (default) or FALSE, provide estimates for the factor (co)variances
factInterceptEst
TRUE or FALSE (default), provide estimates for the factor intercepts
resCovEstTRUE (default) or FALSE, provide estimates for the residual (co)variances
resInterceptEst
TRUE or FALSE (default), provide estimates for the residual intercepts
fitMeasures
one or more of 'cfi', 'tli', 'srmr', 'rmsea', 'aic', or 'bic'; use CFI,
TLI, SRMR, RMSEA + 90 measures, respectively
modelTestTRUE (default) or FALSE, provide a chi-square test for exact fit that compares the
model with the perfect fitting model
pathDiagram
TRUE or FALSE (default), provide a path diagram of the model
corRes TRUE or FALSE (default), provide the residuals for the observed correlation matrix
(i.e., the difference between the expected correlation matrix and the observed correlation matrix)
hlCorRes a number (default: 0.1), highlight values in the 'corRes' table above this value
mi
TRUE or FALSE (default), provide modification indices for the parameters not included in the model
hlMI
a number (default: 3), highlight values in the 'modIndices' tables above this value

Output
A results object containing:
results$factorLoadings
a table containing the factor loadings
results$factorEst$factorCov
a table containing factor covariances estimates
results$factorEst$factorIntercept
a table containing factor intercept estimates
results$resEst$resCov
a table containing residual covariances estimates
results$resEst$resIntercept
a table containing residual intercept estimates
results$modelFit$test
a table containing the chi-square test for exact fit
results$modelFit$fitMeasures
a table containing fit measures
results$modelPerformance$corResa table containing residuals for the observed correlation matrix
results$modelPerformance$modIndices
a group
results$pathDiagram
an image containing the model path diagram
results$modelSyntax
the lavaan syntax used to fit the model
Tables can be converted to data frames with asDF or as.data.frame(). For example:
results$factorLoadings$asDF
as.data.frame(results$factorLoadings)
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Examples
data <- lavaan::HolzingerSwineford1939
jmv::cfa(
data = data,
factors = list(
list(label="Visual", vars=c("x1", "x2", "x3")),
list(label="Textual", vars=c("x4", "x5", "x6")),
list(label="Speed", vars=c("x7", "x8", "x9"))),
resCov = NULL)
#
#
#
#
#

CONFIRMATORY FACTOR ANALYSIS

Factor Loadings
---------------------------------------------------------------,→#
Factor
Indicator
Estimate
SE
Z
p
# ---------------------------------------------------------------,→#
Visual
x1
0.900
0.0832
10.81
< .001
#
x2
0.498
0.0808
6.16
< .001
#
x3
0.656
0.0776
8.46
< .001
#
Textual
x4
0.990
0.0567
17.46
< .001
#
x5
1.102
0.0626
17.60
< .001
#
x6
0.917
0.0538
17.05
< .001
#
Speed
x7
0.619
0.0743
8.34
< .001
#
x8
0.731
0.0755
9.68
< .001
#
x9
0.670
0.0775
8.64
< .001
# ---------------------------------------------------------------,→#
#
# FACTOR ESTIMATES
#
# Factor Covariances
# -------------------------------------------------------------#
Estimate
SE
Z
p
# -------------------------------------------------------------#
Visual
Visual
1.000 a
#
Textual
0.459
0.0635
7.22
< .001
#
Speed
0.471
0.0862
5.46
< .001
#
Textual
Textual
1.000 a
#
Speed
0.283
0.0715
3.96
< .001
#
Speed
Speed
1.000 a
# -------------------------------------------------------------#
a fixed parameter
#
#
# MODEL FIT
#
# Test for Exact Fit
# -----------------------#
X2
df
p
# -----------------------#
85.3
24
< .001
()
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#
#
#
#
#
#
#
#
#
#

------------------------

Fit Measures
----------------------------------------------CFI
TLI
RMSEA
Lower
Upper
----------------------------------------------0.931
0.896
0.0921
0.0714
0.114
-----------------------------------------------

21.2.4 Data handling using jmvconnect or jmvReadWrite
jmvconnect
Jonathon Love (https://jona.thon.love/)
Reads a data set from jamovi (read)
Description
Reads a data set from jamovi
Usage
read(id, columns)

Arguments

id
columns

the number, or the title of the data set to read
(optional) only reads the columns named

Output
the data set as a data frame
Examples
jmvconnect::what()
#
#
#
#
#
#
#

Available Data Sets
------------------------------------Title
Rows
Cols
------------------------------------1
iris
150
5
2
Tooth Growth
60
3
------------------------------------()
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data <- jmvconnect::read('Tooth Growth')
# or
data <- jmvconnect::read(2)
Jonathon Love (https://jona.thon.love/)
Lists the data sets available from jamovi (what)
Description
Lists the data sets available from jamovi. Data sets can then be read using the read() function.
Usage
what()

Examples
jmvconnect::what()
#
#
#
#
#
#
#

Available Data Sets
------------------------------------Title
Rows
Cols
------------------------------------1
iris
150
5
2
Tooth Growth
60
3
-------------------------------------

data <- jmvconnect::read('Tooth Growth')
# or
data <- jmvconnect::read(2)

jmvReadWrite
Sebastian Jentschke (https://www.uib.no/en/persons/Sebastian.Jentschke)
Read files created with jamovi (readjmv)
Description
Read files created of the statistical spreadsheet jamovi.
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Usage
read_omv(
fleInp
useFlt
rmMsVl
sveAtt
getSyn
getHTM
)

=
=
=
=
=
=

"",
FALSE,
FALSE,
TRUE,
FALSE,
FALSE

Arguments

fleInp Name (including the path, if required) of the jamovi-file to be read ("FILENAME.omv";
default: )
useFlt Apply filters (remove the lines where the filter is set to 0; default: FALSE)?
rmMsVl Remove values defined as missing values (replace them with NA; default: FALSE)?
sveAtt Store attributes that are not required in the data set (if you want to write the same data
set using write_omv; default: TRUE)?
getSyn Extract syntax from the analyses in the jamovi-file and store it in the attribute "syntax"
(default: FALSE)?
getHTM Store index.html in the attribute "HTML" (default: FALSE)?

Output
data frame (can be directly used with functions included in the R-package jmv and syntax from
jamovi; also compatible with the format of the R-package foreign)
Examples
library(jmvReadWrite);
fleOMV <- system.file("extdata", "ToothGrowth.omv", package =
,→"jmvReadWrite");
data <- read_omv(fleInp = fleOMV, getSyn = TRUE);
# if the syntax couldn't be extracted, an empty list - length =
,→0 - is returned,
# otherwise, the commands are shown and the first analysis is
,→run, with the output
# from the second analysis being assigned to the variable result
if (length(attr(data, 'syntax')) >= 1) {
print(attr(data, "syntax"));
# the print-function is only used to force devtools::run_
,→examples() to show output
eval(parse(text=paste0('result = ', attr(data, 'syntax
,→')[[1]])));
# without assigning the output to a variable, the command
,→would be:
# eval(parse(text=attr(data, 'syntax')[[1]]))
print(names(result));
print(result$main);
# -> "main"
"assump"
"contrasts" "postHoc"
"emm"
,→
"residsOV"
()
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()

# (the names of the six output tables)
}
Sebastian Jentschke (https://www.uib.no/en/persons/Sebastian.Jentschke)
Write files to be used with jamovi (write_omv)
Description
Write files to be used with the statistical spreadsheet jamovi.
Usage
jmvWrite(
dtaFrm = NULL,
fleNme = "",
retDbg = FALSE)

Arguments

dtaFrm
fleNme
retDbg

Data frame to be exported (default = NULL)
Name / position of the output file to be generated (FILENAME.omv; default = )
Whether to return a list with debugging information (see Value; default: FALSE)

Details
jamovi has a specific measurement level / type ID (in addition to the standard ones Nominal, Ordinal, and Continuous). ID is used for columns that contain some form of ID (e.g., a
participant code). In order to set a variable of your data frame to ID, you have to manually
set an attribute jmv-id (e.g., attr(dtaFrm$column, jmv-id) = TRUE).
Output
A results object (list; only if retDbg is TRUE), containing the meta data (mtaDta,
metadata.json in the OMV-file), the extended data (xtdDta, xdata.json in the
OMV-file) and the original data frame (dtaFrm).
Examples
library(jmvReadWrite);
# use the data set "ToothGrowth" and, if it exists, write it as
,→jamovi-file using write_omv()
data("ToothGrowth");
fleOMV <- paste0(tempfile(), ".omv");
# typically, one would use a "real" file name instead of
,→tempfile(), e.g., "Data1.omv"
dtaDbg = write_omv(ToothGrowth, fleOMV, retDbg = TRUE);
()
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print(names(dtaDbg));
# the print-function is only used to force devtools::run_
,→examples() to show output -> "mtaDta" "xtdDta" "dtaFrm"
# returns a list with the metadata (mtaDta, e.g., column and data
,→type), the extended data (xtdDta, e.g., variable
# lables), and the data frame (dtaFrm)
# the purpose of these variables is merely for checking
,→(understanding the file format) and debugging
# check whether the file was written to the disk, get the file
,→information (size, etc.) and delete the file afterwards
print(list.files(dirname(fleOMV), basename(fleOMV)));
# -> "file[...].omv" ([...] contains a random combination of
,→numbers / characters
print(file.info(fleOMV)$size);
# -> 2199 (size may differ on different OSes)
unlink(fleOMV);
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